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Introduction

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=4

This Open Educational Resource is for the beginning level of both interior design and architecture students who learn
computer graphic communication software.

The author created and developed a total of 22 tutorials to teach three computer graphic applications, AutoCAD, Revit, and
Enscape. AutoCAD is an essential computer drafting software which is 2D drawing software. Revit is a Building Information
Modeling software, which is 3D based modeling software. Lastly, Enscape is a real-time rendering and virtual reality plug-in
for users’ 4D experiences. These three applications are the primary programs that design students should utilize for his/her
design projects throughout an individual’s academic life in the College of Design and the student’s future jobs.

Many design students rely on the instructor’s demonstrations during lectures for acquiring technical knowledge.
Additionally, design students have tutorials from multiple resources such as textbooks and videos from that internet that
are informed by the instructors or the students’ own search results. Typically, a textbook deals with only an application.
And videos from the internet include unnecessary information like commercial advertisements. These separated sources
of information often cause a student’s confusion and frustration. For these reasons, the book provides a unified format of
tutorials to cover the three applications. The tutorials consist of both text and image-based tutorials as the primary resource
and video-based tutorials as the supplemental materials.

An instructor will demonstrate using the text and image-based tutorials, and share the link for the video-based tutorials after
the lectures for student’s practice. This book provides two learning experiences. One is to create an architectural model by
following the instructions provided in this book. The second is to create your own model by referencing the information
from this book.

Students learning outcomes

The tutorials in this book may have positive impacts on students’ learning by 1) providing unified lecture contents to learn
the main three graphic communication applications for design students, 2) offering free and readily available materials, 3)
supporting two different formats of tutorials for different types of learner.

Affordability of the teaching contents

This bool help students’ finance because the materials are free with Creative Common. Whenever students need, the
tutorials will be available without paying for the textbook. Currently, the course uses a textbook for only one application,
Revit. It is because of the price of the textbook, and also the amount of information that the course covers. If the course relay
on textbooks, students in the course should purchase two books, one for AutoCAD and the other for Revit, a textbook for
Enscape is not published yet.

Pedagogical strategies

The author is developing hybrid tutorials to support diverse student’s learning styles. Some students tend to learn lecture
contents through readings, some students learn lecture contents more effectively with video and audio, and some students
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learn lecture contents with in-person coaches. The book implements two types of tutorials to cover visual learners and
auditory learners. The tutorials also can be used for new instructors to teach similar lecture contents in the future. The
instructors can investigate their time to prepare to deliver the lecture contents rather than to create the lecture contents.
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PART ONE. AUTOCAD

Chapter 1. Introduction of AutoCAD

+ What is the application & 4 different AutoCAD

+ How to install the application

+ Understand AutoCAD interface — Ribbon, Panels, Model space, Layout tabs, Status bar, €¢ Properties
« AutoCAD setup tips — Options, Unites, Workspace

« Types and structure of drawings in Auto CAD- Floor plan, RCP, Elevation, Section, ¢ Details

+ Input commands and understand different selections

+ Understand basic drawing tools— Origin, Line, Move, Rotate, Copy

+ Attach image/PDF/CAD and Adjust the scale

+ Set the project folder, Save the file, and backups

Chapter 2. Draw Floor Plans

+ Understand Layers — Name, Line type, Thickness, €/ Color

» Draw centerlines - Line, Ortho, ¢ Offest

+ Draw exterior/interior walls, floor, millwork & openings — Polyline, Spline, Circle, Rectecgul, Object Snap, Mirror, Fillet,
Trim, Extend, Array, € Match Properties

Chapter 3. Create Dimensions and Components

+ Add/Edit dimensions (in model space)— Dim, €/ Dimension style

+ Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door, Window, Column, Plumbing, Furniture £
Equipment

+ Create custom blocks — Custom furniture

Chapter 4. Draw Elevations and Sections

« Draw a section
+ Draw an elevation from Floor plan
+ Add/Edit Text & Annotation (in model space) — MText, Text style, M leader, € Multileader Style
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Chapter 5. Draw Ceiling Plans

+ Draw Ceiling Plans from Floor plan
+ Add/Edit Hatch
+ Create Legends

Chapter 6. Set Sheets

+ Understand the Model space and Paper spaces
+ Set a new layout — Page layout, €/ Plot styles

« Set views in Paper spaces — Defpoints, Scaling

+ Add/Edit/Draw a titleblock

Chapter 7. Symbols and prints

« Add/Edit symbols in Paper spaces — drawing title, elevation symbol and section letters, north arrow
+ Printing
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Chapter 1. Introduction of AutoCAD

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand what is the application & 4 different AutoCAD

(CO 2) Install the application on your computer

(CO 3) Understand the User Interface of AutoCAD - Ribbon, Panels, Model space, Layout tabs, Status bar, & Properties
(CO 4) Understand AutoCAD setup tips — Options, Units, Workspace

(CO 5) Understand the types and structure of drawings in Auto CAD- Floor plan, RCP, Elevation, Section, & Details
(CO 6) Input commands and understand different selections

(CO 7) Understand basic drawing tools- Origin, Rectangle

(CO 8) Attach image/PDF/CAD and adjust the scale

(CO 9) Set the project folder, Save the file, and backups

£ 2 Session Highlights

At the end of the session, students can create the graphics below.

DeEHRLEES - -+ ¥ Type a keyword or phrase 8 Q. signin S el _
Home Insert Annotste Parametric View Manage Output Add-ins  Collsborste ExpressTools  FesturedApps (D~
/‘ ) @ /-/' T~ b Move C Rotate §Tim - 7 o Htner - 2 > - B S Create E\@ @ [ Bylayer - [5? B o B ‘D B
e paine (Cide A 2 ‘)"?’(”W M mor (ARG | e | L naert O EIE Match — L ! Groiip & e B pae D e
T w . | Disvech Glsee Samy - €| ¢ ETble  Properies & & & % F Match Layer & Edit Atiributes ~ Properties 52 ByLayer - i3 % =
Draw ~ Madify ~ Annatation ~ Layers ~ Black ~ Properties ~  Groups - Utiities - Clipboerd  View ~
Start Dravingl” X Eames_House Project Yongyeon Cho 01 X +
PROPERTIES
- @
O Bylayer
0
Linctype Bylayer
Linetype scale 1.0000
Lineweight Bylayer
Transparency ByLayer
Thickness o
3D Visualization -
Material ByLayer
Plotstyle -
Plot style ByColor
Plot style table None
Plottable attachedto  Model
- Plot table type Not available
T View =
£ CenterX 25140
s Centery -8 346"
% CenterZ o
= Height 65'-05/8"
T Width SERA
S M =
Annotation scale 11
UCSicon On es

UCSiconatorigin s

UCS per viewport es
UCSName
Visual Style 2D Wireframe

]~ Type o conmand

Model | Loyoutl | Layour2 |+ mooeL [{] = - L [&F] v - (XA -+ PCBRE =
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E Lecture Contents

(COr1) Understand what is the application & 4 different AutoCAD

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

About CAD

Computer-Aided Design(CAD) or Computer-Aided Design and Drafting (CADD) can be defined as using computer systems
to assist in the creation, modification, analysis, or optimization of a design. (Narayan, 2008)

CAD software is used to increase the productivity of the designer, improve the quality of design, improve communications
through documentation, and create a database for manufacturing. (Narayan, 2008)

image credit: Shaan Hurley, AutoCAD R14 Welcome Sample DWG, Flicker
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CAD is an important industrial art extensively used in many applications, including automotive, shipbuilding, and aerospace
industries, industrial and architectural design, prosthetics, and many more. (Pottmann, and et al., 2007)

About AutoCAD

AutoCAD is an industry-leading commercial CAD software.

AutoCAD is used by AEC(Architecture, Engineer, and Construction) to generate and optimize 2D and 3D designs. AutoCAD
is a widely used software program that can help you draft construction documentation, explore design ideas, visualize
concepts through photorealistic renderings, and simulate how a design performs in the real world. (Autodesk)

AutoCAD was first released in December 1982 as a desktop app. In 2010, AutoCAD was released as a mobile- and web app,
marketed as AutoCAD 360. (Autodesk and AutoCAD)

Four AutoCAD products for AEC

+ AutoCAD: the original version of AutoCAD. This version can use architects, project managers, engineers, graphic
designers, city planners, and other professionals.

+ AutoCAD Architecture: a version of Autodesk’s flagship product, AutoCAD, with tools and functions specially suited
to architecture work. This software supports dynamic elements (wall, door, windows, and other architectural
elements) and automatically updating Spaces and Areas for calculations of sqft.

+ AutoCAD LT: the lower-cost version of AutoCAD, with reduced capabilities (No 3D, No Network Licensing, No
management tools, and more).

+ AutoCAD 360: an account-based mobile and web application enabling registered users to view, edit, and share
AutoCAD files via a mobile device and web using a limited AutoCAD feature set and using cloud-stored drawing files.

(COz2) How to install the application

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5

Install AutoCAD

This version is for educational purposes only.

You must know your system requirement first before you install the application. If you do not know your system use, please

find the information here.

« [STEP 01] Go to https://www.autodesk.com/education/free-software/autocad on your Windows side, open a web
browser (Chrome is recommended because the instructor tested).

« [STEP 02] Click [CREATE ACCOUNT] if you do not have one. If you already have an Autodesk account, please sign in
by clicking [SIGN IN].
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[STEP 03] Select an appropriate version of AutoCAD, your system, and language.
[STEP 04] Click [INSTALL].
+ [STEP 05] Accept the license and services agreement.
[STEP 06] You will receive an email from Autodesk for the license information (Product key and Serial Number). It
will be needed for the activation process.
« [STEP 07] Click the downloaded installation file to install. The installation will take a while.
« [STEP 08] After installation, the software will require activation. Please use the license information.

(CO3) Understand AutoCAD interface — Ribbon, Panels, Model space, Layout
tabs, Status bar, & Properties

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

Once you open AutoCAD by double-clicking the AutoCAD icon, you can create a new drawing by clicking the [START
DRAWING] icon on the first page of the AutoCAD application.

Get Started Recent Documents Notifications

June 2020: Have you
tried to customize the
AutoCAD User Interface

to better suit the way

you work? Workspaces

can help with that.

Manage and Customize Your
Workspace

Connect

Sign In to your Account
Access onling services

Send Feedback
Help us improve our products

Send Feedback

LEARN CREATE B

You also can select a different template by clicking [TEMPLATES] under start drawing. The default setting is [acad.dwt]

Your recent documents will show in the middle of the first page. You also can click to open the recent documents.
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What's New Getting Started Videos

"7 Plota Drawing Layou!

a layout,

AutoCAD New Features Overview

Convert 2D Objects to 3D
Objects

" Create and Modify Surfaces
and modify

CREATE B

Learning Tips

For a more precise placement, attach
a PDF before importing it. You can
then use the ALIGN command to
orient and place the PDF,

More information...

Online Resources

Explore training materials on the
web to sharpen your skills or learn
something new.

The Hitchhiker's Guide
o AutoCAD Boss

Hitchhiker's AutoCAD Basics

/\ AUTODESK.
Autodesk AutoCAD Services 8
Support

For the tutorial provided by Autodesk, you can click [LEARN]. I recommend you watch the Getting Started Videos.

Once you click [START DRAWING], you will see this user interface below. [please remember the names]

_RIBBONVIEW B

B

DRAWING AREA /
GRAPHIC AREA

COMMEND BOX

S Bl Type @ command
Model  Layoutl  Layo LAYOUT TAB

+ Application menu: New, open, save, import, export, print

+ Quick access toolbar: User can save tools that they often use

+ Info Center: Ask a question, find out answers from Autodesk community
+ Ribbon: Main menus — Home, Insert, Annotate, View, Manage

« Ribbon tab

« Ribbon view: User can minimize and maximize the ribbon

9 | AutoCAD Session 1
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+ File tab: Navigate files and create and open files

+ Drawing area/graphic area: Main drawing space

+ View cube: User can change the view, top, front, 3D, or more

+ Navigation bar: Zoom in and out, pan, zoon to all, and more

+ Command box: Can type commands and see the previous commands
+ Layout tab: Can see model space and print spaces

+ Status bar: Can set grid, snaps, scales, and more

Please see this detailed user interface that is provided by Autodesk

(CO4) AutoCAD setup tips — Options, Unites, Workspace

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

Before you start your drafting, it is recommended to set your workspace and options as you wish. Take some time and
experiment with the settings, as shown below. You can change settings at any time.

Below are the instructor’s recommended setups based on more than 10-years of drafting experience.

OPTIONS

+ [STEP 01] Click [APPLICATION MENU] and then Click [OPTIONS], or type [options] on the command box, and
Enter key

« [STEP 02] You will see the Option window

+ [STEP 03] Click Display tab > Change Color theme from dark to light

+ [STEP 04] Find Crosshair size on the Display tab > Change the value from 5 to 100

AutoCAD Session 1 | 10
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A Options

Cument profile: <<linnamed Profiless ='= Cumrent drawing: Drawing 1.dwg
File-n and Save Plot and Publish System User Preferences  Drafing 3D Modeling  Selection  Profiles

Dizplay resolution
!-= Arc and circle smoothness

[ ] ™ i H
IS Segments in a polyline curve
g Display scroll bars in drawing window =_= Rendeed dject amootiness
Use large buttons for Toolbars
= Cortour i rf
Resize ribbon icons to standard sizes o PISSRSISERREEES
Show ToolTips Dizplay performance
m Mumber of seconds before display []Pan and zoom with raster & OLE
[ 1 ™ " . .
Show shorteut keys in Tool Tips ] Highlight raster image frame anly
[ 1 ™ .
Show extended Tool Tips :: Apply solid fil
Number of seconds to delay = []5Show text boundary frame only
i et [] Draw true sihousttes for solids and sufaces
Display File Tabs
Colors... Fonts. ..
Layout elements Fade control
Display Layout and Maodel tabs Href display
Display printable area IE' I
Display paper background Inplace edit and annotative representations
Digplay paper shadow

[] Show Page Setup Manager for new layouts
Create viewport in new layouts

Cancel Aoy Help

« [STEP 05] Find [Colors] and change Uniform background to Black> Click [Apply & Close]
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Current profil|
Files  Dil

Window

Color th

[] Disp
[JUse
Resi
Shaf
D
&
M

Shaol
Disp

Layout &
Disp
Disp
Disp
[ sho
Crez

Context:

(20 model space ]

| Sheet [layout

| 30 parallel projection

| 30 perspective projection
| Block editor

| Command line

| Plot preview

Preview:

Interface element:

luniformbacground I

| Crosshairs
| viewport control
Grid major lines
| Grid minor lines
| Grid axis lines
| Autotrack vector
| 2d Autosnap marker
| 3d Autosnap marker
| Dynamic dimension lines
| Rubber-band line
| Drafting tool tip
| Drafting tool tip contour
| Drafting tool tip background

| Control vertices hull v |

Apply & Close

T

|
H

]
e
Pl

Restore current element
Restore current context

Restore all contexts

Restore dassic colors

Cancel Help

SarToe POy Help

+ [STEP 06] Click the Draftingtab > Change the aperture size — make slightly smaller
+ [STEP 07] Click the Selection tab and uncheck[allow the press and drag for lasso] > Click [OK] to close the option
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A Options

Current profile: <<Unnamed Profile:

Pickbox size

Selection modes
Moun/verb selection

[] Use Shift to add to selection
Object grouping

[] Associative Hatch

Implied windowing

Allow press and drag on object

Wi L ;
Bath - Automatic detection w

Object limit for Properties palette

Selection effect color:
B Defautt v

Ribbon options

Contextual Tab States. .

Eﬁ Cument drawing: Drawing1.dwg

Files Display Openand Save Plot and Publish System User Preferences Drafting 3D Mndeli-'uﬁles

Grip size

Grips
Grip Colors...

Show grips

[ Show grips within blocks

Show grip tips

Show dynamic arip menu

Allow Ctr+cycling behavior

Show single grip on groups

Show bounding box on groups

Object selection limt for display of grips

Preview
Selection preview

When a command is active
When no command is active

Visual Effect Settings...
Command preview
Property preview

Cancel Aoply

UNITS

« [STEP 01] Click [APPLICATION MENUJ] > click [DRAWING UNITS] > click [UNITS] or, Type [units] on the

command box > Enter key
+ [STEP 02] Confirm the units are right for your project
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Below snap is an image of a typical setting for the Imperial system.

A Dr:

Length Angle
Type: Type:
Architectural i Decimal Degrees e
Precision: Precision:
00 1/16" w 0 w
[ Clockwise

Insertion scale
|nits to scale inseted content:

Inches -

Sample Output

122
3"<d5 0"

Lighting
Inits for specifying the intensity of lighting:

Imtemational 4

QK Cancel Direction...
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Below snap is an image of a typical setting for the Metric system.

B Drawing Units X
Length Angle
Type: Type:
Decimal i Decimal Degrees e
Precision: Precision:
) e L] "t
[ Clockwise
Ingertion scale
Inits to scale inseted content:
Millimeters ~
Sample Output
220
3<45.0
Lighting
Inits for specifying the intensity of lighting:
Intemational b
Cancel Direction... Help

PROPERTIES

« [STEP 01] Click the small arrow under Properties on Home Ribbon to open the Properties panel

O - Bylayer -
S = ByL [

— ayer -
Match = — i

*  Properties == ByLayer -
Properties « G

+ [STEP 02] Or press [Ctrl+1] on your keyboard to open the Properties panel
« [STEP 03] Place the panel on your left side of the workspace
+ [STEP 04] Click [Layer Properties] on Home Ribbon to open Layer properties

ted s -
= % £ 4 T, £ Make Current
Layer g =
Properties =:_ gj,.- £ <. & Match Layer
Layers -

+ [STEP 05] Place the panel on your left side of the workspace and click the arrow to hide the panel

0 =

LAYER PROPERTIES MAMAGER
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The interface after setting changes

DBEIF,?[‘ g8 = = » | Type a keyrword or phrase 88 2 signin T Wh D -8 X
Home Inset Amnotete Parametic View Manage Output Add-ins  Collaborate  ExpressTools Featwred Apps (-
/' ~ p: "+ 4 Move () Rotate § Tim -+ [ Linear « - O 52} ‘D =
e vopine Crde ae O 7| B Avor (e - G| Ly ¢ e - i e Mesue B e O o,
g . - R stretch G]Scale 55 Amy - & E B Teble Z Match Layer Edit Attributes - Properties ry =
Draw ~ Modify ~ Annotation ~ Block ~ Properties + S Groups ~  Utifties ~  Clipboard  View v
Drawing1*
PROPERTIES
No selection - @
General -
Calor O ByLayer
Layer o
Linetype ByLayer
Linetype scale 1.0000
Lineweight ByLayer
Transparency Bylayer
Thickness o
3D Visualization -
Material ByLayer
Plotstyle -
Plot style
Plat style table None
Plot table attached to
Plot table type
View -
Center X
s Center Y
g CenterZ
E Height
g Width
S wisc -
Annatation scale 11
UCS icon On Yes
UCSicon atorigin  Ves
UCS perviewport  Yes
UCS Name
Visual Style 2D Wireframe
X & B~ Type @ conmand
[ o] o wmopeL [ 3 - L[]+ % T R

(COs) Types and structure of drawings in Auto CAD- Floor plan, RCP,
Elevation, Section, & Details

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

Architects and Designers use AutoCAD in slightly different ways. It is different from firm to firm and depending on who

draws the drawing. Moreover, it depends on what phase of the design you are in.

Many design firms never use layout tabs. Some firms use AutoCAD only for Schematic Design purposes. Some designers use

this application for presentation purposes too.

However, in this course, we are targeting to use all essential functions to generate a Construction Document set.

Below is a typical - fundamental — Construction Document set for an interior design project

« Cover sheet + general project information
+ Floor plans

+ Furniture + Finish plans

+ Ceiling plans

+ Elevations + Sections

+ Details

For detailed information about the types of drawings, please refer
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Kilmer, W. Otie, and Kilmer, Rosemary. Construction Drawings and Details / W. Otie Kilmer and Rosemary Kilmer. Third
ed. 2016. Print.

(CO6) Input commands and understand different selections

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

To draw in AutoCAD, you must understand different types of command input

« Use icons on Ribbon (Basic level)
e.g. Click [Home] ribbon > Click [Text]

« Use the commands box (Moderate level)
e.g. Click [command box] > Type MULTILINETEXT > Enter key

«+ Use Shortcuts (Advanced level) — Please practice to improve the speed of work and productivity.
e.g., Type [MT] on a keyboard (mouse can be located anywhere, it can be lower case) > Enter

Often use shortcuts by the instructor [please remember the list of shortcuts]

1] - line

pl] - polyline

mt] — multiline text
m] — move

o] — copy

ro] — rotate

z] — zoom and [a] — all
b] - block

s] — stretch

[
[
[
[
[
[
[
[

x] — explode
ex] — extend

re] — regen (refresh)

[
[
[
o [c] =circle
[
[
[

o [h] - hatch
« [o] - offset
+ F3 - osnap
« F8 - ortho

Detailed information can be found in this link https://www.autodesk.com/shortcuts/autocad

Three types of selections

one click - individual objects

« window selection (blue) — drag/click from left-top to right bottom to select all objects that are enclosed in the selection
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rectangle.

DBEIE?E‘ =R = V[ 1ype a keyword or phrase 88 2 signin Swh @ -5 X
Home Inset Annotate Parametric View Manage Output Add-ins Collsborate ExpressTools  Featured Apps
/' “Cl- 4 Move O Rotate S Tim - A Hner - £Z [ @ oo - £ Create v B B
g i % Copy Miror { Fillet ~ ) Pleder - = 2 2 2 Z 5 Make Curent 5 Edit i s
Line Polyline Circle  Arc = A J & | ot Dimension y o ol ik 0 Measure | paste D\ Base
Y . Dostech Glsale SBAmy - © | - ETable  Propeties G Z G % i Match Layer " & Edit Atrbutes - B - B
Draw ~ Modity ~ Annotation + Layers ~ Block Properties + s Groups ~  Utiities = | Clipboard  View ~

Drawing1”

PROPERTIES

No selection
General
Calor
Loyer
Linetype
Linetype scale
Lineweight
Transparency
Thickness
3D Visualization
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# PROPERTIES

No selection
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Linetype scale
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Thickness
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Plot style table
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Plot table type
View
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CenterZ
Height
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UCSicon On
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ByLayer
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Tip. To select multiple objects, just click one and another. No need to hold [shift] key or [ctr]]

Refer to this link for select object Information from this link
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(CO7) Understand essential drawing tools- Origin and Rectangle

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

Understand the “origin” of the drawing

AutoCAD drawing area is on a real scale, which means the drawing scale is 1:1 scale. Moreover, the drawing area is
unlimited. You can draw the entire earth in the drawing. Furthermore, you can draw a small object, too. Designers often lose
the point/location that they want to draw in the drawing when you draw in a big drawing. Thus, designers use the drawing
origin (0,0,0) — ((x,y,2) for a 3D model) as the base point of the project. Usually, the origin of the drawing is the left-bottom
corner on the first floor (if it is a 3D model). In AutoCAD, we use only (0,0) - (x,y).

To start your drawing, draw a building footprint or property line first.

[STEP 1] Click [Rectangle] on the Home Ribbon, or type [rec] and Enter
« [STEP 2] Specify the first point, type [0,0] and Enter

[STEP 3] Specify the next point. Any point on the right-top corner will be fine. It depends on the project size. For our
project, type [58'7",20'4"]
« [STEP 4] Type [z] to zoom and type [a] and Enter

DBEIE["D@‘>‘ s

Home Insert Annotate Porometric View Manage Output Add-ins Collsborate  ExpressTools Featured Apps

-

Stretch Verte
Add Vertex

Remor

s Manager

Model | Loyoutl  Layout2 wopeL [#] it~ L[]~ W - [Z]ED - [R]K A v % -+ o B =

Line (command)

+ [STEP 1] type [1] and Enter
+ [STEP 2] specify the first point by clicking a point or typing [x,y]
« [STEP 3] specify the end point by clicking a point or typing [x,y] — absolute point, type [@x,y] — relative point
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« Please refer to this link for the line command

Move (command)

[STEP 1] type [m] and Enter

« [STEP 2] select the object/objects that you want to move and Enter
[STEP 3] specify the base point

[STEP 4] specify the second point to move the object/objects

+ Please refer to this link for the move command

Copy (command)

STEP 1
STEP 2

[ type [co] and Enter
[
+ [STEP 3] specify the base point
[
[

select the object/objects that you want to copy and Enter

[ U

STEP 4] specify the second point to copy the object/objects
STEP 5] specify the third point or more to copy the object/objects if you have. If you want to stop, use ESC

o Please refer to this link for the copy command

+ Please practice Line, Move, Copy, and Rotate commands

(CO8) Attach image/PDF/CAD and adjust the scale of the attached file

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5

Download a floor plan image (Eames House-House)

From this page, click [Eames_House_Floor_Plan_House.jpg] and mouse right-click to save the image file to your project
folder.

Your CAD file and JPG file MUST be in the same folder. Otherwise, you have to relink the file every time or set your link

relatively.

Insert the image file.

« [STEP 1] Click [Insert] on the ribbon tab
+ [STEP 2] Click [Attach] on the Reference palette
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Home | Insert | Annctate  Parametric  View  Manage  Output A3B0 Express Tools F
*} i @_% EB' Underlay Layers
: . Lo Lo =1 [Fe

: g . M [ *Frames vary* ~
Insert Edit Create  Define  Manage Block | Attach | Clip Adjust ™ =
Attribute Block  Attributes Attributes Editor

Snap to Underlays ON -

Block - Block Definition - e~ u
Start Crawing1*® ; +

PROPERTIES [~]1[Topll2D Wireframe]

Mo selection

+ [STEP 3] Select [Eames_House_Floor_Plan_House.jpg] from your project folder > Click [open]
« [STEP 4] Click [OK] on the Attach Image window

A

Mame: Eamez_Haouze_Flaar_Plan_Houszs & Browse ..
Praview Path typz Scalz
Relative path ~ R —
| | — 1.0000
i [ —4 _I_ Inzartion paint
' o N Specify an-screen Ratatian
- L 1
. - '|' v |0 [] Spacify an-=creen
L . \ 4. =
U 1 Angle: | 1]
= [

Show Cietailz Hezlp

+ [STEP 5] Click the origin point or type [0,0] and Enter

Adjust scale

« [STEP 1] Specify the scale factor [1] and Enter
« [STEP 2] Select the inserted image > Change the Fade value to [50] or lower that you can see the background
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B:'i:_|!*.!ne]s 50
£ c:n*.rast] 50
Fade | 50

B S| & |[W

gt ove || Show | Background | External
ping [Image Transparency |References

Adjust Clipping Options
1 sn
| : PROPERTIES [
|Raster|mage |v| Q s ««{.‘g
| General - |
Color O Bylayer
Layer o]
Linetype ByLayer
= Linetype scale 1.0000
E‘ Plot style ByColor
ﬁ Lineweight ByLayer
.g Transparency ByLayer
8 Hyperlink
f% Image Adjust -
% Erightness 50
1 Contrast 50
Fade 50
Geometry =
Position X o"
Position ¥ o
Position £ o
Rotation 0
= Width 17
7 Height 11/16"
Scale 1.0000

« [STEP 3] Zoom in to the scale or a known dimension
+ [STEP 4] Type [SC] and Enter for Scale change
+ [STEP 5] Click a base point > Type [r] and Enter > Click the base point > Click a second point that you know a

dimension (for th

is draw, you can use the scale bar) > Type the known dimension [1']

Specif factor or [Co erence]: r

LS D]~ SCALE Specify reference length <1'-8">: Specify second point:

Change the drawing order

« [STEP 1] Click the inserted image
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+ [STEP 2] Mouse right-click > Click [Draw Order] > Click [Send to Back]

Repeat ZO00OM

Recent Input

Clipboard

|solate

Erase

Mowe

Copy Selection

Scale

Rotate

Draw Order Bring to Front
Group Send to Back

Image Bring Above Objects

Add Selected Send Under Objects

Mowe the image to the building footprint

+ [STEP 1] Select the inserted image

« [STEP 2] Type [m] to move and Enter

+ [STEP 3] Click a base point > Click the target point to move

« Tip! Use Object snap [F3] to select the target point from the building footprint.
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(COg) Set the project folder, Save the file, and backups

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=5

Save the file

It is vital to save your file as early as possible. Moreover, save anytime, and the moment you think it is appropriate. I usually
save within 15 min (at least four times per hour).

[STEP 01] Click [Application menu] > Click [Save]

[STEP 02] Select a project folder on your hard drive, external hard drive, USB, Dropbox, or Onedrive

[STEP 03] Recommended file type — AutoCAD 2007/LT2007 Drawing(*.dwg)

[STEP 04] Recommended file name — Eames_House_Project_Firstname_Lastname_01.dwg

Tip! (bak) file is a backup file. In the default setting, every 10 minutes, the file will be saved. To use the backup file, change
the file extension (.bak) to (.dwg)

gi References

Narayan, K. Lalit (2008). Computer Aided Design and Manufacturing. New Delhi: Prentice Hall of India.
ISBN 978-8120333420.

Pottmann, H.; Brell-Cokcan, S. and Wallner, J. (2007) “Discrete surfaces for architectural design” Archived 2009-08-12 at
the Wayback Machine, pp. 213-234 in Curve and Surface Design, Patrick

Chenin, Tom Lyche and Larry L. Schumaker (eds.), Nashboro Press, ISBN 978-0-9728482-7-5.
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Chapter 2. Draw floor plans

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand Layers — Name, Line type, Thickness, & Color

(CO 2) Draw centerlines — Object snap, Line, Move, & Offest

(CO 3) Draw exterior/interior walls, floor, millwork & openings — Polyline, Spline, Circle, Rectengule, Object Snap, Mirror,
Fillet, Trim, Extend, Array, & Match Properties

¥ Session Highlights

At the end of the session, students can create the graphics below.
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@ Lecture Contents

(CO 1) Understand Layers — Name, Line type, Thickness, & Color

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=32

The concept of layers in CAD

Architects and designers use layers in vector-based CAD software.

The concept of layers allows CAD information to be organized, facilitates the visual display of the information on a

computer screen, and allows the information to be efficiently converted to the conventional print media of drawings.

The efficient use of layers can reduce document preparation time and improve document coordination.

The American Institute of Architects and National Cad Standard published “AIA CAD Layer Guidelines.”

Using layers can make your drawings easier to control and interpret for both you and your team. For example, you can draw

your interior walls on one layer, and furniture on another using a different color. You can quickly turn off your furniture

layer on a floor plan and turn on the furniture layer on a furniture plan.

You can control layers from the Layer Property Manager.

d 1OFd

Line Polyline Circle  Arc

Draw =

Start Drawing1* x

0 -« Move
G - | G Copy
] - D:_ Stretch m Scale

Modify +

i# LAYER PROPERTIES MANAGER

Current layer: 0

T wm| eSS

() Rotate %, Tim -
A Mirrer {7 Fillet - (&
og Amey - © 7

& A

Text  Dimension

Annotation «

Eames_House_Project_Yongyeon_Cheo_02 % +

[ Linear -
/° Leader ~
B Table

=
Layer
Propertie

Search for layer

o

@l [0 =

“% &, ‘% “G £ Make Current

::‘g: 5/, :‘g 51-_"i' £ Match Layer
Layers =

[—1Mop][2D Wireframe]

Q

.9

» fSta.. MName
W 0

~ On

Freeze Lock Plot Color

VX

i @ [ white

Linetype  Lineweight

Tran... | N...
Caontinu.,, —— Default 0 =

Description

)

Each layer has a set of properties assigned to it.

« Name
« Turn On/Off

+ Freeze — Looks the same as turning on and off but uses less memory. Boost the speed of work.

« Lock

+ Plot - It shows on your screen, but it will not print.

+ Color - It is for working on the screen — easier to recognize the layers by color. Usually, prints in black and white.

+ Line weight — Important to identify the hierarchy of the lines

« Line type

+ Transparency — not often used

AutoCAD Session 2 | 26


https://iastate.pressbooks.pub/visualgraphiccomm/?p=32#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=32#pb-interactive-content
http://www.close-range.com/docs/US_National_CAD_Standard_V3.pdf

+ Description — note for the layer

Create Layers for the project

+ [STEP 01] Open the Layer Property Manager panel by clicking the [Layer Property] icon under the [Home] tab on the
[Layers] panel.
« [STEP 02] Click [New Layer] or Press [Alt+N] to add a new layer

X r— - Lavar
o Current layer: 0 Search for layer Q.

5% & WD ﬂsmf e 28

Filters @ 5. Mame « 0. F. L. P. Color  Linetype  Lineweight Transp.. M. Description
= All o O o & [Jwh... Continu.. —— Defa.. 0 =
b All Used Layers ( )

+ [STEP 03] Rename the name of the layer by double-clicking the name of the layer to A-WALL
+ [STEP 04] Update the color of the layer by clicking the color section to YELLOW
« [STEP 05] Update the line weight of the layer by clicking the Lineweight section to 0.5
+ [STEP 06] Repeat the [STEP 02] to [STEP 05] to create the listed Layers below.
[ x -
I Current layer: 5-GRID Search for
w o m| @B G
» | 5.. Name 0. Fu La| P Color Linetype Lineweight Tra... = N. Description
= 0 g S [Jwhite Continuous —— Default 0 =
= A-ANNO 0 EE S O oyan Continuous —— Default 0 =
= A-ANMNO-DIMS S O oyan Contiruous —— Default 0 =
= A-ANMO-TEXT i aT S O ovan Continuous ———— Default 0 [
£ A-ANNO-TTLE e S [ white Contiruous .60 1 0 =5
& A-CLMG ¢S |0 Continuous e (1,30 Fri o =3
£ A-CLMG-PATT g S @ Continuous —— Default ] &
< A-DETL Vg S [@oo Continuous — Default 0 B
= A-DOOR, 7 S M blue Continuous s [1,30) 11T 0 =
= A-FLOR WG e Mo Continuous s (1,300 11T 0 =
= A-FLOR-FMSH 0 iEre Mo Contiruous —— Default 0 =
= A-FLOR-HRAL 0 iEre e Continuous ———— Default 0 B
= A-FLOR-OVHD PR e mao DASHED — 030 0 B
£ A-FLOR-STRS G e a2 Continuous e (1,30 Fri o =3
& A-GLAZ e edT =N [ Continuous e .30 i g B
£ A-GLAT-CURT e e =N Continuous ——— Default o =
S ASALL 0 EE S O yellow Continuous (.50 mim 0 =
= |-CASE 0 EE e W 230 Continuous —— Default 0 =
= |-FURM 0 Er e W20 Continuous —— Default 0 =
i = P-FIXT 0 S deo Cortinuous — Default 0 B
2 £ S-COLS gt S O yellow Contiruous e (1,40 1t 0 B
= & S-GRID (eEsaT =N Rl CEMTER ——— Default 0 =
0 & SLEVL 7S Mo CENTER —— Default 0 B

Note 1. To update line type, click the line type that you want to update, and click [LOAD], and find the line type that you
want to use for a layer, and click [OK], click the loaded line type to apply, and click [OK] to apply.

Note 1A. Due to the scale issue, the line type will not show it correctly. To correct the line type scale, type [lts] on the
keyboard, and press the [Enter] key and enter [number]. For this project, try [10]
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Note 2. The name of the layer is based on AIA CAD layer guidelines, the instructor modified. If you need other layers, please

refer to the guideline.

Apply a layer to a model

[Method 1]

« [STEP 01] Fine a line/lines or an element/elements that you want to apply a layer
« [STEP 02] Select a layer that you want to apply to, then a layer of the element will be changed

Manage  Output  Add-ins  Collaborate  ExpressTools  Featured Apps (D~
e W Tm - i Linear - 27 [T A-ANNO - £ Create L] Bylayer Ml = B
R & 2 =& O S ByL [J E I
s Fillet ~ /2 Leader ~ = _ ~ g Edit yLayer - = i
f B9 | Jet  Dimension * e O Insert ~2 Match I Group "= Measure % Paste 0 g
. BBAmy - & | - B Table  Properties| @ [ A-ANNO T B Edit Attributes ~ | Properties S - -Bylayer ~ - o
fy - Annotation = [ A-ANNO-DIMS Block ~ Praperties = s Groups = Utilities = Clipboard  View

[ A-ANNO-TTLE
M a-CLNG

I A-CLMG-PATT
[ A-DETL

W ~-DOOR

[ a-FLOR

[ A-FLOR-FNSH
[ A-FLOR-HRAL
[ A-FLOR-OVHD
[ A-FLOR-STRS

M a-GLaz

[0 A-GLAZ-CURT
] a-waLL

W -casE

W -FURN

O p-FixT

[ s-coLs

I s-GRID

W sLevL

[Method 2]

+ [STEP 01] Select a layer that you want to draw
« [STEP 02] Draw a line/lines or an element/elements within the layer

[Method 3]

+ Use [MATCHPROP] command or [MA] — match the property to copy a layer style to another

Tip. I prefer to use this method to speed up the work — Draw lines with all layers with name on the side of the drawing,

and use match property command whenever it is needed. You can save time to find the layer and select the layer from the
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drop-down menu.

A-ANNOTTLE

(CO 2) Draw centerlines-column grid — Object snap, Line, Move, & Offset

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=32

Drawing a centerline can be the first step in drawing a floor plan. The drawing order depends on the phase of design and
who is drawing. However, setting centerlines can be easier to draw a floor plan rather than starting from scratch.

« [STEP 01] Select the right layer to draw column grids. Click [S-GRID] from the [Home] ribbon on the [Layers] tab
+ [STEP 02] Make sure [othormode] and [osnap] is on

mooeL [#E| :: ~ L] &~ - [£]E - 4

OSNARP setting — to select a specific point of an element, it is reccommended to use object snap [OSNAP]. To set up object
snap, mouse right click on the OSNAP icon on the Status bar and check the point that you would like to select while the
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object snap is on.

v A Midpoint
v @ Center

[0] Geometric Center

v o Node
b Quadrant
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v — Extension )
J

&2 Insertion

« L Perpendicular

;r Tangent
A Nearest
" Apparent Intersection
// Parallel

| Object Snap

P P SR | MOUSE RIGHT CLICKES

This image is the recommended object snap settings for 2D drafting, based on the instructor’s experience. Note. For more

information regarding OSNAP, please read this link about using Object Snapes.

+ [STEP 03] Select [Line] from [Home] ribbon on [Draw] tab ,or Type [l] and press [Enter] on the keyboard to draw lines
Click the base point [0,0] and mouse move to plan north, and type [25'] and press [Enter] on the keyboard

“| § PROPERTIES

Line - &4
General =
Calor @ Eylayer
Layer 5-GRID

Linetype ——— — - Bylayer Stretch N
Linetype scale 1.0000 Lengthen

Plat style ByCalor

Lineweight Eylayer
Transparency ByLayer
Hyperlink
Thickness o

3D Yisualization =
hdaterial Bylayer

Geometry =
Start X
Start ¥
Start 2
End ¥
End ¥
End Z
Delta X
Delta
Delta Z
Length 25
Angle aa

oo o g~ oo o
=i 2|2 g R S S

Layer Properties Manager

+ [STEP 04] Move the gridline to the center of the building base footprint.

-i-' Move
Click [Move] icon from [Home] ribbon on [Draw] tab

or, type [m] and press [Enter] key
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Click the midpoint of the selected line, and then click the midpoint of the building footprint

CLICK CLICK THE
THE MIDPOINT OF =i s MIDPOINT OF THE
THE SELECTED LINE BASE BUILDING
FOOT PRINT

+ [STEP 05] To create vertical grid lines, it is recommended to use the [OFFSET] command.

Click [OFFSET] icon = from [HOME] ribbon on [DRAW] tab
or, type [o] and press [Enter] key
Type a specific number that you want to offset, for this project, enter 7'-4-3/4"
and then press [Enter] key,
and then click a point to the direction that you want to create the copied line,
if you use the same distance, you do not need to enter the number,
if you use a different distance, you must enter a specific number
+ [STEP 06] Repeat [STEP 03] to [STEP 05] for horizontal grid lines
« [STEP 07] Copy the first level grid lines, both vertical and horizontal, for the second level
To copy the lines, please use an even number (e.g., 28'-11" based on the base drawing)
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(CO 3) Draw exterior/interior walls, floor, millwork & openings — Polyline,
Spline, Circle, Rectangle, Mirror, Fillet, Trim, Extend, Array, & Match Properties

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=32

Let’s draw the floor plans (no columns, no furniture, no windows, no doors, no patterns, no symbols, no plumbing, no

dimensions, no texts at this point) with the following commands
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image credit: Screen captured by the Author from the application

Make sure you use the commands below to control and easy selection
[ORTHO)] or [F8] key, [OSNAP] or [F3] key

If needed, you can turn on/off [grid] by press the [F7] key

Polyline(command) - this is for creating a connected line. Once you make an element (wall) with a polyline, the lines will be
connected. This connection is useful in controlling each element.

[STEP 01] Type [pl] on keyboard and press [Enter] key
[STEP 02] Specify start point
+ [STEP 03] Specify the next point.
[STEP 04-01] If you want to close the object, type [c] on the keyboard and press the [Enter] key
[STEP 04-02] If you want to finish the object without closing the object, press the [ESC] key

+ Please refer to this link for the polyline command

Pedit(command) - this used to convert line objects to a polyline

STEP 01
STEP 02

[ Type [pe] on keyboard and press [Enter] key
[

« [STEP 03] Type [y] and press the [Enter] key to turn the objects into one object.
[
[

Specify an object to convert a polyline

[ W/ B s R Y

STEP 04] Select [Join]

STEP 05] Select all connected objects that you want to join as a polyline, and press [Enter] key, and press [Enter] key
one more time to finish the command

+ Please refer to this link for the Pedit command

Explodes(command) - this is to convert a polyline or a block to line objects

+ [STEP 01] Select an object (polyline or a block) to convert to line objects

33 | AutoCAD Session 2


https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-11883C70-6435-4F80-8FB4-F6E933B8FD94-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-0C422AA9-23DD-4650-AD66-68E9D7989E3F-htm.html

+ [STEP 02] Type [x] on the keyboard, and press [Enter] on the keyboard
« Please refer to this link for the Explodes command

Spline(command) — may not be needed for the Eames House project, but you will need it for your project — These

commands for creating a connected curved line.

STEP 01] Type [spl] on keyboard, and press [Enter] key
STEP 02] Specify the first point

STEP 03] Specify the next points

STEP 04] Press [Enter] key to finish

« DPlease refer to this link for the Spline command

[
[
[
[

Circle(command)

« [STEP 01] Type [c] on keyboard, and press [Enter] key

« [STEP 02] Specify a center point

+ [STEP 03] Specify a radius by typing a specific number of by clicking a specific point
« DPlease refer to this link for the circle command

Rectangle(command)

« [STEP 01] Type [rec] on keyboard, and press [Enter] key
« [STEP 02] Specify a first corner point

+ [STEP 03] Specify another corner point

+ DPlease refer to this link for the Rectangle command

Mirror(command)

[STEP 01] Type [mi] on keyboard, and press [Enter] key

[STEP 02] Select an object/objects, and press [Enter] key
« [STEP 03] Specify the first point of the mirror line

[STEP 04] Specify the second point of the mirror line

[STEP 05] Decide whether to erase the source objects or not, and press the [Enter] key to complete the command
+ Please refer to this link for the Mirror command

Fillet(command) - create a corner between two objects

[STEP 01] Type [f] on keyboard, and press [Enter] key

+ [STEP 02] Select the first object
[STEP 02-01] If you want to create a smooth corner, you can specify radius by type [r] and press [Enter] key, and type
[specific number] and press [Enter] key

the radius information will be stored, if you want to create a sharp corner, the R = ‘0’

+ [STEP 03] Select the second object

+ DPlease refer to this link for the Fillet command

Trim(command)

« [STEP 01] Type [tr] on keyboard, and press [Enter] key
« [STEP 02] Select cutting edges
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+ [STEP 03] Select object(s) to trim, and press the [Enter] key to complete the command
« Please refer to this link for the Trim command

Extend(command)

+ [STEP 01] Type [ex] on keyboard, and press [Enter] key

+ [STEP 02] Select boundary object(s)

« [STEP 03] Select object(s) to extend, and press the [Enter] key to complete the command
«+ DPlease refer to this link for the Extend command

Stretch(command)

« [STEP 01] Type [s] on keyboard, and press [Enter] key

+ [STEP 02] Select objects — specify the portion of the object that you want to stretch, using the crossing object selection
method, and press [Enter] key

« [STEP 03] Specify the base point

+ [STEP 04] Specify the destination point to complete the command

+ Please refer to this link for the Stretch command

Match Property(command)

+ [STEP 01] Select source object
« [STEP 02] Select destination object(s)

+ Please refer to this link for the Match Property command
There is no right or wrong way to draw a floor plan, be creative, Designers!!
SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 3. Create dimensions and components

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit dimensions (in model space) - Dim, & Dimension style

(CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door, Window, Column, Plumbing, Furniture &
Equipment

(CO 3) Create custom blocks — Custom furniture

¥ Session Highlights

At the end of the session, students can create the graphics below.
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E.’ Lecture Contents

(CO 1) Add/Edit dimensions (in model space) — Dim, & Dimension style

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=78

Open your working CAD file.

Understand CAD dimension scale settings

« [METHOD 01] Dimension in model space for plotting in model space — This is the traditional method used with

single-view drawings — Need Text height charts for correct text height, and it is challenging to be flexible in drawing
scale.

« [METHOD 02] Dimension in model space for printing or plotting in paper space — This was the preferred method for
complex, multiple-view drawings. (We will practice this method for our project)

« [METHOD 03] dimension in layouts — This is the simplest dimensioning method

+ Please refer to this link for more information about scale for dimensions

Text Heights in paper space (1=1)

+ 10 pt = 3/32” (minimum font to read)
« 12 pt=1/8"(Standard text size)

« 18 pt = 3/16” (Subtitle text size)

« 24 pt=1/4"(Title text size)

Understand the types of dimensions

+ The basic types of dimensioning are linear, radial, angular, ordinate, and arc length.
« Please refer to this link for more information about the types of dimensions
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Before you add dimensions, move the inserted drawing image to avoid accidental deletes and confusion.

100° MOVED TO RIGHT

Move the image to the right side — 100ft or any number that you can easily remember. You might need to move the image
back to the original position.
Note. Make sure you turn on [ortho]

Set Drawing scale

+ Before you start to add dimensions, it is recommended to set the drawing scale. Sometimes, the drawing scale can be
changed for the drawing. However, once you set the drawing scale, less work is needed at the end.

» The drawing scale is defined with some factors — the paper size, purposes of submissions, and so on.

+ For this project, you will be asked to print out your drawings in 11in x 17in (Horizontal layout). Although the inserted
original drawing scale is 3/8" = 1 -0”, your drawing scale should be 3/16" = 1 -0"

« To set the scale, click the drawing scale [1:1] and select the drawing scale [3/16" = 1" -0"]

LN L O-F@RACETO) -+ T OB D=

image credit: Screen captured and modified by the Author from the application

MODEL i |

« If you cannot find the ft-in types of scale, click [Custom] > click [Add] > add the name of the scale [3/16” = 1-0”], add
the value on Paper units [3/16], add the value on Drawing units [12] > click [OK] to complete the custom scale > click
[OK] to set the scale

Set Dimension style

“A dimension style is a named collection of dimension settings that control the appearance of dimensions, such as arrowhead
style, text location, and lateral tolerances.” (Autodesk help, Mar 29, 2020)

Please refer to this link for more information about dimension style

+ [STEP 01] To open Dimension Style Manager,

click [Annotation] ribbon tab, click [ * |] on Dimension panel
or, type [ddim] and press [Enter] key
+ [STEP 02] Click [Annotative] > Click [Set Current] > Click [Modify] to open Modify Dimension Style: Annotative

window
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A Dimension Style Manager

Current dimension style: Annotative
Styles:

PN Annotative)
andard

Preview of : Annotative

Description
Annotative

x

Mew...

Cvemde. ..

Compare. ..

« [STEP 03] Click [Lines] tab
adjust the Baseline Spacing to 1/16"

adjust the Extend beyond dim lines to 1/16"
adjust the Offset from origin to 1/16"
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A Modify Dimension Style: Annotative

Symbols and Amows  Text Fit Primary Units  Altemate Units  Tolerances

Dimension lines

Color: [ ByBlock w
Linetype: — ByBlock et
Lineweight: — ByBlock b

Extend beyond ticks: P <
Baseline spacing: |

Corce

Suppress: [ ] Dim line 1 [ ] Dim line 2
Extension lines
Color: L] ByBlock il (Exteru:l beyond dim lines: 118" =
Linetype et ine 1: | ———— ByBlock w - =

E}Hset from origin: 118 ,)
Linetype est ine 22 | ——— ByBlock o

[ ] Fixed length extension lines
Lineweight: — ByBlock -

Length: 1 =

Suppress: [ | Estline 1 [ ]Ext line 2

Help

« [STEP 04] Click [Symbols and Arrows] tab
adjust the first Arrowheads to / Architectural tick
adjust the second Arrowheads to / Architectural tick
adjust the arrow size to 1/8"
adjust the break size to 1/16"
adjust the Jog height factor to 1/16"
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A Modify Dimension Style: Annotative

Lines (5'_.'111I:u:||s and ;’-‘-rrc:ws)Te,.,-t Fit
Amowheads
Firat:

Primary Units  Altemate Units  Tolerances

(;f-‘-rch'rtectural tick

Second:

[_/ Architectural tick

Leader:
= Cloged filled

Amow size:

Center marks

Dimension Break

Break size:

Arc length symbaol
(®) Preceding dimension text

() Above dimension text

i) Mane

Radius jog dimension

Jog angle: |45

Linear jog dimension
Jog height factar:

[1;1 5"

:) Text height

Cancel Help

« [STEP 05] Click [Text] tab
adjust the text height to 1/8"
select Aligned with the dimension line
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A Modify Dimension Style: Annotative ot

Lines  Symbols and Amows

Text appearance

Primary Units  Altemate Units  Tolerances

Text style: Standard
Text colar: [ ByBlock

Fill colar: [ Mone

Fraction height scale: | 10000 =

[] Draw frame around text

Text placement Text alignment
Vertical: Centerad w i) Horizontal
Horizontal: Eoaerl o

EE] Aligned with dimension Iine]

View Direction: Left4o-Right ~

Cffeet from dim line: 1/8" B () 150 standard

Corce Hel

« [STEP 06] Click [Fit] tab
make sure [Annotative] is checked
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A Modify Dimension Style: Annotative

Lines  Symbols and Amows  Text Primary Units  Altemate Units  Tolerances
Fit options

ff there isn't enough room to place both text and
amows inside extension lines, the first thing to
move outside the extension lines is:

{®) Either text or amows (best fit)
() Amows

() Text

() Both text and amows

() Always keep text between ext lines

Scale for dimension features

[ ] Suppress amows if they dont fit inside _
extension lines [ Annotative ]

Text placement ) i ———

Uze averall gcale of:
When test is not in the default position, place it: ) =

(®) Beside the dimension line Fine tuning

() Over dimension line, with leader

() Over dimension line, without leader ] Draw dim line between ext lines

] Place text manually

Corce Hel

« [STEP 07] Click [Primary Units]
adjust the Unit format to Architectural

adjust the Precision to 0’ -0 1/8"
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A Modify Dimension Style: Annotative ot

Lines  Symbols and Amows  Text Fit emate Units  Tolerances

Linear dimensions
Lnit format: Architectural

Precision 0 1/8"

Fraction format : Horizortal

Decimal separatar: " {Period

Bound off: 0"

Prefix: |

Suffi: | |

Measurement scale

Scale factor: 1.0000 =

[ Apply to layout dimensions only

Angular dimensions

Zero suppression Units format: Decimal Degrees A
Leading Trailing
Sl.ILI.-LII'li‘tS fau:tu:uE Ofeet Precision: 0 et
o Zero suppression
. & 0inches o
Sub-unit suffix: []Leading

[ ] Trailing

Corce Hel

« [STEP 08] Click [OK] to complete the modification > Click [Close] to finish the dimension style manager

Add dimensions

« [STEP 01] Change layer to [A-ANNO-DIMS]
) A_A ; =
g () O of [ A-ANNO-DIMS
; ~ o 8 4 Sh £F Make Current
ayer
Properties £ £4 £5 < £ Match Layer

Layers =

+ [STEP 02] Click [Annotate] ribbon tab > make sure the dimension style is [Annotative] > click [Linear] to draw
dimensions
or, type [dim] and press [Enter]
If Linear doesn’t fit for your purpose, please select the types of dimension that you want to add.
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mn
| [ Home Insert { Annctate ) Parametric  View Manage Output A360 Express Tools  Festured Apps  Acrobat =

A %" Standard - F_‘l (& Annotative Y E A ﬁ\ ///’ /—O Standard - Standard
LS ’
R |Fing text €3 Use Current - =T ’ 7 Add Leader B3 FZ, Extract Data
Multiling “> Dimension =] D ft e T | Center Centerline | Multileader e Table =¥
Text 0" - f—| Linear vIH Quick [ Continue - Mark /B #° Remove Leader Bty B Link Data
Text = | |._.‘ v ‘ ns v u|  Centerlines Leaders u Tables
Start Eames_House_Project_Yongyeon_Cho_0
7| : PROPERTIES 4\7 Aligned
Mo selection @ - <¢E : ) Angular
General =
—a
Color O ByLayer éf?” Arc Length
Layer A-ANNC-DIMS
Linetype ———— ByLayer (™) Radius
Linetype scale 1.0000 o
g Lineweight —— Bylayer l'gj Diameter
@ Transparency ByLayer ~
£ Thickness 0"
: J |
=| [ 3D Visualization - ,/j‘ 099¢c
= Material ByLayer 0 X
ki i V]i Ordinate
Plot style - [
Plot style ByColo ‘

[STEP 03] make sure you turn on Object Snap
Click the intersection point at the top left corner of the building column grids

Click the next intersection point for dimensioning

Click a third time to place the dimension line and text

M Continue -~
[STEP 04] if the dimensions are in a continuous string, please use [continue] from the [Annotation]
tab, [Dimensions] panel.

Add additional dimension lines to the previous dimension.

[STEP 05] Repeat to dimension all column grids for the first floor and overall building dimensions.
—
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Add a new dimension style

— 3/32" text size — Annotative and interior wall dimensions.

[STEP 01] Type [ddim], and press [Enter] key to open [Dimension Style Manager]
[STEP 02] Click [New] to create a new dimension style
+ [STEP 03] Add new style name [Annotative 3-32], check start with [Annotative], [Annotative] checked, and click
[Continue]
[STEP 04] Adjust Arrow size from Symbols and Arrows to 1/8",
adjust Text height from Text to 3/32"
click [OK], click [Set Current] and click [Close]
« [STEP 05] Make sure your layer is correct in [A-ANNO-DIMS]
« [STEP 06] Type [dim], and press [Enter] key and start dimensioning for the interior walls (You don’t need to match

your dimensions exactly, as reference for this project, +/- 4 inches are acceptable)

(CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door,
Window, Column, Plumbing, Furniture & Equipment

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=78
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Understanding the concept of blocks in AutoCAD

+ Ablock is a collection of objects that are combined into a single named object.

+ Although a block and a group in AutoCAD look similar, these are different concepts.
Basically, blocks are copies that will change if you change one, but groups will not change. Groups are unique.

+ Ablock consists of the name of the block, the block geometry, the location of the base point, and any associated
attribute data.

+ For more information about blocks, please refer to this page

Source of blocks

Designers/drafters often bring blocks from outside resources. They use free resources from other websites and/or resources
from the firm for schematic design to save time, resources from manufacturers for design development, and/or construction
documents.

AutoCAD provides some basic blocks. You can find the block from the [Content Browser] and add blocks to [Tool Palette]
and [Design Center]

Cad library websites

+ BIM object - https://www.bimobject.com/en-us
« CAD blocks - https://cad-blocks.net/index.html
« DWG models - https://dwgmodels.com/interiors/

Furniture manufactures websites for the Cad library

« Knoll - https://www.knoll.com/design-plan/resources/furniture-symbols

« HermanMiller - https://www.hermanmiller.com/resources/3d-models-and-planning-tools/product-models/
« Steelcase — https://www.steelcase.com/resources/3d-models-cad/

« AllSteel - https://cms.allsteeloffice.com/Pages/Design-Resources/Planning-Tools/PlanningToolsLandingPage.aspx

If designers/drafters cannot find blocks that they want to use for the project, they can create custom blocks. Sometimes it
saves more time.

Add blocks from Tool Palettes (Use basic blocks from AutoCAD library)

Move the linked Eames House Floor plan image to match the drawing for reference— We moved the image to 100ft to the
right. At this time, move the image back to the original place. If the image is hidden, show the image by clicking [Show Image]
on the Image ribbon. If the image hides your drawing (Cad objects), let’s change the drawing order by mouse right-click on
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the image and click [Draw Order] > click [Send to Back]

Repeat EXECUTETOOL
Recent Input

Clipboard
Isolate

Erase

Mowe

Copy Selection

Scale

Rotate

Draw Order Bring to Front
Group Send to Back

Image Bring Above Objects
Send Under Objects

Add Selected

Select Similar
We will add columns from the tool palettes.

+ [STEP 01] Click [View] tab > Click [Tool Palettes] under Palettes panel to open the panel or, type [TOOLPALETTES]
on the command, and press [Enter] key
Once the tool palettes are open, place the palette in a comfortable location (I personally like all palettes on the left side
of the application.

+ [STEP 02] Click [Structure] tab on the tool palettes > Click [WF beam - Imperial]

+ [STEP 03] Change the layer to [S-COLS]

+ [STEP 04] Place the column on the top-left corner of the building. At this time, you cannot place the [WF beam -
imperial] to the precise location.
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UCS | View |Navigation|
Icon | Cube Bar

B Named E

Join
Viewport
Configuration [G] Restore

Tool
alette

= 28 [f

Properties| Sheet Set

O Switch |
Manager ‘ Windows

Viewport Tools + ‘ Model Viewports Palettes +
v
Start Eames House Project Yongyeon Cho 03% | + |
7| | PROPERTES
=
K]
[N selection EEEEY B
| General - E
Color O ByLayer g
5 B
e S-COLS &l e
= Imperial
Linetype ByLayer g
L Linetype scale 1.0000 E Mament
5 Plot style ByColor =) Cerieaie =
SE Lineweight ByLayer 2 — Splice-
2 .
P Transparency ByLayer Z Imperial
§| 3D Visualizati Bl = Elevation
E | Misc = ‘ g symbol - Im...
g Name WF Beam - Imperial = g, Stepsymbol -
1 Block Unit Inches | ¥ Imperial
Unit factor 1 § [ Channel -
Custom - = L imperial
o) DAl | Metric samples
Depth 43/16" 5]
ui 378" WF Beam -
Tw 174" Metric
_ Block Tablel = (R
= Size 1.0000 [

Moment
Connection...

es | Hatche, (Giuctn) |

]

File
Tabs

R

Layout|
Tabs

Interface

= Tile Horizontally
[0 Tile Vertically

B Cascade

[STEP 05] Move the column to the right position using [osnap] and guidelines

+ [STEP 06] Copy the column to other positions of the first-floor plan; you will need to rotate the drawing and adjust

your drawing according to the column locations.

Tips. Use the intersection with object snap [F3] and ortho tool [F8]

« [STEP 07] Copy the columns on the first floor to the second floor.

AutoCAD Session 3 | 50



You may lock the layers that do not need to be selected. After you copy the columns on the first floor to the second
floor, you may also unlock the layer you locked.

BBl Home Inset Annotate Parametric  View Manage Output A360 ExpressTools FeaturedApps  Acrobat )~

/ o) @ Jr“ O~ # Move ()Rotate +-Tim - A m 11 Linear - @ %f o - £ Create m @ ByLayer
@ - | O3 Copy Mi (Filet + Leader - s e Make Current | - 5, Edit Ve = ByL:
Line Polyline Circle  Arc e A wirer = & | Tot Dimension /2 Lesder § £ G B £F Make Cumen Insert =5 5 Match £t
= = « | [ByStretch 5] Scale 55 Amay - & = [ Table Propetties| ) & £ 4G & Match Layer T '@ Edit Attributes ~ | Properti Bylayer
Draw ~ Modify ~ Annotation ~ Loyers ~ Block ~ Propertics ~ »| Groups ~ | Utilities ~ Clipboard | View ~ »
Start Eames_House_Project Yongyeon_Che 03 +
o | Current layer.0 Searchforlayer  Q
R R -]
Filters «| 5. Name . Color Linetype Lineweight Transp..

=% Default
LUVESTY =  ASANNO

Layer Properties Manager

& 5-COLS

= 5-GRID
= SLEVL y

Edit a Dynamic block

You can find [Door-Imperial] and [Window-Imperial] from the Architecture tab on the tool palettes to add to your drawing.
However, the currently loaded blocks (ex. [Door-Imperial] and [Window-Imperial] with a thunderbolt image) on the tool
palettes are called [Dynamic block], a dynamic block is a parametric block that users can easily modify.

STEP 01] Click [Window - imperial] on the tool palette

STEP 02] Place [Window - imperial] block in your drawing

STEP 03] Double-click [Window - imperial] to open Edit Block Definition
STEP 04] Click [OK] to open the Block Editor

.
— o
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B Edit Block Definition

Block to create or edit

Window - Imperial

<Current Drawing>
_ArchTick

Door - Imperial

Door - Left Hung 36 in.
Drawing Title - Imperial
| Beam - Imperial
Staircase - Spiral

WWF Beam - Iﬁeﬁal

+ [STEP 05] Select [Width=3’-0"] and adjust [Dist type] to [Increment] on the properties palette. And adjust [Dist

increment] to [1/4”]

PROPERTIES

| Horizontal Constaint Parameter

[-] @+ 4

| General -]
Color ® Bylayer
Layer 0
Linetype ByLayer
Linetype scale 1.0000
Plot style ByColor
Lineweight ByLayer
Transparency Bylayer
Hyperlink

Constraint

Name Width
Expression 36
Value ¥
Description

| Geometry
Dim line offset -1-75/8"

| Value Set
Dist type Increment -

Dist increment
Dist minimum
Dist maximum x

Misc
Show Properties Yes
Number of Grips 1

[STEP 06] Select [Wall=0"-4"] and adjust [Dist type] to [Increment] on the properties palette
[ ] Click [Save Block] from the [Block Editor] ribbon
[STEP 08] Click [Close Block Editor] to close

[STEP 09] Relocate the window and update the size of the window according to the floor plan

STEP 07

bles | Hatche.

Imperial samples

Door -
2 imperal

 Window -
T2 imperial

Aluminum

Window (Ele...

Fluorescent

S=7 (Recessed) -

Stud -
Imperial

Toilet -
=, impenl
Trees -

Imperial

Vehicles -
% mperal

Door

Elevation - ..

Metric samples

23, Door- Metric

Window -

T2 Metric

I ] Aluminu m
4 Window (Ele...

Fluorescent

B (Recessed) ..

& Stud - Metric

L PALETTES
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Repeat the steps for [Door-Imperial]. You will need to change the [Dist type] for [Door Size] and [Wall Thickness]

Complete placing and adjusting windows (curtain walls) and door (interior and exterior doors) within correct layers. If you

can find the blocks, you can draw the elements with [line] or [poly line]

Add more blocks using [Design Center]

Design Center is a tool to access and add blocks, Dimension styles, Layers, Layouts, Line types, Multi leaders, Table styles,
Visual styles, and Xrefs.

For more information about the Design Center, please refer to this page

I am going to demonstrate how to load a sink from the AutoCAD sample blocks.

+ [STEP 01] Change layer to [P-FIXT]

+ [STEP 02] Click [View] tab > Click [Design Center] icon &
or, Type [adcenter] on the command line, and press [Enter] key to open the Design Center window
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= Tile Horizontally

[0 Tile Vertically

PROPERTIES

[Noselection

| General

AUTODESK® SEEK

External References

[STEP 03] Once you click the [Home] icon

, you can find [en-us] folder > double-click to op

click to open [Design Center]. You can find some sample drawings containing blocks

| m
abase | en-us | Mechani
onnectivity Sample

VBA  VisuallISP

ical  Sheet Sets

en [en-us] > double-

The folder structure may be different from the versions of AutoCAD, but generally, you can find the sample CAD files
C:\Program Files\Autodesk\AutoCAD 2020\Sample\en-us\DesignCenter
[STEP 04] Double-click [Kitchens.dwg] > Double-click [Blocks] > Double-click [Sink-single-30 in top] to inset in your
file > Click [OK] to confirm the information

[STEP 05] Place the sink in the kitchen, using object snap

- Dual

[ —
Range-Oven Range-Oven Range Hood
-30infront -30intop - 30infront

I O =

Refrigerato... Refrigerato.. Sink-double
door - 36 in... door - 36 in...

[]

Sink-single - Wall Cabinet Wall Cabinet
intop -18x12in.. -18x36in...

- 36intop

DesignCenter Kitchen example

[STEP 6] Click the inserted block [Sink-single-30 in top] > Mouse right-click > Click [Edit Block In-place] > Click [OK]
on reference Edit

[STEP 7] Use [Stretch] tool to resize the sink, and delete elements that are not needed, and add geometrics for the sink

Note 1. For the assignment, you don’t need to make the model 100% the same. Some flexibility will be acceptable
(shape of sink and faucet)

Note 2. When you draw a new line and element, use the [0] layer in a block
[STEP 8] Once you are done with the editing > Click [Save Changes] on the [Home] ribbon, under [Edit Reference]

panel
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If you want to rename the block, type [rename] on the commend. > Click [blocks] > Click [blocks that you want to rename]
If the block is your own or whether it was modified from another or created new, add [000_] in the first part of the block
name to recognize/find the block easily

A Rename

MNamed Cbjects

Detail view styles
Dimension styles

ftems

_ArchTick
_ClosedBlank
Doar - Imperial

Door - Left Hung 36in.
Drawing Title - Imperial
| Beam - Imperial

Linetypes
Materials

Multileader styles
Section view styles
Table styles

Sink-double - 36 in top
Sink-single - 30in top
Staircase - Spiral

Text styles
UCSs

WF Beam - Imperial
Window - Imperial
Viewports
Views

Qld Mame:

Bename To:

|Sink$ingle - 30in top

D00 _Sink-single - 38 in top

If you want to use a downloaded CAD file (e.g., https://cad-blocks.net/kitchen-cad-blocks-kitchen-sink.html ).

+ Save the downloaded file in a project folder

+ Open the [design center]

+ Click [Load]

+ Find the project folder where you saved the downloaded cad file
+ Click [Open] to load

« Double-click [Blocks]

+ Select a block that you want to use in your project and double click to load

If the inserted block is the wrong scale, adjust the scale.
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Please use these strategies to draw plumbing fixtures in the kitchen and bathrooms.
You will select your selections of blocks. The below image is a reference only.

« Add (2) beds in the bedrooms

« Add (1) desk and chair set in the bedroom

+ Add (1) dining table-chair set in the dining area
« Add (1) table in the alcove

« Add (1) table in the living room

» Add bookshelves in the living room

+ Add (1) lounge chair in the living room

+ Add (2) chairs in the living room

We will ask you to create custom furniture (sofa set) below.

(CO 3) Create custom blocks — Custom furniture

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=78

Sometimes, you may experience difficulty finding CAD blocks from CAD library websites and/or manufacturers’ websites.
Especially, it is hard to find furniture blocks for residential projects. In this tutorial, you will learn how to create blocks using
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product information and photos. I will demonstrate it using two different sofa sizes from the website Design Within Reach

(DWR). You will create using your selections of furniture for the project.

Create an 86" sofa block

« [STEP 01] Retrieve the product information (dimensions) and images from the DWR website

« [STEP 02] Change layer to [0] > Draw overall size of the sofa (Width=86" & Depth=33") using [pline] or [rectang], make
sure turn [ortho] on for 90 degree

« [STEP 03] Download or screenshot the product image to your project folder
Most of the time, you cannot find a top view of a product. You may rely on a front view to draw a floor plan view for
the product.

+ [STEP 04] Insert the front view image into your drawing file. Click [Insert] tab > Click [Attach] > Click the downloaded
file > Click [Open] > Click [OK] on Attach Image > Click once on the drawing area > Click once again near the first
point > Click the inserted image > Adjust the [Fade] value to [50] > mouse right-click on the image > Click [Drawing
Order] > Click [Send to back]

« [STEP 05] Relocate and rescale the inserted image to match the overall sofa dimensions.

For relocating, you will need to use [Move], [Rotate], and [osnap] command.
For rescaling, you will need to use [scale] with Reference [R].

« [STEP 06] Draw the details of the sofa using [line], [pline], [rectang], and [circle]. Use the detailed dimensions what the
website provided. Also verify the dimensions using [distance] - type [di] and press [Enter] key

+ [STEP 07] Before defining the lines to a block, make sure all lines are in the [0] layer.

« [STEP 08] Select all lines for the sofa (excluding the inserted image) > Type [b] on the command line and press [Enter].
Block Definition window will open > Name the block something meaningful (e.g., 000_DWR-Bantam_Sofa-Plan) >
Click [OK] > Change the block from [0] layer to [I-FURN] > If you don’t need the inserted image anymore, you can

delete the image.

Create a 73" sofa block using the [ooo.DW R-Bantam Sofa-Plan] block

Rather than redraw the 73" sofa block from scratch, you can start with the [000_DWR-Bantam_Sofa-Plan] block and using
the Stretch tool to adjust the length.

« [STEP 01] Type [co] to copy [000_DWR-Bantam_Sofa-Plan] block or Insert the [000_DWR-Bantam_Sofa-Plan] block
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on the drawing area — Click [Insert] tab > Click [insert] icon under Block panel > Select the block > place the block on
the drawing area.

« [STEP 02] Type [x], and press [Enter] key. The Explode command breaks up a block into individual lines. This
commend is useful to convert a block into elements for redefining a block.

For more information about this command, refer to this page.

« [STEP 03] Use [Stretch] commend to resize the sofa. And edit the details.

+ [STEP 04] Create a new block by typing [b], and pressing [Enter] > name the block [000_DWR-Bantam_Sofa-73-Front]
> update the layer to [I-FURN] > place the sofa

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Core/files/GUID-E98BCEF4-DED6-48A6-87EB-10FE87188083-htm.html
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Chapter 4. Draw elevation and sections

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Draw a section
(CO 2) Draw an elevation from the floor plan
(CO 3) Add/Edit Text & Annotation (in model space-annotative) - M Text, Text Style, M leader, and Multileader Style

£ 2 Session Highlights

At the end of the session, students can create the graphics below.
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(CO 1) Draw a section

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=80

“A section is a cut-through of a space that will show more of the room’s features. It also allows you to show some structural
detail. A section line can be cut from any part of the space, depending on what you would like to show.”
Retrieved from https://www.nda.ac.uk/blog/identify-plans-elevations-sections/

“A ‘section drawing, ‘section, or ‘sectional drawing’ shows a view of a structure as though it had been sliced in half or cut
along another imaginary plane.”

Retrieved from https://www.designingbuildings.co.uk/wiki/Section_drawing
For more information about a building section drawing, please read this page: https://www.designingbuildings.co.uk/wiki/

Section_drawing

In this tutorial, students will draw a building section based on Eames House, House, Section A-A’ drawing, the plan south

section (You can download the image from Canvas Module and this link Eames_House_House_Section_A-A’jpg), and your
space planning (Furnishings, fixtures, and equipment).

I T I

HOUSE, SECTION A-A'

SCALE 3/8" = 10"

image credit: Screen captured by the Author from http://www.loc.gov/pictures/collection/hh/item/ca4169/ (Eames House

as-built drawing, public domain)

+ [STEP 01] Open your CAD file for the Eames House Project.
« [STEP 02] Copy the floor plans (1st floor & 2nd floor) to the right side 100". This step is optional, but I prefer to save
the original plans and to use the copied plans for creating a section view.
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Specify second nt or [Array] <use first point as displa:ement>l me‘j
L econd point or [Array Exit Unde] <Exit>

« [STEP 03] confirm you are in [0] layer and Draw a section line (recommended to use [PLINE]) on the first floor for a
section view. Copy the section line in the same position for the second floor. You can rely on a column grid line. (For
section line, you can break and offset the line to focus on key interior and/or architectural elements. The line should
start and stop outside of the plan, and you should add a small perpendicular box to indicate the direction of the section
view. Update the section lines to the [A-ANNO] layer.

.
| Perpendicular

+ [STEP 4] Draw a perpendicular line from the section line on the first floor to indicate the building boundary and
drawing boundary.
+ [STEP 5] Insert the section drawing (Eames_House_House_Section_A-A’jpg) by clicking [inset] > click [attach] > select

the file Eames_House_House_Section_A-A’jpg from your project folder > click [open] > click [ok] on Attach Image

window > click a base point and the second point to insert the image > adjust Image Fade to 50 > mouse right-click on
the image > click [Draw Order] > click [Send to Back]
+ [STEP 6] Relocate (use [move] command) and rescale (use [scale] command) the inserted image to fit the building
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boundary for the section lines.
Note, you must use the object snape [F3] appropriately when you adjust the scale. Sometimes the object snap works

perfectly to click the CAD object. Sometimes the command does not work to click a point in a raster image.

[STEP 7] Now, you are ready to draw the section with the inserted image.

> Note 1. You will rely on the dimensions on the inserted image, the lines on your floor plan. Use numeric values to
draw lines (please, don’t just click on the image except for the spiral stair. The image is reference only because the
scaled image is always a bit off).

> Note 2. Create three new layers

» [A-LWT-OBJECT] 0.2mm - The edges of objects, and represent a change in depth
« [A-LWT-SECTION] 0.5mm - The lines are representing the boundary of anything cut-through
= [A-LWT-SURFACE] 0.05mm - The lines are detail lines on an object. They don’t represent much (if any)
change in depth
> Note 3. Use [LINE]. [PLINE], [SPLINE], [CIRCLE], [TRIM], [OFFSET], [FILLET], [EXTEND], and [STRETCH]
commands.
> Note 4. You also update the line type manually for door and window openings.
> Note 5. First, you draw the guidelines. You are using [xline] for creating a line of infinite length.
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o Then, you draw the section lines.

o After that, you draw the object lines.

o Draw surface lines for details.
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« [STEP 8] Move the section and the section lines that you drew except the inserted image 100’ to the left to save the

section drawing in a safe drawing area.
« [STEP 9] Create a block for the section. Select all the elements in the section > Type [B] for creating a block > Define
the name [000_Section A-A’] > Click [OK]

(CO 2) Draw an elevation from the floor plan

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=80

“An elevation is a view from the side of an object when drawing interior elevations; this would represent one of the walls.
This would include any windows or doors as well as any built-in furniture that is in direct contact with the wall.”
Retrieved from https://www.nda.ac.uk/blog/identify-plans-elevations-sections/

“The term ‘elevation’ refers to an orthographic projection of the exterior (or sometimes the interior) faces of a building, that
is, a two-dimensional drawing of the building’s facades.”
Retrieved from https://www.designingbuildings.co.uk/wiki/Elevations

In this tutorial, students will draw an interior elevation based on Eames House, House, Section C-C’ drawing, the plan west
elevation in the living room. Students will not draw a section. You will need to understand the concept of elevation and will

draw only interior elevation.
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« [STEP 01] Decide an elevation view.

7143 :
743 —f

: Q

E

« [STEP 02] Draw outline of the elevation by using [xline] to draw the boundary of the elevation.
+ [STEP 03] Rotate and relocate the section view c-c’ from the inserted image to match the boundary of the elevation.

You will need to rotate 90degree clockwise.

« [STEP 04] Rotate the copied floor plan and the inserted image to 90degree counterclockwise. The reason for this step
is to draw the elevation quickly. It typically takes less time to draw the elevation in the right direction (Up-North,
Down-South, Left-West, and Right-East).

« [STEP 05] Remove the elements that are not needed from the copied floor plan. Make sure you saved the original floor
plan. You only delete the elements in the COPIED floor plan.
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« [STEP 06] Now you can draw the elevation

o Draw floor level and ceiling level (8’ -1” AFF) (Typically, an interior elevation expresses interior elements only.
You don’t draw wall thickness, window cut, ceiling structure, and roof structure.) > Change the lines for the wall
ends, floor level, and the ceiling level to [A-LWT-SECTION]

o Switch the layer to [A-LWT-OBJECT] > Draw wall and furniture by using [LINE], [PLINE], [CIRCLE], [FILLET].
[TRIM]

o If needed, switch the layer to [A-LWT-SURFACE] > Draw anything that is not important in terms of construction.

« [STEP 07] Add dimensions and opening for more information

o On the Application Status Bar, switch the scale to 3/8” = 10"
o Type [ddim] and press [enter] to open [Dimension Style Manger]
o Click [Annotative-3-32] > click [Set Current] > click [Close]
o Type [dim] and press [enter] to add dimension
> You will need to click the first extension line origin > click the second extension line origin > specify dimension
line location. Repeat this process to add dimensions for the casework.
« [STEP 08] Make a block for the elevation.

o Select the elevation, including lines and dimensions.
o Type [b], press [enter] to open [Block Definition]

o Define the name [000_Elevation-A]

o Click [OK] to finish the command
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« [STEP 09] Organize your drawings.

o Move the inserted — reference images to 75’ plan north.
o Move your section and elevation on the right side of the floor plans.

(CO 3) Add/Edit Text & Annotation (in model space — annotative) — M Text,
Text Style, M leader, and Multileader Style

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=80

In this tutorial, students will learn how to add and edit text and annotation in the drawing area by using [MULTILINE
TEXT], [TEXTSTYLE], [MULTILINE LEADER], and [LEADERSTYLE]
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Add room names and room numbers on the floor plan.

« [STEP 01] Switch to the [A-ANNO-TEXT] layer
« [STEP 02] Adjust units by typing [UN] and press [enter] to open [Drawing units].

o The current unit precision is 0’ -0 1/16"
o Change the unit precision to 0' -0 1/32"
o Click [OK] to close the Drawing units window
+ [STEP 03] Add two text styles for the room names and room numbers

o From the Annotate tab, Text panel on the ribbon, Click [Standard] > Click [Manage Text Styles]

DBEEE‘ tm<c-a-+
fr
Home  Insert Parametric  View  Manat

A % |standard G) "_" A

A Por

Multiline AaBb123 Dimension

Text |E| f=
Standard

Start [Manaqe Text Styles... ];}f&un_Chn_Dsl*

o> On [Text Style] window, click [New]

o Enter Style name [Annotative 1-8] and click [OK]

o Confirm [Annotative] is checked, update Paper Text Height to [0-0 1/8"]
o Click [Apply]

o Click [Set Current]

o Click [New]

o Enter Style name [Annotative 3-32] and click [OK]

o Confirm [Annotative] is checked, update Paper Text Height to [0'-0 3/32"]
o Click [Apply] and click [Close]

tres
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B Text Style et

Current text style: Annotative 1-8
Styles:

Font
ﬁnnntativ& 1-8 Fort Name: Fort Style:
Standard T Avial w Regular -
Ilse Big Font
Paper Text Height
[] Match text orientation &D'—l} 1/8" J]
to layout
All Sh"'ES " Effects
[] Upside down Width Factor:
| 1.00000 |
[ ] Backwards
AaBb123
Vertical | 0 |

« [STEP 04] Add room name

o Verify the Text Style is [Annotative 1-8] from [Annotate] tab, on [Text] panel
o Click [Multiline Text] from [Annotate] tab, on [Text] panel
or, Type [mt] and press [Enter]
o Define a text box for a room name. Using All Caps are recommended for a room name. Sometimes, use an
acronym. (e.g., LIVING RM)
o Enter [a room name] and click a point outside of the text box.
« [STEP 05] Add room number

o Verify the Text Style is [Annotative 3-32] from [Annotate] tab, on [Text] panel

o Click [Multiline Text] from [Annotate] tab, on [Text] panel
or, Type [mt] and press [Enter]

o Define a text box for a room number.

o Enter [a room name] and click a point outside of the text box. Typically, each room requires one number, e.g., 102
(The first number (1) indicates the floor number. In this case, the living room is located on the first level. The
second and the third number (02) indicate room number that starts from the main entry to clockwise. In this case,
the HALL is 101; LIVING RM is 102.

o Draw a box around using [RECTANGLE]

+ [STEP 06] Create a block for the room name and number that you just created. Name the block to [000_Room name
and number]
Note. This strategy is useful because once the block is updated on the floor plan, the room names and room numbers
are automatically updated on other plans like a ceiling plan, finish plan and more.

« [STEP 07] Use [Edit Block-in Place] to copy the room name and number to all rooms > Edit the names and numbers by
double-clicking the name and the number > Click [Save Changes] to close [Edit Block-in Place]

« [STEP 08] Update the block from [A-ANNO-TEXT] layer to [0] layer
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Add text and annotate on the floor plan

« [STEP 01] Switch to [A-ANNO)] layer
« [STEP 02] Draw lines for openings and change [line type] to [Dashed]

otate %‘ Tim - A |'—'| |+ Linear ~ DL\VAI‘:INO - L& Create ELG ByLayer - [DJ 2% E 5] |—|__|
P (603 © (8 | o ey T T ohhsEnEs o B Match M | easire B page D o
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Todify ~ Annotation ~ Layers ~ Black ~ ByLayer Groups = | Utilities ~ Clipboard  View ~
Cho_0a* ByBlock

W _ - CENTER

Continuous

— — — DASHED

« [STEP 03] Add multiline texts
o Add [OPEN TO BELOW] text on the second level above the LIVING RM-102. Make sure the scale is 3/16” =1’ -0"
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while you add the text
o Add [OPEN TO HALL] and [OPEN TO KITCHEN] texts on the [ELEVATION A]. Make sure the scale is 3/8" =1

-0” while you add the text

Add annotates on the elevation A

+ [STEP 01] Switch to [A-ANNO-TEXT]
« [STEP 02] Click [Manage Multileader Styles] from Annotation tab, Leader panel, under Standard
&I Home  Insert Parametric  View Manage Output Add-ins Express Tools  Featured Apps (38

A “5 A Annotative 3-32 - A Annotative-3-32 v A 7'7 — O E Standard -
A A NS — ¥ =
Y] £ [ Use Current e % [ Extract Data
Multiline _ _lE X Dimension = B I IT 121 | Conter Centerine | Matieader ¥
Text & 332 - {{ Linear - [5] Quick [ Continue - Mark % [ Link Data
Text « Dimensions + ) Centerlines Tables

Eames_House_Project_Yongyeon_Cho_04* A Annetative 3-32 Standard

IManage Multileader Styles. .

Manage Multileader Styles...

Press F1 for more help

alettes - All Palettes

+ [STEP 03] Click [NEW] > Add a new name for leader style [Annotative 3-32] > Check Annotative box on > Click
[Continue]

« [STEP 04] Update these values to 3/32" — Text height from Content tab, Landing gap from Content tab, Arrowhead
size from Leader Format, Break size from Leader Format, and Set Landing distance from Leader Structure > Click
[OK] to close the window

« [STEP 05] Click [Set Current]

« [STEP 06] Click [Multileader] from the Annotate tab, on the Leader panel
or, type [MLD] to add leader and text

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 5. Draw ceiling plans

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Draw RCPs from Floor plans
(CO 2) Add/Edit Hatch
(CO 3) Create a legend for the RCPs

* Session Highlights

At the end of the session, students can create the graphics below.
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(CO 1) Draw Reflected ceiling plans (RCPs) from floor plans

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=82

In this tutorial, you will learn how to draw an RCP in AutoCAD.
Open your AutoCAD file

Copy elements from the floor plan

+ [STEP 01] Turn layers off that are not needed to copy for the RCPs.
Turn off the following layers: A-ANNO, A-ANNO-DIMS, A-ANNO-TEXT, ANNO-TTLB, A-CLNG, A-CLNG-
PATT, A-DETL, A-FLOR, A-FLOR-FNSH, A-FLOR-HRAL, A-LWT-OBJECT, A-LWT-SECTION, A-LWT-SURFACE,
Defpoints, [-FURN, P-FIX, S-LEVEL

LAYER PROPERTIES MANAGER
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Q W 160 Continu.. Defa..
& A-LWT-OBJECT [ [30 Continu.. 0.20..
£ A-LWT-SECTION [ [ 181 Continu. 0.50.
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= Defpoints 'l Defa
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& S-GRID Q W10 CENTER — Defa..
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< >

Command :
%~ All: 27 layers displayed of 27 total layers = |

wooeL # i - [ @+ - [Z]T] - E)[X] K] A 3/8°=1-0"~ £ Drofting & Annotation ~ + J0 [3, Y] =

« [STEP 02] Copy the remaining elements to 100’ plan south direction
« [STEP 03] Turn on all layers
+ [STEP 04] Clean up the plan

o In the space, we want to show all door openings, but not the doors themselves. To remove the door swing, you
must Explode the door blocks and remove the doors themselves and swings
o For the casework, remove the casework that is not below 5 ft.
o Extend lines as needed to clean up the plan
« [STEP 05] Lock [S-GRID] layer > Select all walls and elements for the RCPs > Switch to the [A-CLNG] layer.
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« [STEP 06] Make the [A-CLNG] layer to the Current Layer
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+ [STEP 07] Add ceiling elements (height changes and ceiling structure if it is the open ceiling)

« [STEP 08] Make the [A-CLNG-PATT] layer to the Current Layer > Confirm the layer color to 34 > Add ceiling pattern
+ [STEP 09] Make the [A-CLNG-PATT] layer to the Current Layer > Add ceiling annotation
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« [STEP 10] Copy the room name and number block from floor plan
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« [STEP 11] Create Lighting symbols

> You can bring lighting symbols (blocks) from other websites or the samples from Electrical-lighting folders using
[DESIGN CENTER]
> And you also can make your own symbols for your project. I created eight types of lighting fixtures

6" RECESSED LED LIGHT

10" SURFACE MOUNTED LED LIGHT

4" WaALL MOUNTED LED LIGHT

32" PENDANT LED LIGHT

28" DECORATIVE PENDANT

LIGHT

48" SUSPENDED LED LIGHT

24" UNDER. CABINET LIGHT

36" UNDER. CABINET LIGHT

« [STEP 12] Add [A-CLNG-FIXT], color - 190, lineweight — 0.25mm > Place lighting symbols (blocks) in the floor plans
> Switch the light symbols to [A-CLNG-FIXT]

« [STEP 13] Select all lighting symbols from the floor plans > Create a block [000-lighting fixtures] > Move the block to
the RCPs
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+ [STEP 14] Select the block on the RCPs> Mouse right-click > Select [Edit Block in-place] > Adjust and align the
lighting fixture with add dimensions > Click [Save changes]
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(CO 2) Add /Edit Hatch

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=82

« [STEP 1] Hide unnecessary layers for better hatch results

o Confirm the current layer is [0] layer
o Turn off all layers except [0], [A-WALL], [A-LWT-SECTION], and [A-CLNG] layers
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+ [STEP 2] Draw lines or pline to create a closed object

o Hatch only recognizes a closed object. Thus you must make a closed pline or lines that are completely closed. If
you are unsure the object is closed or not, you have to try the Hatch command first. If the hatch command doesn’t
work, you have to redraw using [PLINE] or use [PEDIT] to convert from lines to [pline].
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« [STEP 3] Add hatch for the wall

o Confirm the current layer is [A-WALL]

o Click the Hatch icon from the [HOME] tab, on the Draw panel
or, type [H] and press [ENTER]

o Select Solid from the [HATCH EDITOR] tab, on the [PATTERN] panel

o Select color nine from the [HATCH EDITOR] tab, on the [PROPERTIES] panel

> As you move your mouse cursor over a closed object, the hatch pattern fills the area. If you don’t get the preview,
that means you don’t have a closed object.

o You can select multiple files for one hatch command

o Press [ENTER] to finish the hatch command
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« [STEP 4] Copy wall fills to RCPs

o Select the wall fills you just made. if necessary, you also can make a block for the wall fills by typing [B] and press
[ENTER]

o Change drawing order to [SEND TO BACK] by clicking mouse right-click and select [SEND TO BACK]

o Copy the wall fills from the floor plans to the RCPs
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« [STEP 5] Add hatch for the section view

o Select the section view

o Mouse right-click > select [EDIT BLOCK IN-PLACE] > Click [OK]

o Draw lines or polylines to make a closed object. Make sure you are in a correct layer

o Select [HATCH] icon from [HOME] tab, on [DRAW] panel
or, Type [H], and press [ENTER] key

o Select a closed wall, floor, ceiling area. You can select multiple areas for one hatch—Press the [ENTER] key to
finish the comment.

o Update the hatch fill layer to [A-LWT-SECTION]

> Once you finish hatching, click [SAVE CHANGES] to save the block > Click [OK]

+ [STEP 6] Turn on all layers
The Hatch command is to fill an enclosed area or a selected-closed object with hatch patterns or fill.
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Hatch is often used to add a fill to the wall, floor, and ceiling thickness for better readability.

Moreover, the hatch is also used to add patterns on a surface to express the finishes.

In this tutorial, you will practice adding solid fills on the wall of the floor plans and RCPs. This is commonly referred to as

poche. Additionally, add a hatch pattern on the wall, floor, and ceiling of the section view.

(CO 3) Create a legend for the RCPs

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=82

In your RCPs, a legend is necessary to inform what items are included, such as lighting fixtures, finishes, equipment, HVAC,

and more that are used in your RCPs.

In this tutorial, you will make a lighting legend that you used in your RCPs

« [STEP 1] Find/organize the lighting fixtures that you used

o

o

o

Copy the lighting block from the RCP to an empty drawing area

Explode the lighting block by typing [X] and press the [ENTER] key

Remove all dimensions from the exploded lighting block. You can lock the [A-CLNG-FIXT] > select the
dimensions > delete the selected dimensions by press the [DELETE] key, or type [ERASE] and press the [ENTER]
key

Delete duplicated lighting fixtures. You only need one lighting fixture block of each lighting fixture type.

Organize the lighting fixtures vertically. You can draw a line for a reference.

AutoCAD session 5 | 84


https://iastate.pressbooks.pub/visualgraphiccomm/?p=82#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=82#pb-interactive-content

o [STEP 2] Create a table with lines

o AutoCAD offers a Table tool to create a table. You can find the tool from the [ANNOTATE] tab under the
[TABLES] panel. However, this table tool is used for very complicated documents. As an interior designer with
more than ten years’ experience in the industry, I still use lines to create a table. Please try the table tool if you
want.

o Copy the reference line for the column lines for the table. You can use the [OFFSET] command, too.

o Draw rows with lines

> To clean up lines, use [TRIM] commands
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« [STEP 3] Add texts to the table

o Make sure your drawing scale is 3/16”=1"-0.”
o Type [MT] and press [ENTER] to draw a text box and add text
o Repeat the [MTEXT] command for other text. You also can copy from what you created.

LIGHTING LEGEND

6" RECESSED LED LIGHT
10" SURFACE MOUMNTED LED LIGHT
4"\WALL MOUNTED LED LIGHT

32"PENDANT LED LIGHT

258" DECORATIVE PENDANT

mopeL # i v L] &~ Y\~ [Z][[]~ = [K][K] (36" =1-0"~) & De

« [STEP 4] Select the table and table contents > Switch to [A-ANNO] layer
+ [STEP 5] Make the table as a block [000-Lighting Legend]

AutoCAD session 5 | 86



SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 6. Set sheets

@’ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand Model space and Paper space
(CO 2) Set a new layout — Page layout and plot styles
(CO 3) Set views in Paper space — Defpoints, scaling
(CO 4) Add/Edit/Draw a titleblock

“® Session Highlights

At the end of the session, students can create the graphics below.
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E? Lecture Contents

(CO 1) Understand Model space and Paper space

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=84

In this tutorial, you will understand the differences between the concept of model space and the concept of paper space.
AutoCAD provides two different types of drawing areas.

f MODEL SPACE

+ Model space — A limitless drawing area. You draw at a 1:1 scale.
+ Paper space — To prepare your drawing for printing, use paper space. Paper space is a pre-defined and set area. Please
refer to the information from this link.

Clean up the CAD file

+ Purge is a command to automatically removed all layers, blocks, dimension styles, and more items that are not
currently used in your document. This command is a useful command to reduce the file size.
« Type [PURGE], and press [ENTER] key, select [PURGE ALL], and purge all again until the [PURGE ALL] is grayed out.
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A

Named Cbjects

(®) View items you can purge

O\d‘ley items you cannot purge
ttems not used in drawing:

Purge - Confirm Purge

| Doyouwantto purge block DWR Bantam

imension styles

Sofa 86 Plan? s

Layers
inetypes
o Materials
Purge this item
=2 g -t Mine styles
&) Multileader Styles
—> Purge all items - ||& Plat styles
-4 Section view style
SR -Bo Shapes
—> Skip this item ] Table styles .
A Tt bt

Confirm each item to be purged
[[] Purge nested items
Unnamed Objects
[ Purge zero4ength geometry and empty text objects

[ Automatically purge orphaned data

Punge Purge Al Close Help

(CO 2) Set a new layout — Page setup

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=84

In this tutorial, you will understand how to set a new layout in the paper space using page setup.

Once you click [LAYOUT 1], you will see the models you made in the model space in a rectangular box. It is called a viewport.

There is a dashed line that is inside of the white space; it is called a printable area.

And the white space called a layout. Once you change the paper size to print, the layout and the printable area will change

accordingly.

Update Page setup for 11in x 17 in PDF

+ [STEP 1] Open Page setup manager

o

o

o

Mouse right-click on [LAYOUT 1]
Click [PAGE SETUP MANAGER]
Click [*Layout1*] and select [MODIFY] to open the Page setup

+ [STEP 2] Edit Page Setup

o

o

o

Click the name of printer/plotter and switch to [DWG To PDF.pc3]
Update paper size to [ANSI full-bleed B (17.00 x 11.00 Inches)
Confirm What to plot: [LAYOUT]

Confirm Plot scale to [1:1]

Change Plot style table to [monochrome.ctb]
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o

Check [Display plot styles]

Check [Landscape] for the drawing orientation
Click [OK] - Page Setup - Layout 1

Click [Close] - Page Setup Manager

]

o

o

o

il lde] [

Page Setup - Layoutl x
9 p - Ly

Page setup Plot style table (pen assignments)

(- Yisplay plot styles

A Page Setup Manager

Printer /plotter
N Name: ﬂE DWG To PDF.pc3 Properties
53 Current layout: Layoutl = = Ql | o ‘ Shaded viewport options
Plotter: DWG Ta PDF - PDF ePlot - by Autodesk Shade plat As displayed i

Page setups 170 —f

Current page setup: <None> ; L Quality %
Description: = :
hazuutl* l Set Current b
T DRI 100

==
Paper size Plot options
ST
Import.

T

{ avist ful bleed B (17.00 x 11.00 Inches) P

[JPlot transparency
Plotarea Plot scale [] Plot with plot styles

Selected page setup details What to plat: Fit to paper [ Plot paperspace last
Device name: Mone | Layout ~) [ Hide paperspace objects
Flotter: None

Plot offset (origin set to printable area) Drawing orientation

Plot size: 8.50 x 11.00 inches {Landscape)
¥ [0.000000 | inch Center the plot (O Portrait
Where: Not applicable unit
andscape
Description: The layout will not be plotted unless a new plotter y: [ 0.000000 | inch [ Scale lineweights

configuration name is selected. [ Plot upside-down

l oK i Cancel

[Display when creating a new layout [ Preview... | Help

Command: _.PAGESETUP
Press ESC or ENTER to exit, or right-click to display shortcut menu.

[~ PAGESETUP
. Model  [Layout1

+ [STEP 3] Confirm the layout with an updated sheet size

Local\Temp _House_Project_Yongyeon_Cho_06_1_25969_6eeBhccd.sus ...

PR [l |~ W~ [£] 7]~ = 15 A2 X % Drafting &Ann

« [STEP 4] Update the name of the sheets and add sheets

> To update the name of sheet > mouse-right click on the tab > Click[RENAME] > Rename on the tab
o To add a sheet > click [+] tab

= Update the name of Layoutl to A101. A101 is for the floor plans
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= Update the name of Layout2 to A102. A102 is for the furniture plans
» Add a new layout and change the name to A401. A401 is for RCPs
= Add a new layout and change the name to A601. A601 is for the section view and the elevation

‘|Regenerating layout.
) Regenerating model.

Y 50 -
Model AT01 A102 A401 Asl1 +

« [STEP 5] Update other sheets to 11x17 PDF

o Mouse right-click on A102

o Open Page Setup Manger

o Select *A101*

o Click [Set Current]

o Click [Close]

o Repeat this process for A401 and A601

(CO 3) Add/Edit/Draw a titleblock

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=84

« [STEP 1] Draw a titleblock

o Select [A101] sheet to open the sheet

o Confirm your current layer is [0]

o Draw a rectangle for a paper size box — Type [REC], press [Enter] key > Type [0,0], press [Enter] key > Type
[177,117]. Press [Enter] key

o Draw a titleblock outline using the paper size box — Type [O], press [Enter] key > Type [1/4”], press [Enter] key >
Click the inside of the sheet

o Draw lines for the titleblock. Please refer to the image below
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« [STEP 2] Add titleblock information

o Sheet number — A101

o Project name — Eames House, House

o Your name - First name and last name
> Course number

o Submission date

o Add text using [MT] for titleblock information. Verify the text size is 3/32”. You may rotate the text 90 degrees.
« [STEP 3] Add the titleblock to other sheets

o Click [Inset] from [Insert] tab, on [Block] panel
o Select [000_Titleblock_11x17]
o Type [0,0], press [Enter] key

o Select the titleblock and the information except for the Sheet number.
o Create a block for the selected elements — Name the block — [000_Titleblock_11x17]
o Insert the titleblock to A102, A401, and A601
o Switch the Titleblocks to [A-ANNO-TTLB]
o Copy and modify the sheet number to A102, A401, and A601
+ Now you are ready to add a titleblock on the paper space.
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(CO 4) Set views in Paper space — Defpoints, scaling

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=84

Now you are ready to set the views in the sheets

+ [STEP 1] Change a viewport size and the viewport layer

> Once you click, a viewport can be changed by stretching the corner of the viewport line.

[

[

s Jemes s, e Jror e o ssrnene

[>.| -Specify stretch point or [Base point Copy Undo eXit]: <Ortho off>

Model ) A101 | A102 | A401 )| AGOT R | G-\ - [ZE-EH XS

> Select the viewport > switch to [Defpoints] layer. The [Defpoints] layer is set up by default as a non-plot layer.

— —— . . Lig g gt g e e PSR
£ Defpoints i 1B = fo. wh... Il wh... Continu... Continu
— | rACC [ e M = B0 B OTION Caedieas Medio

« [STEP 2] Update the scale of the viewport

o After changing the viewport size > double-click the viewport > Zoom in and out > Pan the view to make the view
centered
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3/32" =1-07
178" = 10"
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o Click a scale on the application status bar, and select a desired scale for the floor plan

on]: *Cancel*

o If the dimensions have disappeared, click on the Show Annotation icon on the application status bar
« [STEP 3] If you want to add a new viewport, use the [MVIEW] command.

> Type [MV], and press [Enter] > Click the first point to draw a rectangle > Click a second point to finish the
rectangle. It will automatically show the drawings

> If you have a viewport to copy, you can copy the viewport and pan the view

> Sometimes a copied viewport will show in color. To change it to black and white, double-click the inside of the
viewport > type [RE] and press [ENTER] key > double-click the outside of the viewport
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[STEP 4] Update layer visibility for the viewports
> Open [LAYER PROPERTIES MANAGER]

> A101 is for dimensioned floor plans. Thus, it would help if you hid the [I-FURN], [[-CASE], and [P-FIXT] layers
o Double-click the viewport, and click [VP FREEZE] on the I-FURN], [I-CASE], and [P-FIXT] layers
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[STEP 5] Set a furniture plan sheet

o The scale of the furniture plan is 3/16"= 1.
o VP Freeze [A-ANNO)], [A-ANNO-DIMS], [S-GRID], and [S-LEVEL]
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[STEP 6] Set an RCP sheet
o The scale of the RCP is 3/16”"= 1

£
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X B B 316" =1-0"~ [ # Drafling & Amnotation~ + %0 [ B5] &)
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« [STEP 7] Set a section view and elevation sheet
o The scale of the section view is 3/16”= 1.
o The scale of the elevation is 3/8"=1.
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H e T
$ — H
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|| @~ Al 28 1ayers displayed of 28 total layers
Model | A101 | A102 | A1 | A601 [+

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 7. Symbols and prints

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit symbols in Paper spaces — drawing title, elevation symbol and section letters, north arrow
(CO 2) Printing

“® Session Highlights

At the end of the session, students can create the graphics below.
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@ Lecture Contents

(CO 1) Add/Edit symbols in Paper spaces- drawing title, elevation symbol and
section letters, north arrow

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=86

Open your AutoCAD file.

Add drawing title and scale for Floor plans, Furniture plans, RCPs, Section view, and elevation

+ [STEP 1]
+ [STEP 2]
+ [STEP 3]

Click [A101] sheet to open the view
Open [DESIGN CENTER]
Find [A-01.dwg] for a sample drawing title

o Click the [HOME] icon

> Open [Sheet Sets] > [Architectural] > [A-01.dwg]
> Open [Blocks]

> Double click [Drawing Title]

[

[STEP 5
- [STEP6

[STEP 7

[STEP 8

PROPERTIES

]
]
]
]

No selection B R

STEP 4] Add on the sheet

Double-click the inserted drawing title and edit the attribute. Adjust the title line length
Copy the edited drawing title for the 2nd-floor plan and double-click to edit the drawing title
Repeat [STEP 6] for other drawings

Update the drawing titles to the [A-ANNO] layer

==

® Bylayer
0

Bylayer
1.00000

ByLayer

ByLayer
o

——

ByLayer

bopro] b get]

Plotstyle
Plot style table

Plot table attached to 4101

1ST FLOOR PLAN
Scal A= T

- nand
Model 4 A101 | A102 4 A201 | A6 f+ PPR |, &~ % ,, = kﬁf)«‘ £+ Drafting & Annotation ~ + 20 3 ] = =

2ND FLOOR PLAN
(ZBEponaa |
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Add an elevation symbol from [TOOL PALETTES]

[STEP 1] Open [TOOL PALETTES] from [VIEW] tab, on [PALETTES]
[STEP 2] Click [Annotation] tab from [TOOL PALETTES]
[STEP 3] Select [CALLOUT BUBBLE - IMPERIAL]
+ [STEP 4] Add the symbol on the first floor
[STEP 5] Double-click to open the attribute editor, and update information
[STEP 6] Update scale to 0.75

[STEP 7] Update the symbols to the [A-ANNO] layer

| Block Reference -] &+ %
| General -] 5 | Imperial samples -
Color 8 Bylayer = %
2 = 3 i 58-7"
Layer i| — Tag- Imperial
8 ¥ 3, 3 3
Linetype ByLayes £ 7-3=" i T ya 7-3= i 7-3=" ya 7-3=" ya 7-2
Linetype scale 1.00000 | [T 4 k| 4 A 4 7 4 d 4 7
Plot style ByColor o = > Bubble - Im... = T— 1-25'
Lineweight Bylaye E £ ‘L Section = = T i -
Transparency ByLayer <> Callout - Im... |
Hyperlink H E Elevation - 3 ] @
| 3D Visualization BRE E > Imperial ] L g
. ey 402
Material ByLayer 5| Draving Tide A "VE b 302" 4
3 Z| e g = 5 £
| Geometry - Ea < - Imperial & M~
0 =)
Position X 821732 = CorfieTems LIVING RM =] ‘ ‘
Position ¥ 727/32" =‘ £| T - imperial = g1 — —. - |
Pgsition Q" L e e ] e KITC
((scalex 075000 — ig = 4 M
Sy TTSO00 5| el b 744l ol g
3 [ L by o
ScaleZ 0.75000 = 5 : H " ‘ ==
— > Imperial | _ | e
[ - M — e | T
— & T
Name Callout Bubble - Imperial [ H §3 IF‘W‘('”T'“ J ol A ‘ | _
Rotation 0 — xloess — I — o
Annotative Yes £ D‘ Detail Layout (s
Annotative scale 11 = 74 Grid - Imperial '
Match orientation t.. No B ctic samples = HALL
Block Unit Inches £
N qn =
Unit factor | [ | . i !
| Custom - g v E . -
Arrow Rotation 0 3 E % Callout &
Arrow Direction Right E \ i, > Bubble - Me.. E
[ Attributes -1 |8— 2 Section B
VIEWNUMBER A 3 = S Callout - Me... | @

Add section letters with [MTEXT]

STEP 1
STEP 2
STEP 3
STEP 4
STEP 5
STEP 6

Type [MT], press [ENTER] key

Draw a text box to add the section letter
Text size update to 1/8”

Add section letter

Repeat this process for other sections
Update section letter to [A-ANNO] layer

[t/ W o W s Y

[
[
[
[
[
[

Add north arrow with drawing tools [LINE], [CIRCLE], [MTEXT], & [HATCH]

+ [STEP 1] Draw a north arrow in the paper space and make a block
« [STEP 2] Rotate the north arrow to match the information from Eames House plan images
+ [STEP 3] Place the north arrow to Floor plans, Furniture plans, RCPs
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Draw ~ | | Annotation ~ Loyers + l Block + Properties ~ | Groups + | Utilities ~ | Cliphoard | Vie
PROPERTIES i u
| Block Reference - @+ 4 7,(777777‘7777777777777 %)
i
| General -] Imperial samples 5 f o
Color ® Eylayer % ‘ ‘ A =)
Layer 0 | = Teg- Imperel ! | O
Linetype Bylayer ' ‘
Unetpescae 100000 i oot DINING RM N O
Plot style ByColor & : > Bubble - Im... ‘N
Linewesight ByLayer é‘- Section ‘ ‘ O
Transparency ByLayer 30 . Callout - Im. . | — =
Hyperlink a| i Elevation - ‘ ‘ «©
| 3D Visualization -1 |2 = Imperial
3 |
Material Bylayer 2 E Drawing Title
| Geometry =1 | g % - Imperial
Position X 71732 = Graphic Scale ' |
Position ¥ 1-85/32" _ £ =3 - Imperial [ _ _ ,‘ ,,,,,, L Y
Position Z 0" # 5
=] =g North Arrow - i i
Scale X 1.00000 ~ 1(/ Imperial
Scale Y 1.00000 =
<1
ScaleZ 1.00000 | o Arows- ! !
—| % Imperial
[mic I R \ ‘
MName 000 NORTH E 2 §ZZ ‘F‘”WC_“‘M' z
(_osstion 280 2 et
‘Annotative No £ D Detail Layout
Block Unit Inches b= $4 Grid - Imperial
UnfsEz g| Metric samples
s
/] Tag - Metri
: —3 Tog - Metric E
- £ sy, CRlout =
2 ‘ ] > Bubble - Me.. |£ ‘ ‘
- Section = ! !
E ‘ i 55 Callout - Me... E ‘ ‘
g | Elevation - = ' A LUE
& £ 55 Metric £ + o
NS Drawing Title 8 [ <
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" 7'-1 3
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(CO 2) Printing

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=86

Update the print setup for each layout

« [STEP 1] Open [PAGE SETUP MANAGER] by mouse right-click on each layout.

+ [STEP 2] Click [Modify] to open [Page setup]

+ [STEP 3] Plot style table is already set to Monochrome.ctb. The Monochrome style turns all layer colors to black. Since
we don’t want our wall, floor, and ceiling thickness to be black, we need to customize the plot style.

« [STEP 4] Click the edit button next to the name
[STEP 5] Click [Color 9] from [PLOT STYLES] and change to [USE OBJECT COLOR]

+ [STEP 6] Click [SAVE & CLOSE]
[STEP 7] If the color is not changed automatically on your paper space, use the [REGEN] command for the views.
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ByLayer o
MAM—I_J._U_/J[: A Psgesetup - A101 X § M lot Style Table Editor - monochrome.cth X
A Page Setup Manager o Ll paeseue Plotstye teble (pen assgnments) e Form Vew
: 5 4 menochr =
b | Erezciins Printer jplotter o - -
T Comentpagesctus done> Name: |11 DWG To PDF.pe3 o | propertes | v — Ir
“A1* Set Current. || Potter: DG To PDF - PDF ePlot - by Autodesk Shadeplt  [Asdepayed JH Pen #
Az o - e —d] Virtualpen #:  [Aomatc 3]
w1 7 / . o e}
u “A01* Descripton: £ Sereening: [100 5]
1 A = o e«
r s
o [5] Pepersze Plot options —
= | Ans ful bleed 8 (17.00 x 11,00 Inches) v [ Plot object ineweights ¥ | et
Selected page setup detais e —— > neendste: |Use object endstyle v
| Deviee name: DWG To POF.pc3. Plot area Plot scale EPlotwith plot styles ST— Linejoin sy | Use object jon style v
Plotter: DWG To PDF What to plot: Fit to paper [ Plot paperspace last Filstyle: | ige object fllstyle. v
Plot size: 17.00 x 1100 inches (Landscape) el e [Hide paperspace objects
e | Ee Plot offset (origin set to printable area) - Drawing orientation
| | ‘ x inch Center the plt O portrait )
@tomtre
[ oipiay when creating 2 new layout 3 inch WA = Add Sle Delete S
Yes SavedCose | | Cancel | | Heb
oK Cancel Hep
s I I ‘ ‘ ‘ | TP=—5 1 i ) i ) | 1} I =
« [STEP 1] Click a layout that you want to print
+ [STEP 2] Press [CTRL+P] to open [PLOT]
« [STEP 3] Click [PREVIEW] from the [PLOT] window
D5 HE L § & - = | Duiting & Annotation___+]~] AD 2019 - STUDENT VERSION  C:\L OneDrive - lowa State University\..\Eames_House_Project Yongyeon_Cho 07.dwg [» [Tyoe a keyword or priase 168 2 signin S wd B -

f— 74F —f— 13— — 13—

( > 1ST FLOOR PLAN
Scalma = T

T

2ND FLOOR PLAN
Scale:a "= 1

« [STEP 4] Click [OK] > find a location to save > click [SAVE]

Print multiple sheets at once

« [STEP 1] Click [Home] button > Select [Publish] to open [PUBLISH] window
+ [STEP 2] Select the drawing model if it shows, and mouse right-click > click [Remove]
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@ Plot and Publish Job Complete

x]




[ No selection LR

| General -]
Color ® Bylayer
Layer 0
Linetype BylLayer
Linetype scale 1.00000
Lineweight ByLayer
Transparency ByLayer
Thickness. o

| 3D Visualization -]
Material ByLayer

[ Layout -
Layout name a0
Pagesetuprame  <None>
DP to raster 300

| Plot style -
Plot style ByColor
Plot style table monochrome.cth
Plot table attached to A101
Plot table type Color dependent

[ view -
CenterX
CenterY
CenterZ
Height
Width

Misc 5

Annotation scale 111
UCSican On Yes
Ucsiconatorigin ~ No
UCS pervienport  Yes
UCS Name
Visual Style 2D Wireframe

STEP 3] Click [PUBLISH]

STEP 7] Wait until the completion message comes

£ 587
' 2 2 a k] 7‘?3" . 7.73%.‘ “ 7‘,3%-‘
A Publish X | S
[
SheetList: T 2
El = Publish Options Infarmation i ]
None ~||%| B Locaton: c:yserstyongyeon pesctop) @ @ . .
Pubish to; File type: Mltishest fie P e —~ H
POF v Naming: Prompt for name T ‘ ‘ — J @
Layer information: Incude: :
PDFPreset; | AUtoCAD POF (eneral Documentation) 4 aTcHen I
L 1 Merge control: Lines overnrite ok B
[ Automatically load all open drawings: T ol ol S
= Pubiish Options. &g
(s =S ] , T ‘j g
DOWF  Pagesetn Status = T i H
Add Shests... 4 i
ropmet - ne> & Moermors 4 ] =3
mes_House_Project Yongyeon Cho_07-1  bead List.. ne>  Noermors r 70/ b
mes House.Project Yongyeon Cho 07-A4 _ Save List.. nes o Noerors J
mes_House_Project_Yongyeon_Cho_07- > 7 Noerrors
(—
Move Up
Move Down .
< Rename Sheet g
¢ Change Page Setup 3
Freierm Belmiemaans, | SR AESERED clude plot stamp & H
Drawing location  C:\Jsers\yongyeon\OneDrive - |+ Include Layouts When Adding Sheets 3
Levouronc RN i) ¥ Include Model When Adding Sheets ik baioon: 5 = &
Plot device: Override: DV/G To PDF g
= pen in viewer when done =
Plotsize 8.50 x 11.00 inches (Landscape) o ~ " ‘ e
Plot scale Scaled toFit i [ Y TN EN
Page setup detallOverride output device specified n .. Q T “" 8
3
A Hide Details Bublish Caneel | Help /H Al g
Eal ol 3
T | T T |\ i A M E e A | H
i i i S| emmm o e g
I . .. I T T T T g
— i i i i i Lad E%w“” & £ E
| | |- | =

[ ]
[STEP 4] Specify the file location to save > click [SELECT]
« [STEP 5] If you want to save the current list of sheets for later use, click [Yes]
[STEP 6] Click [close], once a processing background job window popup
[ ]

’fﬁ Plot and Publish Job Complete ||

Mo errors or warnings found

Click to view plot and publish details...

peR [ | & ~ %~ [Z0 - = B

[m)

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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PART TWO. REVIT

Chapter 8. Introduction to Revit

+ Purpose of using Revit — How &/ Why Interior Design uses Revit
« Install Revit

+ Understand Project Templates — Default and Own

+ Save Revit file — Set the project folder and backup file

« Open an existing project file

+ Keyboard shortcuts

+ Understand the User Interface — Toolbar, Properties, Drawing area, Option bar, and Project Browser

Chapter q. Create a Site

+ Understand the site plan and information

+ Set the project location and understand building base point

+ Find GIS information

» Add & Edit Site — Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees
+ Define true north and project north

Chapter 10. Set Grids, Levels, Dimensions, & Building columns

« Import CAD drawings— Floor plans, building elevations, and sections
+ Adjust and verify the scale

+ Create and modify grids and levels

« Create plan views— Floors and ceilings

+ Create columns with dimensions

Chapter 1. Add/Edit Beam, Walls, & Curtain Walls

+ Add/Edit Beam

+ Create walls

+ Edit walls wall properties — Wall thickness, Wall details, ¢ Finishes
+ Edit/add wall properties — Wall opening, wall sweep

« Add/Edit Curtainwalls, Mullions, & Panels
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Chapter 12. Understand Visibility settings, Add/Edit Floor & Ceiling

+ Understand View template, visibility graphics
+ Understand View range

« Add/Edit Floors & Floor Properties

+ Add/Edit Ceilings & Ceiling Properties

Chapter 13. Add/Edit Stairs, Rails, & Roof

+ Add/Edit Stair — three types of staircases
+ Add/Edit Railing
+ Add/Edit Roof

Chapter 14. Add/Edit Windows, Doors, Lighting Fixtures, Furniture, Tags, &
Sheets

» Understand the concept of family file
« Add/Edit Doors and Windows

« Add Tags

+ Add/Edit Lighting fixtures

- Add/Edit Titleblocks

+ Insert Plan views and symbols — North arrow and graphic scale

Chapter 15. Add/Edit Model-in-Place Components & Edit Family

+ Add/Edit Furniture families
+ Add/Edit Model-in-place components — Custom casework
+ Add/Edit a New Family - Furniture
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Chapter 16. Add/Edit Elevation, Section, Detail, Text, Annotation, & Rooms

+ Add/Edit Elevations & Sections — Adjust crop region
+ Add/Edit Detail views

+ Add Texts & Annotations

+ Add/Edit Rooms, Room tags, Room separators

+ Add/Edit a color fill scheme

Chapter 17. Add/Edit Views, Lighting, & Materials

+ Set perspective views

« Set Isometric views

« Edit Views - Graphic Display styles
+ Test Render

+ Setsun

« Edit Artificial lighting

+ Add/Edit materials

+ Render material managements

Chapter 18. Create Revit Rendering, Revit Clouding Rendering

+ Insert other types of files — Sketchup, AutoCAD
+ Advanced render settings

- Edit render qualities

+ Understand and make cloud renderings

+ Save Rendering outputs
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Chapter 8. Introduction to Revit

@‘ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Purpose of using Revit - How & Why Interior Design uses Revit
(CO 2) Install Revit

(CO 3) Understand Project Templates — Default and Own

(CO 4) Save Revit file — Set the project folder and backup file

(CO 5) Open an existing project file

(CO 6) Keyboard shortcuts

(CO 7) Understand the User Interface — Toolbar, Properties, Drawing area, Option bar, and Project Browser

“® Session Highlights

At the end of the session, students can create the graphics below.

REeHG - «-# -8 2-Y0A & ¢FE WG = Autodesk Revit 2021
Architecture  Insert  Annotate  Analyze  Massing &Site  Collaborate  View  Manage  Add-Ins  Modify &
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< @0 2 signin W ®- -2 X
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B e . 0
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Underiay A
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Depth Clipping No ciip
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View Name Level1
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Title on Sheet
Referencing Sheet
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Datum
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¥ Project Browser - Project? x
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@ Lecture Contents

(CO 1) Purpose of using Revit — How & Why Interior Design uses Revit

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=88

Introduction of Revit, a BIM (Building Information Model) software

+ Charles River Software originally developed the software in 1997, renamed Revit Technology Corporation in 2000,
and acquired by Autodesk in 2002.

+ Autodesk Revit is BIM software for Architects, Interior Designer, Landscape Architects, Structural Engineers, MEP
Engineers, Contractors, and more.

+ Revit can be used as a very powerful collaboration tool among different disciplines in the Architecture, Engineering,

and Construction (AEC) industry.
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image credit: https://commons.wikimedia.org/wiki/File:Revit.jpg

+ Revit has a huge library for modeling in the software itself and supports plug-ins, advanced data management systems,
and energy modeling analysis.

+ Revit modeling process is complicated and not easy for a first-time user.

+ Software required better hardware, 40% more expensive than Autodesk CAD but higher productivity.

+ For architects and interior designers, the software is being used to create construction documents.
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+ Most of the commerecial interior design/architectural design firms use Revit.
+ Not much of renderings features, but support Virtual Reality plugins.
+ Collaborate with CAD drawing users.

(CO 2) Install Revit

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88

Install Autodesk Revit

[STEP 1] Go to https://www.autodesk.com/education/free-software/revit on your window side in a web browser.

[STEP 2] Click [CREATE ACCOUNT] if you do not have one. If you have the account, please sign in.

[STEP 3] Click [Get product] under Revit.

+ [STEP 4] Select, windows, 2021, and English. Click [[INSTALL].

[ ]
[

STEP 5] Accept the license and services agreement.
STEP 6] You will get an email from Autodesk for the license information (Product key and Serial Number). It may
need the information for the activation process.
[STEP 7] Click Install.
[STEP 8] Click downloaded installation file to install.
+ [STEP 9] Setup Initialization will download actual software to install it will take time.
[STEP 10] While you are installing Select the “Architecture” discipline in the drop-down menu.
[STEP 11] After installation, the license information required to activate Revit.

(CO 3) Understand Project Templates — Default and Own

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=88

Open Revit by double-clicking the Revit Icon.

Once the application opens you can see the HOME page. From the home page, you can open recent project files and recent

family files. Also, you can create a new project file or a new family file.

Create a new project file with Architecture Template.

+ [STEP 1] Click [NEW] under Models on the left side of the Home page
+ [STEP 2] Click [Imperial-Construction Template] and select [Imperial-Architectural Template]
« [STEP 3] Click [OK] to create a new project file.
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@ Recent Files

MODELS
MODELS
& Open..
R Choose Template
[ O New.. ] ferviacie Lookin: | Englsh-Imperial 5
[Impena\wmtecmra\‘remuane v] Browse... - PN rame ~ Date Wi
FAMILIES = [ Commercial-Defautt.rte 1/17/2020 2:39 PM Autod:
Create new [ Construction-Default.te 1/17/2020 2:39 PM Autod:
= Open. @ Project (O Praject template el default.rte 1/17/2020 2:39 PM Auted:
= [ Electrical-Default.rte 1/17/2020 2:38 PM Autod:
™ New.. o = [z LT_USI_Commercial-Default.te 1/17/2020 2:41 PM Autod:
[LT_USI_ Default.rte 1/17/2020 2:41 PM Autod:
CII_SUIU LU IO LT I T RS I R U - I@ [ LT_USI_Residential-Default.rte 1/17/2020 241 PM Autod:
[ Mechanical-Defauit.rte 1/17/2020 2:38 PM Autod:
. [l Plumbing-Default.rte 1/17/2020 242 PM Autod:
FAMILIES l.g‘ [ Precast Detailing-Default.ite 1/23/2020 237 PM Autod:
E Recent Files . [ Residential-Default.rte 1/17/2020 2:39 PM Autod:
[ Structural Analysis-Default.rte 1/17/2020 242 PM Autod:
B BiM360 Elsystems-Default.rte 1/17/2020 2:39 PM Auted:

If you are working on a specific project like a residential building or a commercial project, there are more templates that
Autodesk supports. To open the template, you can click [BROWSE]. And see what template is appropriate for your project.

Additionally, you can also create a project template for your firm. Many firms already created/use their own template (called
a seed file) to save time and resources to develop their construction documents.

(CO 4) Save Revit file — Set the project folder and backup file

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88

Saving a file must be a friend of yours. Once you create a new file you must save the Revit file first and work on it later.

Save a file for the first time

« [STEP 1] Click [FILE] tab
o [STEP 2] Select [SAVE AS] from the file menu
« [STEP 3] Select [Project] under the menu
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g | ! Architecture  |nsert  Annotate  Analyze  Massing & Site Collaborate  View  Manage  Add-

Railing -
I@I@ Saves current project or family. Saves current " B Railing A H K

project as a template. Save any family, group or @ Ramp IL EI
view to your library.

D New v & Stair &~ [~

Circulation  Model Room & Are

Cloud Model
C}i Saves the current Revit model to the
cloud.

) o .
E Save Saves the current Revit project file,

D Family
g Save As 4 Saves the current family,

=

o

Template
m Saves the current Revit project file as a
Export K FTE
- template.
" ... Library

« [STEP 4] Find a folder location to save. If you do not have a folder, you can create a folder by pressing [ALT+5]. it is
recommended to have a project folder to save the project Revit file. You also save other family files (e.g. Furniture,
lighting family that you downloaded) and material images that you found under the project folder. You may draw and
drop the folder to the left side of the browser for future use.

R saveAs ? *
Sawve in: | 2020 ISU-mini-grant
Marrte - Date medified Type Size
0_Module 8/10/2020 1:28 PM File folder
m [0_Proposal 6/4/2020 2:30 PM File folder
U _AutoCAD 8/16/2020 5:33 PM File folder
8/19/2020 8:32 PM  File folder
003_Enscape 8/19/2020 8:33 PM File folder
100_Received 7/14/2020 10:03 AM  File folder
002 Revit
=g
My Computer
File name; | Eames_House_Project_Yongyeon_Cho_08 v|
Files of type: |Project Files {*.rvt) V| | Options. .. |
| Save | | Cancel |

Tip, I strongly recommend having an external hard drive to save files. If your laptop hard disk is full, your hardware

Revit Session 1 | 112



performance will be drastically reduced. To prevent this, your working file should be saved in an external hard disk. For
extra safety, it is recommended to use Cloud file storage to save files.

+ [STEP 5] Open a folder to save and make a unique name for the project.

+ [STEP 6] Before you click [SAVE], you may consider saving a backup file by clicking [OPTIONS]. Revit will
automatically make backup project files. It is safe to have the backup files, but it will take time for the automatic
backup file while you work on it. You may set the number of backup files (default is 20) by open [Option] in the save as
browser. 5 backup files might be enough.

R saveis ? =
Save in: | 08 _Revit_01 V| = E b 4 -_'_ Views w
i File Save Options W B Size
Screenshots folder
Maximum backups: @
Worksharing

Make this a Central Model after save

Compact File

Open workset default:

Thumbnail Preview

Source: |Acﬁ\re view fsheet V |

[JRregenerate if view sheet is not up-to-date.

C ox ) cacd |

File name: | Eam

v
Files of type: |Project Files (*.rvt) ¥ |
' Save ' Cancel

Save a file while working or end of the work

« [STEP 1] Click [FILE] tab
+ [STEP 2] Select [SAVE] or simply press [CTRL + S]

(CO 5) Open an existing project file

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=88

Revit has 2 ways to open your project file.

The first method is just double-clicking your Revit project file.
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The second method is opening a file in the application. I recommend this second option due to reducing errors that you
might have, especially, while you are sharing a file with your co-workers.

[STEP 1] Open the Revit software
[STEP 2] Click [File] on the tab
« [STEP 3] Click [Open] on the file tab
[STEP 4] Select the file that you want to open under the folder
[STEP 5] Click [Open] to open the file

(CO 6) Keyboard shortcuts

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=88

To increase productivity, I recommend you become familiar with the following keyboard shortcuts.

« MV  Move

« TL  Thin Line

. VV  Visibility

- ZE Zoom All to fit

« WT Tile Views

« TW  Tab Views

« DI Aligned Dimension
« DL  Detail Line

« CO Copy

« RO Rotate

+ MA  Match type properties
« AL  Align

« PT  Paint

For more information regarding shortcuts
https://www.autodesk.com/shortcuts/revit

(CO 7) Understand the User Interface — Toolbar, Properties, Drawing area,
Option bar, and Project Browser

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88
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Revit’s user interface is similar to AutoCAD’s one including an icon with text, and wording.

T e T HELP ANDFIND C-EISenn D @+ -8 X
[0 Architecture _Inset__Annotate _Analyze _Massing & Site__ Collaborate _View _Manage. =) TABS
o -
o Mg B K2 K S %7 et @E
B OO AL 1, X d pYEE & W o 3
Modify|  Wall Door Window Component  Column  Rocf Celing Floor Curtain Curtain Mullion  Railing Ramp Stair Model Model Model  Room Room  Tag _ Area Tag By Shaft Wall Vetical Dormer Gid  Set Show Ref Viewer
9 d < T System Grid G Tet L oup Separator Room” T Area Plane
select ~ Build Circulation WModel Room & frea ~. Opening Datum Work Plane
roperties X||3 Level 1 X Project Browser - Project2 E

E] Floor Plan

Floor Plan: Level 1

v Ediit Type.

raphics 2
View Scale

Scale Value e

Display Model Normal

Detail Level Coarse.

Parts Visibilty Show Originai
Visbility/Graphics ver.. Edit
Graphic Display Gptions Edit
Grientation Project North
Wall Join Display Ciean ail wal joins
Discipiine Architectural
Show Hiddien Lines By Discipiine
Color Scheme Location  Background

Color Scheme “nonex
Difault Analysis Display .. None

Sun P

Range: Base Level

~--PROPERTIES -

DRAWING AREA

Range: Top Level

Unbounded

Underiay Grientation ook down
fatents. 4
Crop View 0

Crop Region Visible 0

Annotation Crop 0

View Range Edit

Associated Level Level 1

Scope Box None

Bepth Clipping No ciip

dentity Data H
View Template <MNone>

View Name Level 1

Bependency independent

Title on Sheet

Referencing Sheet

Referencing Detail

hasing
Phase Filter Show Al

Phase New Construction
roperties help Apply

510, Views (all)

- Floor Plans
20 Level 1
Level 2

Site
- Ceiling Plans
Level 1
Level 2
- Elevations (Building Elevation)
East
North

Legends
3 Schedules/Quantities (all)
Sheets (all)
O Families
2] Groups
& RevitLinks

PROJECT
BROWSER

BECR

—
Vo =10 [ T09 % O 66

2,

Click to select, TAB for alterr

nates, CTRL adds, SHIFT unselects.

PR O P

You may change the location of Properties and Project Browser to expand more drawing area.

[T Achitecture st Annotate  Analyze  Massing &Site  Collsborate  View  Manage  Adddns  Modiy G-
£ S| ooo - — 9
b [ E D DEORESOCD & B 5 B oM
Modify  View _ Visibility/ Filters Show  Remove  Cut Render Render 30 Section Callout  Plan  Elevation Drafting Duplicate_ Legends Schedules Scope  Sheet
Templates” Graphics Lines | Hidden Lines Hidden Lines Prfile in Cloud Gallery  View T ews” " View  View ¥ 5 Box

Select ~ Graphics s Presentation Create

Properties X | [ Level 1

E Floor Plan -

Floor Plan: Level 1 | £B Edit Type @

Graphics A

View Scale Ve =10

Scale Vaiue T 5%

Dispiay Model Normal

Detail Level Coarse

Barts Visibility Show Original

Visibiliy/Graphics Gve.. Edit.

Graphic Display Options Edit

Grientation Project North

Wiail Join Dispiay Clean all walljoins

Discipiing

Show Hidden Lines By Discipline

Color Scheme Location Beckground

Color Scheme <none>

Default Analysis Dispia.. None

Sin Bath ~

Broperties help

Apply

Project Browser - Eames_House_Project Yongyeon_.. X

- Ceiling Plans.
Level 1
Level2

North
South
West

Legends

Sheets (all)
Families
Groups.
Revit Links

Click to select, TAB for altemates, CTRL adds, SHIFT unselects.

& Elevations (Building Elevation)
East

Schedules/Quantities (all)

F w6 B lE <

A £ Matchiine [ 0 0| =
o & =)
View Reference
s e el e
Windows Views Views Interface
e

Sheet Composition

b I T

115 | Revit Session 1




You also can change the Ribbon panel size by clicking the minimize panel button.
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If you accidentally close Properties or Project Browser, you can open with [User Interface]
Select [VIEW] tab > Click [USER INTERFACE] > Check the box to open.
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image credit: Screen captured and modified by the Author from the application

In the ribbon, you will find many tools for your work.
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For more information regarding the user interface, please read this page

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter g. Create a site

@’ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand the site plan and information

(CO 2) Set the project location and understand building base point

(CO 3) Import google maps and define true north & project north

(CO 4) Find GIS information

(CO 5) Add & Edit Site — Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees

£ & Session Highlights

At the end of the session, students can create the graphics below.

[ site 5 2 150-view-01 X

~ 3 :- ﬂ A
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E Lecture Contents

(CO 1) Understand the site plan and information

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=90

The site plan is an architectural plan of proposed improvements to a given lot. A site plan usually shows a building footprint,

travel ways, parking, and landscaping and garden elements (Department of Building and Development Land Development,
2009).

orees) Ll

OB Na: [Fe

DRALNG TITLE: 1 CHRLALNG Mo
rondad G o SR | or | e |SITE FLAN "LOCHABER CENTRE Al
5 ME.'..““ x;;; D::é 01 LOGHABER, NS

image credit: Archibald & Fraser Architects Ltd. - Wikimedia Commons - File: Lochaber Centre Site Plan.jpg

A site plan is a “set of construction drawings that a building or contractor uses to make improvements to the property.
Counties can use the site plan to verify that development codes are being met and as a historical resource. Site plans are often

prepared by a design consultant who must be either a licensed engineer, architect, landscape architect, or land surveyor”
(Chesterfield County, 2009).

Asite plan is a top view of a property that is drawn to scale. A site plan can show
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+ Property lines

+ Outline of existing and proposed building and structures
+ Parking lots, indicating parking spaces

« Driveways

+ Surrounding streets

+ Landscaping areas

+ Terrains

(CO 2) Set the project location and understand building base point

visualgraphiccomm/?p=90

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

Draw the building footprint for the site plan

Architecture  Inset  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-lns  Modify &

Modify| Door Window Component  Column  Roof Ceiing Floor Cuttain Curtain Mullion  Raiing Ramp Stair Model Model Model  Room Room  Tag _ Area Tag | By Shaft Wall Vertical Dormer
& < < T System Grid G Ted Line Group Separator Room™ T Area” Face
Select + Build Circulation Model Room & frea Opening
Properties X (dLevelt  Xid D)
E] Floor Plan -

Floor Plan: Level 1 ~| B8 eait rpe

Graphics 2

View Scale AR

Scale Value %

Display Model Normal

Detail Level Coarse

Parts Visibility Show Original oD

Visibity/Graphics Overr. Edit ke -
Graphic Display Options Edi

[(Crientation Project North

AT o Depley Tean o wall jomns } {
Discipiine Architectural g Lull
Show Hidden Lines By Discipiine

Color Scheme Location  Background

Color Scheme <none>

Default Analysis Display .. None

Underizy a =

Range: Base Level None Bl

Range: Top Level Unbounded b

Underlay Orientation | Look down

Bitents A

Crop View O

Crop Region Visible 0

Annotation Crop il T
ot — 3 )
Associated Level Level 1 =

ScopeBox None

Depth Clipping No clip

identiy Data A

View Template <Mone>

View Name Level 1

Dependency independent

Title on Sheet

Referencing Sheet

Referencing Detail

Phasing A

Phase Filter Show All

Phase New Construction

PBroperties help Apply Yo' =10 Ok GRE D o (318 <
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. & 0 l3in Model

+ [STEP 1] Acknowledge the overall size of the building.

o The size of the house part of the Eames House project is 58’-7” x 20’-4.”
« [STEP 2] Select [WALL] from [ARCHITECTURE] tab, under [Build] panel
Or, Type [WA] on your keyboard

o Draw only overall exterior walls on level 1
o Make sure your walls are [Project North] on the [Properties] palette.
o Confirm the wall is — Basic Wall/Generic-8”, Unconnected Height 20’ 0.”
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+ [STEP 3] Draw the building footprint

o Click a drawing area

o Move the mouse to the right-side

o Enter 58'7” on your keyboard > press [ENTER] key

o Move your mouse to the down-side

> Enter 20'4” on your keyboard > press [ENTER] key

o Move your mouse to the left-side

o Click the third point and forth to create the building

+ [STEP 4] Move the elevation symbols closer to the close the building

o Select one elevation symbol
> Type [MV]

o And click one point and move the mouse and click the target point to complete the command.

o Repeat this process to other elevation symbols

Set the project location

This setting is for sun orientation and weather information

ZIEN  Architecture  Insert  Annotate  Analyze  Massing & Site Collaborate  View Add-Ins  Modify =~

Project Location

Main Model

Design Options

Generative Design Ma

Location Weather and Site

Location  Site

Define Location by:

Internet Mapping Service ~
Praject Address:
U2 Chautaugua Blvd, Los Angeles CA D00

——— = an VICENTE
Mountain

Topanga

Lookput

-~

Santa Monica Bay

Santa’-l\ﬁ)nica

Shores Spa.
b ging & 2020 TomTom © 2020 HERE. & 20
[[] Use Daylight Savings time
o< J

0km
~—haEwean T o=sth @
2 fporation Terme
Cancel Help

STEP 2] Enter the project address (Eames House address is 203 N. Chautauqua Blvd. Pacific Palisades, CA) and Select

Select + Settings
Properties [ X i
Floor Plan -
Floor Plan: Level 1 ~ Eﬁ Edit Type
Graphics S
View Scale 1/8"=1-0"
Scale Value 1: 96
Display Model Mormal
Detail Level Coarse
Parts Visibility Show Original
Visibility/Graphics Overr... Edit...
Graphic Display Options Edit...
Orientation Project North
Wall Join Display Clean all wall joins
Discipline Architectural
Show Hidden Lines By Discipline
Color Scheme Location  :Background g
Color Scheme <none> =
Default Analysis Display ...: Mone
Sun Path [
Underlay S I:D H
Range: Base Level Mone
Range: Top Level Unbounded
Underlay Orientation Look down
Extents E]
Crop View [l @
Crop Region Visible 0
Annotation Crop 0
View Range Edit...
Associated Level Level 1
Srane Rov Mene
« [STEP 1] Select [LOCATION] from [MANAGE] tab, under [PROJECT LOCATION]
<
[SEARCH]
+ [STEP 3] Select a Weather Station near the project location
+ [STEP 4] Click [OK][ to complete the command
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(CO 3) Import google maps and define true north & project north

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=90

Sawve site information from Google Map

« [STEP 1] Open your web browser and go to [GOOGLE MAP] - https://www.google.com/maps

+ [STEP 2] Search the address [for Eames House project, 203 N. Chautauqua Blvd. Pacific Palisades, California]

« [STEP 3] Use [Snipping tool] (search Snipping tool from your program list) — Screenshot — must include the building,
and the property line, and the scale on the bottom left corner. For your drawing accuracy, I recommend saving both

the map image and the satellite map image.

oS
. . . "

image credit: search result from Google map

+ [STEP 4] Save the snipped image file in JPG file format in your project folder

Insert site information from google map

+ [STEP 1] Open [SITE] plan by double-clicking from the [PROJECT BROWSER]
+ [STEP 2] Move the project origin to the building bottom left corner
+ [STEP 3] Change the orientation to [TRUE NORTH]
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Properties X [ Levell = Project Browser - Eames House Project... X

A 0, Views (all)
@ & Floor Plans
D Floor Plan - Qﬂ’ i
Graphics 2 - & Calmg Plans
View Scale =20 = Level 1
Scale Value T 55 Level 2
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Detail Level Coarse 5~ Elevations (Building Elevation)
Parts Visibilty Show Original - Eost
Visibilty/Graphics Overr, Edit.. North
Graphic Disploy Options St South
(Grientstion [True North West
AT TR LR Legends
Discipiine Architectural P Schedules/Quantities (2!l
Show Hidden Lines By Discipline Sheets (al)
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View Range Edit..
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View Template <None>
View Name Site -
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Title on Sheet
Referencing Shect
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ing
Phase Filter Show All
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Properties help Apply r=100 D% G&HEHS § @mIE >

Click to select, TAB for alterates, CTRL adds, SHIFT unselects. & ) BN Main Model e R N N )

[STEP 4] Select [[IMPORT IMAGE], from [INSERT] tab

+ [STEP 5] Open the project folder and select the google map and click [OPEN]
[STEP 6] Click on the center of the drawing area

[STEP 7] Repeat this process for the satellite map

Avchtecture | Insert | Annate  Amabae  Masing&Ste  Colaborate View Mamge  AdcHns  Modly -

E%@@ O9e @ @GeklEdAM L @0

Link Lnk Link  Link DWF  Decal Point Coordination Link Link Manage Import Import Import Load Get Autodesk Loadas Insert _
Revit IFC CAD Topography Markup ~  Cloud Model  PDF Image Links CAD PDF Image Famiy Content Group from File
Select + Link Import N Load from Library

Popeies X [ Level 1 @ site x B o Browse - Eames Fcvise Propcte X
A B0, Views (o)
- Floor lans
D Floor Plan - @ gLt
—= Level 2
| Floor Plan: Site | 5 Edit Type Ll Site
Graphics 3 & Celling Plans.
View Scale T2 Level 1
SceVaiue 2] Level2
Display Model Normal 3D Views
DetailLevel Coarse 5 Blevations (Building Elevation)
Parts Visibility Show Original East
Visibilty/Graphics Overr... | Edit. North
Graphic Display Options Edit. South
Orientation True North Wt
WallJoin Display Clean all walljoins Legends
Discipiine Architectural (5 Schedules/Quanities (al)
Show Hidden Lines By Discipline Sheets (all)
Color Scheme Location _ Background O Families
Color Scheme <none> [ Groups
Default Analysi Dispiay .. None @0 Revit Links
Sun Path o
Underiay
Range: Base Level None
Range: Top Level Unbourded
Underiay Orieniation Lok down
Bxtents
Crop View
Crop Region Visible
Annotation Crop
View Range Edt..
Associated Level [evel 1
Scope Box None
Depth Ciipping No diip
Identity Data
View Template | <None>
ViewName Site
Dependency Independent
Title on Sheet
Referencing Sheet
Referencing Detail

Phasing
Phase Filter Show All

Phase New Construction

Propertes help B | -av0r OGO GmEID 0 I < >

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. & v 0 B Main Model . 0 =N o S NN

Adjust the scale of the imported google map

+ [STEP 1] Select the two imported maps by crossing selection

« [STEP 2] Click [SCALE] from [MODIFY/RASTER IMAGE] tab, under [MODIFY] panel
or, Type [RE] for adjusting the scale

+ [STEP 3] Zoom-in to find the graphic scale on the bottom right side of the map
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+ [STEP 4] Click Oft - click 50 ft - type 50" - Enter
« [STEP 5] Move the imported raster maps to be centered

Insert  Annotate  Analyze Massing &St Collaborate  View Manage  Adc-lns  Modify | Raster Images
= oI | v Qe i

B Xkee-bb B A b =-

ol e et el

g am-za 290

hitecture.

es  Clipboard Geometry Medify
Modify| Raster lmages |

Measure Create Image Arrange Selection

Properties X [ Level [ site x = Project B
~ 0, Vi
R - @
|Rasterimages @) ] B e <ot : 9, L
Dimensic 2
T 015
699039125 3D Views
699.029126 =) Elevations (Building Elevation)
East
North
Background
es/Quantites (al)
e Apply r-200 D@ GmREHY 0 tald < >
image: 09,02 03 ¢ mapjpg & By B[ Viin Model > PR O8N O T2

Adjust the orientation of the imported google maps according to the building footprint

« [STEP 1] Select the imported google maps

+ [STEP 2] Select [ROTATE] from [MODIFY] tab, under [MODIFY] panel
Or, Type [RO] on your keyboard

+ [STEP 3] Select [PLACE]

+ [STEP 4] Click the base point to rotate, click an appropriate point to rotate.
Remember how many degrees you rotated (for Eames House, 75.56 clockwise)
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G Awchitecture  Insert  Annotate  Analyze  Massing &5ite  Collaborate  View  Manage  Add-lns  Modify |RasterImages 33+
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" D Slow- =g L emn so= b o
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View Range Edit.
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+ [STEP 5] Relocate the imported google maps, if needed

« [STEP 6] Select only the satellite map > click [SEND TO BACK] from [MODIFY/RASTER IMAGE] under [ARRANGE]
panel

+ [STEP 7] Select the project base origin

« [STEP 8] Click [ANGLE TO TRUE NORTH]

+ [STEP 9] Type [-75.56], and press [ENTER] key (for Eames House, we rotated the google images to 75.56 clockwise, so

you need to re-rotate the origin to 75.56 counter-clock-wise)

Project Base Pont
i X Shared Stz ] X
ws 0o
EN 0 0 Project Base Font
Eev 00" Shared Sie:
175.56 Angle to True North 0.00° NS 00"
| Ew 00"
Eev 00"

u Angle to True North 284 44°

+ [STEP 10] Change the view to [PROJECT NORTH] from the [PROPORTIES] to check the plan rotated the right-way.
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« [STEP 11] Change the view to [TRUE NORTH] from the [PROPORTIES] for the site plan
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Crop the view to only the site plan area

+ [STEP 1] Select [CROP VIEW] and [CROP REGION VISIBLE] from the [PROPERTIES] panel
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+ [STEP 2] Adjust the region for the view
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(CO 4) Find GIS information

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=90

In this tutorial, we will find GIS information from CADMAPPER

[ ]
[ ]
[STEP 3]
[ ]
[ ]

STEP 1] Open your web browser, go to https://cadmapper.com/

STEP 2] Sign up for free if you don’t have an account. Sign on the website.

Enter the project address [203 N. Chautauqua Blvd. Pacific Palisades, CA] and search

STEP 4] Adjust the area for your project by zooming in and changing the selected area. It is free up to 1 km?2
STEP 5] Click [CREATE FILE] to generate the 3D model
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image credit: Screen captured from www.cadmapper.com

« [STEP 6] You can see the preview for your confirmation. Click[DOWNLOAD)]

©ADMAPPER Free City Files Help Account My Downloads ~New Map
< EDIT MAP PREVIEW: 3DAxonometrieView 2D View  Topography

Map near Santa Monica, California, US

File Type: AutoCAD DXF
Area 0.119 km?
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Spatial Reference System: Meters; UTM zone: 11, easting: 359538.33, northing: 3765363 63
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@
&
o
&
<

&

C0r0n3 e 157

Leafiet| © OpenStreethap

image credit: Screen captured from www.cadmapper.com

+ [STEP 7] Once the download is done, open the folder to extract the zip file

129 | Revit Session 2


http://www.cadmapper.com/
http://www.cadmapper.com/

GADMAPPER Free City Files Help Account My Downloads ~New Map
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Topography: Included, 3.74 m above sea level

Setings: Road centeriines, 3D buildings, 5 m contours
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image credit: Screen captured from www.cadmapper.com

+ [STEP 8] Extract the zip file
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+ [STEP 9] Copy the files to your project folder and read the License.txt file before you use the file
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") LICENSE.tt - Notepad - O x®
File Edit Format View Help
The downloaded file must be distributed with this accompanying license text.Map data (c) OpenStreetMap contributors.license details

available at http://www.openstreetmap.org/copyright---Data via USGS Mational Elevation Dataset (NED). All MED data are in the public
domain. ---Data via NASA Shuttle Radar Topography Mission (SRTM). All SRTM data are in the public domain.

[STEP 10] Open the LEVEL 1 view

[STEP 11] Click [IMPORT CAD], from [INSERT] tab, under [IMPORT] panel

[STEP 12] Open the project folder, change the file type to [DXF files], change colors to [Black and White], change
Import units to [meter], Click [OPEN]
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Default Anlysi Dispizy . Nome € @ RevitLinks
Sun Path =] =
Underlay A
Range: Base Level None
Range: Top Level Unbounded
Underiay Orentation Lok down
e = A < N
rop View
Crop Region Visible 0 File name: | cadmapper-santa-monica-caifornia-us.dxf v
Annotation Crop v | Fies of type: DX Fies (=) v
View Range Edit
Associated Level Level 1
iy re Clcurrent view orly coord Gladeadiie ) Postionng: [Auto -Orign winteralorgn  ~
Depth Ciipping No ciip Layersfevess: [al v [T T —
Identity Data A
V‘aﬁempm i Import units: 1,000000 Porient to view
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Dependency independent
Title on Sheet
Referencing Sheet
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Phase Filter Show All
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v
Broperties help Apply ye-ror Ol KR ED 0 Fald < >
Ready 0 3 o

[STEP 13] Move the imported CAD site information to the site. To move the map, you have to unpin before you move
the site.

[STEP 14] Switch the view to [SITE] view, Uncheck [CROP VIEW] from [PROPERTIES]

[STEP 15] Rotate the imported CAD site map to match the imported GOOGLE MAP (75.56 degrees clockwise)
[STEP 16] Move the imported CAD site map to match the imported GOOGLE MAP.

> To move correctly, you can switch the graphic display option to [WIREFRAME]
o Refer to other building locations and road locations to get the right location aligned
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[ Levelt @ site x | Project Browser - Eames House Project... X

0] Views (all)
Q| fme
SN 1 VB NN | 4 o L=
EST ] I EnE N B L e
— - Ceiling Plans
L i e Level1
C L Lewel2
- 3D Views
L)
/ {3 ) Elevations (Building Elevation)
— S 7] 5 o
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| "\‘ FL 0 ... South
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— [ Legends
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\ S - = e
2 Graphic Display Options...
(7 Hidden L:
£ Shaded
(7 Consistent Colors
-
& M 7 || Main Model ~ A IF M O o
+ [STEP 17] Open [WEST] view
+ [STEP 18] Move the imported CAD site map to match the building level 1
> You can type the Base Offset or manually move to match
Import Symbol = O v
S ol < q P
= Level2
Constaints 5 - & Cefling Plans
Base Level | — Level 1
Base Offset -134' 6" i
Dimensions ] 83D Views
A ] : - Eevatons (Buiding Elevaton)
Name cadmapper-santa-monic. s:m
South
West
Legends
3 Schedules/Quantities (all)
Sheets (all)
9] Families
el Groups
0 RevitLinks
i Ao | r-ror OG5 SR 0 tald < >
Click to select, TAB for alterates, CTRL adds, SHIFT unselects. & g 7 B[ Main Model v Lol =N I V)

(CO5) Add & Edit Site — Topo surface, roads, side works, property line, building
pod, surrounding buildings, and trees

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=90
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Create a TOPO SURFACE

Note, Building sight might be completely flat or with little level change. Please try the TOPO SURFACE tool to make the
site model.

[STEP 1] Select [TOPOSURFACE], from [MASSING & SITE] under [MODEL SITE]
[STEP 2] Select [CREATE FROM IMPORT], from [MODIFY/EDIT SURFACE] under [TOOLS]
« [STEP 3] Select [SELECT IMPORT INSTANCE]
[STEP 4] Select the imported CAD site map
[STEP 5] Only check [COUNTOURS] from the ADD POINTS FROM SELECTED LAYERS] window
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. N4 o
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s i [Cpaths
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TS S \ % % [Jview Port
] %% 5 \ i i 5 [Jwater
— ‘\1 \ & L |
— T i
\\\ \\\\\ - o
B N N \
3 SR
) i
\\\ N \\\\
SO R \:*
JRR [ oK | canel | Apply Help
. - T 8
\\’\ \\5 S o // | S
S is LN s
— i B ~ = B LY
\ S ST S, T / / 2w
0 / 3 s S el
= \ ;\\\\x L =y % /////(g
= > 7
e — o e
s R 2 - ,%// i & o e
\\ % I%‘TQ” Y f’( m ):r o

+ [STEP 6] Adjust point locations if needed
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Elevation: [ 0' 10105/256" |

Interior Point (1) <

Elevation | A2 —

Y/ // Case Study Vfou.;s.ﬂ:
ames Foundation ; e

« [STEP 7] Click the green check to complete the topo surface tool

Edit TOPO SURFACE

« [STEP 1] If you want to edit the topo surface, select the topography and select [EDIT SURFACE]
+ [STEP 2] If you want to add the point, use [PLACE POINT]
+ [STEP 3] If you want to remove the point, select the point and press the [DELETE] key

Topography line setting

+ [STEP 1] Select [SITE SETTING] from [MASSING & SITE] tab, under [MODEL SITE].

o Itis a small arrow on the panel

Architecture  Insert  Annotate  Analyze  Massing & Site Collaborate  View  Manage  Add-Ins  Modify

| U W@@@@IQE@I? m o s

Maodify| Show Mass In-Place Place Curtain | Roof | Wall Floor Toposurface Site Parking  Building  Split Subregion Property Graded Label
by View Set‘tmgs Mass Mass  System

Select Conceptual Mass Maodel by Face Maodel Site 0 Madify Site

Compenent Component  Pad Surface Line Region Contours

« [STEP 2] Set your topo lines
The increment number depends on your site map scale and how much detail you want to express
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Site Settings

Contour Line Display

At Intervals of;
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Passing Through Elevation:
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Insert Delete
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Properties

Floor Plan

Floor Plan: Site

- Edit Type

[ Level 1 [ ]

oA West

Visibility/Graphic Overrides for Floor Plan: Site

Model Categories  Annotation Categories  Analytical Model Categories  Imported Categories  Filters

Graphics ] Show model categories in this view If & category is unchecked, it will not be visible,
Scale Vaiue T: 345 Herist Sl
Display Model Normal Projection/Surface Cut Detail | A
Detail Level Coarse Wisibility - - Halftone Level
B s Lines Patterns Transparency Lines | Patterns
i Structural Framing O
isibility/Graphics Overr, Edit... ] Structural Path Reinf O
o . i ] ey ;’m Structural Rebar O
et han et - Structural Rebar Co... O
‘Wall Join Display Clean all wall joins Structural Stiffencrs O
Discipline Architectural P O
Show Hidden Lines By Discipline Telephone Deviees O
Color Scheme Location  :Background B O
Color Scheme <nones <Hidden Lines>
Default Analysis Display ... None Boundary Point
Underloy = Interior Point
Range: Base Level None I Trrr ey
Range: Top Level Unbounded Seconr:a Cont.
Underlay Orientation Look down =] Tr\aﬂgu_lar;on Edm
3
Extents -l Walls By View
Crop View O = t T T — = 1V
Crop Region Visible Al None et Expand Al Dverr\de.Host Layers
Annotation Crop ] []CutLine Styles Edit...
‘u."lew Range il Categories that are nat overridden are drawn -
Associated Level Level 1 according to Object Style settings. Object Styles...
Scope Box None
Depth Clipping Ne clip
Identity Data A
View Template <None>
View Mame Site | S Apply i .
Renandano indenandant TR W % T R v = AT

Clean up the imported CAD map

+ [STEP 1] Select the imported CAD map
[STEP 2] Click [DELETE LAYERS] from [MODIFY], under [[MPORT INSTANCE]
+ [STEP 3] Check all except [BUILDING]
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Select Layers/Levels to Delete

[ contours

efpoints
[Amajor_roads
inor_roads
[Apaths

topography
[ view Port

[water

S /i —

Cancel

Check Al

Check None

Invert

)

« [STEP 4] Click [OK] to finish the command
+ [STEP 5] Check [CROP VIEW] to see only the region inside
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Crop View
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Annotation Crop O

View Range Edit,

Associated Level Level 1

Scope Box None
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Identity Data

View Template <None>

View Name Site

Dependency independent

Title on Sheet

Referencing Shect

Referencing Detail

Phasing

Phase Filter Show All

Phase New Construction
PBroperties help Apply r-20 O& B 0 Rl <

Raster Images : Raster image : 09_02_03_Eames House-google map,jpg

i

= Project Browser - Eames House Project.. X
~ | @-10] Views (all)
- Floor Plans
Level 1
Level2
Site
Celling Plans
Level 1
Lewel2
3D Views
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Elevations (Building Elevation)
East
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Sheets (al)
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= Revit Links
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Raster Images : Raster image 0
google mapjpg

>

e R A )

Confirm your topo in 3D

Revit is BIM software. Your 2D drawings can show in 3D. It is wise to double-check in 3D view while you build your model

« [STEP 1] To create a 3D view, click the 3D view on the top of the program
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« [STEP 2] Once you click the 3D view, the 3D view will automatically open. To refer back to this view, you can open the

3D view on Project Browser by double-clicking. If you want to keep the view, you must rename the 3D view. For

example, ISO-view-01
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+ [STEP 4] Check [Section box] on the Properties and adjust the Section box by adjusting the blue arrow
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[STEP 5] Click [Sun path On]
[STEP 6] Click Shadow
[STEP 7] Now you can simulate the sun path by drag and dropping the sun
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Create Building Pod & Property line

For the building pod and property line, you should hide the Topo image by clicking the image, and mouse right-click and
select [Hide in view] > [Elements)

STEP 01] Go to Site & massing tab — Click [Building Pad]

STEP 02] Make sure your building pod is on level 1

STEP 03] Draw a closed line

STEP 04] Go to Site & massing tab — Click [Property Line] - Create by sketching

—_— — — —
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+ [STEP 05] Use Google Map to draw the property line. Draw a closed line
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+ Go to Site & massing tab — Click Subregion

o Draw a closed line
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+ Go to Site & massing tab — Click Site component
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Once you finished your site plan, you should hide the Google image.

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 10. Set grids, levels, dimensions, &
building columns

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Import CAD drawings- Floor plans, building elevations, and sections
(CO 2) Adjust and verify the scale

(CO 3) Create and modify grids and levels

(CO 4) Create plan views- Floors and ceilings

(CO 5) Create columns

£ & Session Highlights

At the end of the session, students can create the graphics below.
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E Lecture Contents

(CO 1) Import Drawings- Floor plans, building elevations, and sections

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=92

Prepare Drawings before import CAD drawings

+ [STEP 1] Open Revit application > Open your project > Double-click [LEVEL 1] from [PROECT BROWSER] > Close
all other views except [LEVEL 1]

+ [STEP 2] Select [SITE] information including the property line, trees, and neighborhood buildings > Mouse right-click
on one of the selected elements > select [HIDE IN VIEW] > Select [ELEMENTS] or [CATEGORY]

“site
150-view-01

X| [3 Level 1 X ¥ Project Browser - Eames_House_Project... X
1 ‘ =
- Ceiling Plans
fooLevel1
[ Elevatiens (Building Elevation)
East

= - FlogrBlan
= !
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Hide in View >

i South

Creste Similar o West

Edit Family Legends

[ schedules/Quantities (all)
Sheets (all)

Select All Instances > o) Families

@] Groups

5 Revit Links

Select Previous

Repeat this process for FLOOR PLAN - LEVEL 2, ELEVATION - EAST, WEST, NORTH, SOUTH, CEILING PLAN -
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Insert drawings

In this tutorial, we will practice how to add an image (drawing) to the view. You can insert CAD files and PDF files

« [STEP 1] Select IMPORT IMAGE] from [INSERT] tab, under [[MPORT] panel
Note. Revit can import various file types — dwg, dxf, pdf, jpg, tif, rvt, and more
Note. For this project, [ will use [tif] files
Architecture Annctate  Analyze Massing &Site  Collaborate  View  Manage  Add-lns  Modify -

b IREC RN OYe @ Ll i 2 @ 3

Meodify| Link Link Link Link DWF Decal Point Coordination Link  Link Manage |lmport| Import Load Get Autodesk Load as Insert
Revit IFC  CAD Topography Markup i Cloud Model PDF Image Links CAD | PDF Family  Content Group  from File
Select = | e T r'nport 3 Load from Library

+ [STEP 2] Find the folder where the drawings are saved > select the floor plan > click [OPEN] > place the imported
image on the view [LEVEL 1]

Repeat this process for FLOOR PLAN - LEVEL 2, ELEVATION - EAST, WEST, NORTH, SOUTHNote. The imported
image will only show on the view where you placed.
Note. To use the image file that you imported for your other level like [LEVEL 2]. Click [MANAGE LINKS] > Click

143 | Revit Session 3



[IMAGES] tab > Click the image that you loaded in the model > Click [PLACE INSTANCE]
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(CO 2) Adjust and verify the scale

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=92

Confirm the scale and position of the imported drawings

If the imported image/CAD file/PDF is in the right scale and position, skip this one, but double-check for your accuracy

« [STEP 1] Select imported image > click [SCALE] from [MODIFY] tab, under [MODIFY] panel
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+ [STEP 2] Click the first point that you know the dimension. I will use the overall building dimension (58’-7”). You may
also use a graphic scale if you have one
You need to zoom in to select the first point in the middle of the dimension line.

Floor Plan Level 1 e
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« [STEP 3] Click the second point
« [STEP 4] Type the dimension [58’7”] and press [Enter] key
+ [STEP 5] Zoom out to see the position
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+ [STEP 6] Move the drawing to match the base drawing. You can use a specific point to match the drawing to the base
Revit model that you created
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You may need to change the graphic display to [WIREFRAME] to see the image behind the model
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Repeat this process for FLOOR PLAN - LEVEL 2, ELEVATION -

EAST, WEST, NORTH, SOUTH
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(CO 3) Create and modify grids and levels

visualgraphiccomm/?p=92

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

Create grids

+ [STEP 1] Open [LEVEL 1] view

+ [STEP 2] Select [GRID] from [ARCHITECTURE] tab, under [DATUM] panel
« [STEP 3] Using the straight-line selection, hover over the view near the west wall until it becomes highlighted in the

center of the wall and an “X” appears
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7 i 7 A A 30, Views (al)
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5 3DViews
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tions (Building Elevation)

New Grids. | E3 EditType

Scope Box [None ]
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, FIRST FLOOR PLAN
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]

[STEP 4] Click the first point and click the second point to complete the gridline 1

[STEP 5] To complete the remaining gridlines, you can copy or continue drawing gridlines based on the imported
image

[STEP 6] To copy, select the Revit gridline 1 that you just made. Select the Copy tool and click a point and specify the
second point to the next grid line

[STEP 7] Also you should use dimension [DI] to specify the distance between gridlines

/4" Bubble Level1

Grids (1) ~ | {3 EditType Site.
Extents ) & Ceiling Plans
Scope Box None Level1
Identity Data # Level 2
Neme 2 - 3DViews

01
ilding Elevation)

/ \ / o
[l N [c ot
7-a3 ] 732" N 7-33
il

[STEP 8] Continue to copy all North/South gridlines
[STEP 9] If the grid bubble and numbers are too big, you can update the view scale by clicking scale. For the Eames
House project, use 3/8” = 1’-0”
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[STEP 10] Create a Horizontal new grid for East/West. And Update the Grid name to [A] and complete East/West grids
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« [STEP 12] Open [NORTH] view and adjust the grid line heights by dragging and drop the edge of the grid line. And
repeat this for [WEST] view
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Create and Modify levels

+ [STEP 1] We will now make Levels. Begin by navigating to the [SOUTH] elevation in the Project Browser.

o Adjust the length of the level by dragging and drop the edge of the level line
> Repeat this for [EAST] elevation view

+ [STEP 2] After you have confirmed that Levels 1 & 2 are set to the correct elevation, you can add additional levels. To
adjust the elevation number, click on the number and type in the correct elevation.

NGERE et

Show Original ‘ ‘ - Elevations (Building Elevation)
Edit. East

North
South
West

dules/Quantities (al)

« [STEP 3] Add a roof level.

o Select [LEVEL] from [ARCHITECTURE] tab, under [DATUM] panel
Or, type [LL]
o Click the left corner of the level and click the second point to finish the command
> Rename [Roof] > Click OK in the window pop-up and change the view name accordingly
o Adjust the height to [18' 5 1/2"]
+ [STEP 4] If you copy (CO)the level from the existing level, the view will not be created. Create Ground and Level 1 top
(Black symbol)

Revit Session 3 | 150



Elevation: South | g kit type
Graphics

View Scale TE =TT
Scaic Vaiue %

Display Model Normal

Detail Level Coarse

Parts Visibilty Show Original
Visibilty/Graphics Overr. Edit
Graphic Display Options Edit,
Hide at scales coarser th.. 1" = 400°-0"
Discipiine Architectural
Show Hidden Lines By Discipline

Color Scheme Location  Background

Color Scheme

Defauit Analysis Display .. None

Reference Label

Edents
Crop View

Crop Region Visible

aooo

Annotation Crop

Far Clipping

No clip

Far Ciip Offset 100"

Scope Box None

Associated Datum None

Identity Data

View Template <None>

View Name South

Dependency independent

Tite on Sheet

Referencing Sheet

Referencing Detail

Phasing
Phase Filter Show All

Phase New Construction

« [STEP 5] Update the view scales

° 3/16” = 1’-0” for all elevations
o 3/8” = 1-0" for floor plans and ceiling plans
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(CO 4) Create plan views- Floors and ceilings

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=92

Currently, you have what you need. When you add a new level [LL], the views automatically created. If you made the view

by coping existing levels [CO], you have to create new views for the level

« [STEP 1] Select [PLAN VIEWS]
« [STEP 2] Select [FLOOR PLANT] if you need a floor plan
+ [STEP 3] Select NAME OF THE LEVEL] and click [OK], then you can find the view from [PROJECT BROWSER]
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If you need additional plans for furniture plans, power, and data plans, and finish plans, you need to duplicate the view by

mouse-right clicking and select duplicate view > duplicate

Note, there are three options for duplicating views. Please refer to this link for further explanation

(CO 5) Create columns

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=92

We will now add columns beginning on the Ground level

o [STEP 1] Under the Architecture tab on the Ribbon select Structural Column.
Inset  Annotate  Analyze Messing &Site  Collaborate  View Manage  Add-lns  Modify -

= HEMEERKE R
o0 E gIlFASEEE BOD ALK g X S pi
Modify| Wall Door Window Component | Column|| Roof Ceiling Floor Curtain Curtain Mullion  Railing Ramp Stair  Model Model Model | Room Room  Tag _ Area Tag By ¢
M M M M T System Grd M Test Line Group Separator Room ™~ 7 Area ™ Face
Select « Id Circulation Model Room & Area ~
l Structural Column I
[ ermerterrat Crteamm 010 et 1 X ([P Level 2  South A West [ Level2 [ Level1 # North A Eas

« [STEP 2] Select the 5” x 5” column.
Note: an existing column family may need to be edited to create this size by clicking [EDIT TYPE] > Click
[DUPLICATE] > add name [W5x 5] > click [OK] > update width and height to 5”

Revit Session 3 | 152


https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/3PP-RVT-ARCH-ASCENT/files/GUID-F4ABE31C-D4D8-45FB-A628-A512D41D8114-htm.html
https://iastate.pressbooks.pub/visualgraphiccomm/?p=92#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=92#pb-interactive-content

P rti
Sl Type Properties ® ) 4
wssxhsapes-lﬁolumn - Family: W Shapes-Column
Type: WSx5
Structural Columns (22) w ‘a
Constraints LR Rename...
Column Location Mark 4 Type Perameters ; :I
Base Level Ground -
Base Offset I\tﬂ“= PEEMEE Value - [T b
& - Moment of Inertia weak axis 93.40in* _'_A_
Top Level Roof 1 - : pp—
TOE Offeet Lu = Elastic Modulus strong axis 54,60 in® ]
Colurmn Style Vertical Elastic Modulus weak axis 18.70in* [
Moves With Gride Plastic Modulus streng axis 60.40 in® “|‘ L
i Plastic Medulus weak axis 28.30in° !
Materials and Finishes Torinnal finerti 135t !
Structural Material Steel ASTM A992 araonal Mament ohintms :39in I
Torsional Modulus L
Structural - A
Top Connection None Warping Constant 2070.000 in® ={=—_5.__!.
Shear Area st !
Base Connection Nene ShEErArea 5 ro;g i :
Enable Analytical Model il b el i
Dimensions i Principal Axes Angle 0.00°
Volurme 0.89 CF Structural Section Geometry 2 ‘1’ l
Identity Data ) idth 5.000" '1 ] [
Image eight 5.000" ) _:!: .
Comments L Flange Thickness 0.560"
Mark Web Thickness 0.340" !
Phasing IS Web Fillet 0.500" ;
Phase Created MNew Construction H Centroid Horizontal 2.500" I
Phase Demolished Mone Centroid Vertical 2.500"
Identity Data E
Assembly Code B10
Type Image
Keynote
Model
Manufacturer
Type Comments
URL hall] =
What do these properties do?
<< Preview Cancel Apply )
1 l ]
I

+ [STEP 3] Confirm the Base Level is set to Ground and the Top Level is set to Roof
+ [STEP 4] Place a column on your [LEVEL 1]
« [STEP 5] It will be necessary to Move [MV] and Copy [CO] the Revit columns to align as shown on the imported floor

plan and the grid that you created

Hide the imported drawing image to confirm all columns are properly placed

Type [TL] to see the thick lines for print
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)

ﬁ References

Autodesk.Help. (2007, September 13). About Duplicating Views in Revit. Retrieved October 22, 2020, from
https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/3PP-
RVT-ARCH-ASCENT/files/GUID-F4ABE31C-D4D8-45FB-A628-A512D41D8114-htm.html
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Chapter 11. Add/edit beams, walls, & curtain
walls

@‘ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit Beam

(CO 2) Create walls

(CO 3) Edit walls wall properties — Wall thickness, Wall details, & Finishes
(CO 4) Edit/add wall properties — Wall opening, wall sweep

(CO 5) Add/Edit Curtainwalls, Mullions, & Panels

£ & Session Highlights

At the end of the session, students can create the graphics below.

Properties X {2 30) X [ Levell
@ 30 View - 7 & . B T
“ T Ny
3D View: (30} | B Edit Type ~ Y - !
Graphics A Sxl
View Scale EEENE S
g & -
Fine ~ Sy
Show Original ~0 ~
< Overr Edit RN
Edit. R
Coordinat ~O~
Show Hidden Lines By Discipline />/ N < . =l E\eu:tmns (Building Elevation)
Diefault Analysis Display .. N 3 5
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un P ~ ~
Bitents / ~o i
Crop View N e
F i J Z ~
P R i -
P e \ S ~
T e = ~
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E? Lecture Contents

(CO 1) Add/Edit Beam

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=94

Adding beams are not typical for interior design projects, but it is needed for the Eames House project. You may use this
information for an open ceiling plan of commercial projects as well.

You can find [BEAM] from the [STRUCTURE] tab, under the [STRUCTURE] panel.
Architecture Precast Inset  Annotate  Analyze  Massing & 5ite Collaborate  View  Manage  Add-Ins  Modify

7)o 0 o WED B & &< (J#@ BB

Madify| | Beam Wall Column  Floor  Truss Brace Beam Connection |solated Wall Slab Rebar Area Path Fabric Fabric Cover
& System Area  Sheet C

Select = Structure a Connection = u Foundation Reinforcement

If you are missing the Structure tab, click [HOME] menu > Click [OPTION] > Click [USER INTERFACE] > Check
[STRUCTURE TABL AND TOOLS]

Options x

General Configure

Tools and analyses:
User Interface ¥

Architecture tab and tools ~
Graphics I8 Structure tab and tools
[ Steeltab and tools
Hard
@ Sk [ Structural analysis and tools

4— File Locations [] Systems tab: mechanical tools

Mechanical analysis tools
—Zf — - — - - Rendering [] Systems tab: electrical toals - —T— —_—-—-
1
1

Blectrical analysis tools

e b [] Systems tab: piping tools |

SteeringWheels Piping analysis tools W .

To see the structural element in solid shapes instead of lines, the view detail level must be [FINE]. Please update all floor
plans, ceiling plans, and elevations to [FINE] on a detail level.

w

1 Coarse
F=3 Medium

38" =107 e G RE S 0 BINE ¢

Add Beams

« [STEP 1] Click [Beam] on [Structure]
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« [STEP 2] Select W Shapes-W5X5

o If you don’t have a W5x5 type. Please add one by clicking Edit Type > Duplicate > Name the type > Edit Width and
Height to 5
« [STEP 3] Select [Level: Level 2] from Option Bar [Modify/Place Beam] for the West Wall of the building
« [STEP 4] Click the center of the north column of the west wall, and click the center of the south column of the west
wall. You will get a warning message, but it is OK, just click X

Architecture  Structure  Precast lnsert  Annotate  Analyze Massing &Site  Collaborate  View  Manage  Add-ns  Modify| PlaceBeam @)

5 Ko 0@ B QG- o Broce- o @
Tt - BBy T g = |
Modity : %%J“L“z "ﬁ*@()ﬁﬁjgxg ‘fﬁl & DK

Select v Properties  Cliphoard Geometry Modify View Mesure  Create  Mode Draw Mutiile ~ Tag

Modiy | Place Beam P\a(emen(?\an Structural Usage: | <Automatic> 3DSnapping | C]Chain

Properties T Tever X [ Level 2 i3 B0} ¥ Project Browser - Eames_House_Project... X
80 i)

=) ® ”

®

On  Tagon
= Grids  Placement

New Structural Framing (<Automatic: 1
Ground T
vo f
00"
0072
0012 150-view-01
Uniform
Grigin & Elevations (Building Elevation)
5 Eost
00
Top North
00" South
# West
Steel ASTM A%92 RN S

Center of Geometry
None

End Connection None
Cut Length 5

<Automatic>

Volume

Identity Data
Image
Commen ts

+ [STEP 5] Confirm the place from the 3D view by clicking the HOUSE icon from quick access and hide site
information by category. Update the 3D view scale to 3/8”=1"-0."

REcHG - 28 = s0A(E)> % 5"
o Manage Addns  Modiy @

5 #Q0 OED & &So Q@B 0= @ AR ZHs %W/ &5

Modify| Beam Wall Column Floor Truss Brace Beam  Connection lsolated Wall Slab  Rebar Area Path F Cover Rebar  Component  Model Model Model By Shaft Wall Vertical Dormer Set  Show Viewer
S S Syster 5 Coupler 5 Tet Line Group” Fac

<R 2 signin W @ -8 X

Architecture  Structure  Precast Insert  Annotate  Analyze  Massin

Select ~ Structure

Model Opening Datum Work Plane

Properties X [0 Level [ Level2 @ ool x
@ 30 View -
3D View: {30} N

Discipline " Coainton Y‘ ) "
‘gg\v’* A \
l..w ' :‘; =, \'
= ‘ \'-l‘ A

+ [STEP 6] Open the 3D view, West elevation, and the floor plan together by typing [WT]
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+ [STEP 7] The Beam must be rotated to 90 degrees.

o Click the Beam, and change the properties

o Change Cross-Section Rotation to 90 degree

>
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Sheets (al)
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el Groups

@ Reit Links

o The beam location needs to be aligned from the Top view of the 3D view. Use Move (MV) command to move the

Beam to be aligned.
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+ [STEP 8] See the West elevation and move the Beam to align with the imported image, [MOVE] command will not

work.

o Thus, update [Y OFFSET VALUE] to [1" 1 %4”]
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« [STEP 9] For other beams repeat step 1 through step 8. You may select all beams that you created and change the
properties — Step 6 & 7. or Copy elements that have the same properties.

o Complete beams for the second floor and the roof exterior beams, AND the second level interior beams

Properties x| [ Level 1 s © 6o x = Project Browser - Eames_House_Project.. X
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Level 1

® Level2
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Add NEW Beams from a new family

.

[STEP 1] Click [Load Family] on [Insert] tab

[STEP 2] Download [LH-Series Bar Joist.rfa] from Canvas Eames House module
+ [STEP 3] Find the folder and select the file and Open

[STEP 4] On Roof plan, Click [BEAM] on the [STRUCTURE] tab

[STEP 5] Click North column and South column to create the Bar Joist
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[STEP 6] Edit the family type to match the imported drawing
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(CO 2) Create walls

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=94

Draw WALLs with Various types based on the imported base drawing image

+ [STEP 1] Select [WALL] from [ARCHITECTURE] tab, under [BUILD] panel
or Type [WA]
« [STEP 2] Select a Wall family

o If you don’t have a wall type from the Properties, add by clicking Edit Type and Duplicate from a wall type.

o For Eames House, we will use

= Curtain Wall 1

= Retaining -12” Concrete

« Interior-4 7/8” Partition

= Interior-6 1/8” Partition

= Soffit-1/2” GWB & Metal Stud

o But the wall details will be modified, and custom walls will be added later in this tutorial.
+ [STEP 3] Confirm [BASE CONSTRAINT] and [TOP CONSTANINT]. If needed set base offset and top offset
« [STEP 4] Specify Location Line
« [STEP 5] If the wall is other than a straight line, specify a line/shape type (circle, arc, rectangle, inscribed polygon, or
ellipse. And draw lines to cross-reference of the imported base drawing image

+ [STEP 6] Make Dimensions [DI] for verification purposes.
« [STEP 7] Confirm with 3D view
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(CO 3) Edit walls wall properties — Wall thickness, Wall details, & Finishes

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=94

For your wall thickness, refer to Kilmer, W., & Kilmer, Rosemary. (2016). Construction drawings and details / W. Otie Kilmer
and Rosemary Kilmer. (Third ed.).

For your design project, you will need to decide on your construction details.

Typical residential house wall thickness (For your reference)

+ Interior Wall (without Plumbing) = 4 12" ((1) 2”X4” wood stud, which are 3 14" deep + (2) ¥2” Gypsum boards)

+ Interior Wall (with Plumbing) = 6 %" ((1) 2"X6” wood stud, which are 5 14” deep + (2) 2" Gypsum boards)

«+ Exterior Wall (with Brick) = 10” (1) 2”X6” wood stud, which are 5 72" deep + (1) ¥2” Gypsum boards + (1) ¥2” Insulation
+ (1) 3 ¥4” Brick)

+ Exterior Wall (with Stucco, wood, aluminum, or vinyl) = 7 1/2” ((1) 2"X6” wood stud, which are 5 ¥2” deep + (1) 12"
Gypsum boards + (1) %” Insulation + (1) 1” Stucco, wood, aluminum, or vinyl)

For the Eames house project, although this building is residential, the construction is a combination of wood base and metal
base. Revit provides walls for commercial construction, which is a metal base, so, you may use the provided walls and change

some walls.

+ Interior Wall = Wood stud with Gypsum BD + Paint Finish or Wood BD (3 1/8”,47/8”, 6", 8”)
+ Exterior Wall = Curtain Wall with Glass, Wood, Metal panels

+ Exterior Wall = Metal with Gypsum BD + Paint Finish or Wood BD

« Exterior Retain Wall = Concert

Once you click a wall, you can edit the properties (wall height-where it starts and ends & wall phase) for each wall

If you want to change the wall’s type (wall thickness Graphic style, materials, Structure, BIM information), you can change
by clicking [Edit Type]

For the future strategy, it is wise to [Duplicate] the type and edit type properties. For best practice, add “000” for the new
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duplication. This will allow the types to organize in alphabetical order.
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Click [EDIT] on [STRUCTURE] and change thickness and material and click [OK]
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Properties i X
Edit Assembly X
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To change other walls from the Revit Metal base 4 7/8” wall to Wood base 4 12.”

« [STEP 1] Click one of Metal base 4 7/8” wall
« [STEP 2] Mouse right click and click [Select all instances] and click [in Entire Project]
« [STEP 3] Select [000_Interior-4 %" Partition]
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150-view-01

- Hlevations (Building Elevation)

Fam
o [0] Groups
oo RevitLinks

(CO 4) Edit/add wall properties — Wall opening, wall sweep

visualgraphiccomm/?p=94

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

Wall opening or wall elevation modification

« [STEP 1] On a plan view, click the wall that you want to make wall opening
« [STEP 2] Click [Edit Profile]

Architecture  Structure  Precast  Insert  Annotate  Analyze Massing &Site  Collaborate  View  Manage  Add-ns _Modify |Walls -
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Modify| - 5 + O =4 = g . ?;U Edit Wall  Attach  Detach
B Gon- & % Q i 202 gy &' |profil Opening Top/Base Top/Base
Select v Properties  Clipboard Geometry Modify View | Measure | Create Mode. Modify Wall
Properties X | [A Level 1 x s 3D}
o3 . 7o . o3 . [EEETS > SN
Basic Wall — L ~ — T — L \Q\
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Base Offset 3
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Base Extension Distance  0' 01
Top Constraint Upto levek: Level 1 Ceiling
Unconnecied Height 18 0
Top Offeet 00"
Top is Attached
Top Extension Distance 0/ 0
Room Bounding | |
Related to Mass
Cross-Section Vertical ‘ ‘
Structural
Structural jm] i n |
Enable Analytical Model § Doae-ro BB ERE D 0 (ald <
Structural Usage iNon-bearing

Level 2

« [STEP 3] Go To View window will open.

+ [STEP 4] Select an appropriate view to open. I prefer the ISO view to quickly change the elements
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+ [STEP 5] Draw the opening with dimension
+ [STEP 6] Click the green checkmark to finish

®x - (=] Ll Ea
Mify &} : : ‘l;l u&d Dk El/ & :
¥ - o M aaxs

Select ~ Properties  Clipboard Geometry. Modify View  Messure  Create

Propertes x| @ Levelt < @ o x = Project Browser - Eames_House_Project.. X

- A~ 10 Views al)
2 5 Floor Plans
I Level 1

= n S Level2
<Sketch> (1) - e L
Dimensions 2 ~7

Site
Length

- Ceiling Plans
Level1

Level2
Roof
- 3D Views
150-view-01
@)
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East
™ North
South
West
77777777777777 Legends
3 Schedules/Quantities (all)
. Sheets (i)
3= 10" BB Pk SR E 0 (3 1E < > B Farnilies
o] Groups
5312 k4 5 Revit Links

« [STEP 7] Double check in 3D view

Wall Sweep is a very useful tool to create moldings

« [STEP 1] To create a continuous molding. First, you need to load a profile by clicking [Load Family] from the [Insert]
tab.

+ [STEP 2] Find Profile from Revit library and open it to the file.
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Ll I | )
R Load Family ? e

Look in: wall v| 4= B L Views ¥
-DESktOD Preview

fi 2 [ This PC
L= #2035 (C:)
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Autodesk
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Libraries
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'y Libraries

@ ¥ Network
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&5 Creative Cloud Files
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STEP 3
STEP 4
STEP 5
STEP 6

Properties

Click the small arrow under Wall on Architecture tab

Select Wall: Sweep on 3D view. Recommend a camera view or a 3D view with a section box
Click [Edit Type] > Duplicate the type. Don’t forget to add “000” for your type.

Click profile under construction, select the profile you just loaded.

[
[
[
[

[l el

|
«
@
x
> 4
o®

Type Properties Xt

Wall Sweep
Comnice

Eamily: System Family: Wall Sweep ~ Load

e e (e D)

Rename...

Type Parameters

Constraints

Cuts Wall
Cut by Insents ]
Default Setback 0

Material <By Category>
Identity Data
Subcategary of Walls Wall Sweeps - Cornice

Manufacturer
Type Comments

URL

+ [STEP 7] See the preview and click the appropriate location on the wall for the molding on the 3D view.
« [STEP 8] To finish the Sweep, [ESC] on Keyboard.

(CO 5) Add/Edit Curtainwalls, Mullions, & Panels

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=94

Modify curtain wall

+ [STEP 1] To add curtain wall grids, open a view. It can be an elevation view. You may close the floor plans.
+ [STEP 2] For the Eames house project, confirm the imported base drawing — elevations are in the correct locations.
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o [STEP 3] Click [Curtain Grid] on [Architecture] tab
+ [STEP 4] Select [All Segments] or [One segment]
« [STEP 5] Click grid lines and use dimensions for accurate distance based on the imported elevations

Architecture  Structure  Steel  Inset  Annotate  Analyze Massing &Site  Collaborate  View Manage Add-Ins  Enscape™  Modify | Curtain Wall Grids (23~
O I Pl == e % Q- — =4
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Med Ps 5 + 0 =
ey g B a0 () T 2 2 x § ARemove Segments
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Select ~ Properties  Clipboard Geometry Modify Adds or removes segments in a curtain grid.
Wodify | Curtain Wall Grids Press F1 for more help | f° Video is loading...

Properties X G4 150-Model [ Level 1 O Section 1 T 3D View 1 T+ North  South X
Curtain Wal Grids (1) ~ | B Edit Type

Phasing

Phase Created iNew Construction

Phase Demolished iNone

+ [STEP 6] You can edit the grid, click the grid, and click add/remove segments.
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] 1 1 ] ] 1 ]
‘ Grids Gnd‘}l ‘ ‘ ‘ ‘
[ [ [
== |

» Complete for all four exterior walls

Add curtain wall mullion

« [STEP 1] On the elevation, click [MULLION] on the [ARCHITECTURE] tab
+ [STEP 2] You may choose All Grid Lines, Grid Line, or Grid Line Segment
« [STEP 3] Also, you may choose a specific type of Mullion by clicking Properties, and you can edit the type as well

> You can change material, size, profile, the width of sides, angle, & offset
+ [STEP 4] Click lines to apply the mullion type that you selected
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Enscape™  Modify | Place Mullion =~

File Architecture  Structure  Steel  Insert  Annotate  Analyze  Massing & 5ite  Collaborate  View  Manage  Add-Ins.

| X Kcpe-[af |3 le‘ D«'\ sa o ¥ Q- — 1 Eﬁ Hﬂ EE]
N il = AN e =
: : Glout - =3 . BBEElw == o 3

Modify aste = ‘_g‘ o =% y " Grid  Grid Line |All Grid

& - G- 2k PO iy x o 5 Line Segment| Lines
Select = Properties  Clipboard Geometry Modify View  Measure  Create TV,
Wadify | Place Mullion
Properties X {7 I1SO-Madel [ Level 1 > Section 1 = 3D View 1 £+ North 4 South x

Rectangular Mullion
1.5 x 2.5" rectangular

Curtain Wall Mullions ~ Edit Type
QRO & © @

=

QEQEQ
EES0 (0 Y |

QEQ

QEQEQEQ

Modify Mullion

+ [STEP 1] If you need to change the mullion type, you can click the mullion that you made and change the properties
« [STEP 2] If you need to change the mullion type and join order, click the Mullion you want to change and click [+] on
the view to change the order

To change the panel from Glazing to Solid, door, or window

[STEP 1
[STEP 2
« [STEP3
[STEP 4

Select the panel to change by multiple [Tab] keys
Change Properties to what you need
If you need to change the properties, click [Edit type] and click [Duplicate] and change the value

[ W Y

If you need to add a new type, Load family first and change the Properties
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Search P

@ Curtain Wall 1
@ Extericr Glazing
@? Storefront

. Empty System Panel

Empty
Stacked Wall
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=== Exterior - Brick Over CMU w Metal Stud

’! System Panel
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Solid

.4

Basic Wall : Generic - 67
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Basic Wall : 000_Interior - 4 1/2" Partition

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 12. Understand visibility settings, add/
edit floor & ceilings

@‘ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand View template, visibility graphics
(CO 2) Understand View range

(CO 3) Add/Edit Floors & Floor Properties

(CO 4) Add/Edit Ceilings & Ceiling Properties

“® Session Highlights

At the end of the session, students can create the graphics below.
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E? Lecture Contents

(CO 1) Understand View template, visibility graphics

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=96

[VIEW TEMPLATE] in Revit is a collection of view properties, such as a scale of a view, detail level, discipline, view ranges,
orientations, model display, and visual settings. With using [VIEW TEMPLATE], you can apply standard settings to views.

For example, I can make a Floor plan view template to apply all my floor plans. The floor plans will have the same scale,
detail level, and style of lines. And you can also set a Furniture plan template. On the floor plans, you can hide all door tags
and window tags at once. View templates save much time when producing a set of construction documents.

To set a view template

[STEP 1] Click [VIEW TEMPLATE] from [PROPERTIES] palette, Assign view template window will open
[STEP 2] Select ARCHITECTURAL PLAN]
« [STEP 3] Click [DUPLICATE] icon, and Name it [3/8” Floor Plan]
[STEP 4] Update [VIEW SCALE] to [3/8"=1-0"]
[STEP 5] Click [EDIT] on V/G Overrides Model, then Visibility/ Graphic Overrides for 3/8” Floor Plan window will
open
+ [STEP 6] You can hide categories that you don’t want to show in the view by unchecking the categories.
+ [STEP 7] Also, you and change the graphic styles by clicking [OVERRIDE]
+ [STEP 8] Click [OK]s to apply
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To apply the view template to other views

« [STEP 1] Select a view or multiple views

+ [STEP 2] Click [VIEW TEMPLATE] from [PROPERTIES] palette
+ [STEP 3] Select the view template you made for the selected views
« [STEP 4] Click [OK] to apply

Once you apply a view template, the visibility/graphic override, view scale, display model, detail level, view range, discipline,
phase filter, and more items in the view templates will be deactivated on the view. To change the setting, you have to adjust
in the view template, not individually.
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If you want to set the view settings individually, you must select [NONE] for the view template.

For more information, please refer to this page for the view template.

(CO 2) Understand View range

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=96

[VIEW RANGE] is a set of horizontal planes that control the visibility and display of objects in a plan view.
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To adjust view range

« [STEP 1] Click [VIEW RANGE] from [PROPERTIES] palette. If this is deactivated, check your view template and click
[VIEW RANGE] from the template.
+ [STEP 2] You define the ranges by adjusting the offset value
+ [STEP 3] You can see the sample view range for better understanding by clicking [<< SHOW] button
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« [STEP 4] Click [OK] to apply

For more information about [VIEW RANGE], please visit this page

[UNDERLAY] is a function to understand the relationship of components at different levels for coordination and
construction.

To apply [UNDERLAY]

[STEP 1] Open the second-floor plan
[STEP 2] Click Range: Base Level and change the level that you want to look below
« [STEP 3] Click Range: Top Level and change the level that you want to ‘lookup.
[STEP 4] For floor plans, the Underlay Orientation should be [LOOK DOWN]
For RCPs, the Underlay Orientation should be [LOOK UP]
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Once the underlay function is activated, you can see the gray lines. You are not able to click nor edit the underlay items.

This function is only for the working process. If you don’t need the underlay items, please check [NONE] on Range: Base
Level to deactivate the function.

For more information about [VIEW RANGE], please visit this page.

(CO 3) Add/Edit Floors & Floor Properties

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=96

Revit is a BIM software; it needs more information to generate 3D views and Drawings. When in plan view the drawing
appears complete much like it does in AutoCAD. However, when you view the Revit model in a 3D view, the floors and
ceilings are missing. Therefore, you need to model these elements as well.
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There are multiple ways to create floors. I prefer to create a slab(without finishes) and then add finishes over the top of the
slab.
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To Add/Edit Floors

+ [STEP 1] Select [FLOOR ARCHITECTURAL] from [ARCHITECTURE] tab, under [BUILD] panel

Grch\te(ture’ Structure  Precast Insert Annotate  Analyze  Massing 8 5ite  Collaborate  View  Manage Add-Ins  Modify =~

s3I0 E @ | PASEBE BOS ALR KK B X
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Select E Circulation Maodel Room & Area ~
Floor: Architectural
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| ‘ | |

+ [STEP 2] Select a Floor Type. For the First Level of Eames House, we will use [Generic — 12”], but we will modify the
properties later.

+ [STEP 3] Select the level where the floor is located. And specify height offset from the level if required.

+ [STEP 4]Draw the boundary of the Floor plan. You can draw using straight lines or any of the other options. Make sure

Floor Plan: Level 1 ~ Edit Type

H

the boundary lines are connected and closed
+ [STEP 5] Click the green checkmark to complete the sketch
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« [STEP 6] Confirm the location on a section view or a 3D view
You can click [SECTION] from the [VIEW] tab, under the [CREATE] panel. And draw a section line for verification
purposes.
Make sure your building pod must be below level 1.
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Add a floor for the second level

[STEP 1] Open [LEVEL 2] floor plan
« [STEP 2] Click [FLOOR] from [ARCHITECTURE] tab, under [BUILD] panel
[STEP 3] Change the floor type to 3” LW Concrete on 2” Metal Deck, and verify the Level 2, and the Offset
[STEP 4] Draw continued lines for the floor. If there are floor openings, draw the openings as well. If the openings are

inside the boundary of the floor, Revit will recognize as it is opening.
+ [STEP 5] Click [GREEN CHECK MARK] to complete the sketches
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Edit Floor properties

You will change the thickness of the floor 12” to 2.

STEP 1] Select the first level floor from the 3D view

o [ ]

« [STEP 2] Click [EDIT TYPE] on [PROPERTIES] palette

« [STEP 3] Click [DUPLICATE] on [TYPE PROPERTIES]

+ [STEP 4] Enter a new name. I recommend adding [000_] of the letter of the name.

For example [000_Generic - 2]
« [STEP 5] then click [OK]

Properties =] X ]
Floor . s *
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[ Edit T
Constraints 2 E——
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. AL 3 ===l e

« [STEP 6] Click [EDIT] for [STRUCTURE]
« [STEP 7] Change [2”] and click [OK] and [OK] to complete

Properties i, . =
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Floor - - )
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Area

Volume

Elevation at Top
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Add Floor types

[STEP 1] Click [FLOOR] from [ARCHITECTURE] tab, under [BUILD] panel
[STEP 2] Select [Generic — 127
« [STEP 3] Click [EDIT TYPE]
[STEP 4] Click [DUPLICATE]
[STEP 5] Rename to [000_TL_01], you will need [000_TL_02], and [000_CPT_01]
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STEP 4] Click [EDIT] for [STRUCTURE]
STEP 5] Change the Function to [FINISH 1]
STEP 6] Change the Thickness to [1/2”]
STEP 7] Click <By Category>

]

STEP 9] Rename the new material
STEP 10] Check [USE RENDER APPEARANCE]
STEP 11] Change the foreground pattern

[
[
[
[
« [STEP 8] Click [CREATE A NEW MATERIAL]
[
[
[

- B x - K [ - e
16w l ::::!vﬁ = seoch q\ MAW eeeeeee
)| o voten B T e
o | gl o o [scs2122 18
‘ ~| @ ropes | o
[STEP 12] Click [APPEARANCE] tab
[STEP 13] Click [REPLACE THIS ASSET]
[STEP 14] Find appropriate material from [APPEARANCE LIBRARY]
[STEP 15] Click the [REPLACE] icon, and close the [ASSET BROWSER]
[STEP 16] If needed, change the color
[STEP 17] Click [OK]s to complete
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» | Relief Pattern
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Add floors for finishes

STEP 1] Open a plan view to add the finish floor

STEP 2] Confirm the level on the [PROPERTIES]

] Change the Height Offset From Level to [1/2”]
]

[
[
[STEP 3
[STEP 4] Draw Floor Boundary, please consider not to overleap with walls
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(CO 4) Add/Edit Ceilings & Ceiling Properties

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=96

Add a ceiling

[STEP 1] Open [LEVEL 1] ceiling plan

[STEP 2] Click [CEILING] from [ARCHITECTURE] tab, under [BUILD] panel
« [STEP 3] Select [GWB on Mtl. Stud]

[

STEP 4] Confirm [LEVEL] is [LEVEL 1 CEILING] and [HEIGHT OFFSET FROM LEVEL] to [0°0”].

If you don’t have a level for a ceiling, you can set your level to Level 1 and update the height offset from a level like

8-0”
« [STEP 5] Draw the Ceiling boundary.
You will need to draw an independent ceiling for each room.
« [STEP 6] Click the green checkmark to complete this command.
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+ Repeat this process to place a ceiling at level 2

Edit Ceiling properties

You will change the thickness of the ceiling 12” to 2.”

STEP 1] Select the first level ceiling from the 3D view
STEP 2] Click [EDIT TYPE] on [PROPERTIES] palette
STEP 3] Click [DUPLICATE] on [TYPE PROPERTIES]
STEP 4] Enter a new name. [ recommend adding [000_] of the letter of the name.
For example, [000_GWB on Mtl.Stud-3"]
« [STEP 5] then click [OK][STEP 6] Click [EDIT] for [STRUCTURE]
« [STEP 7] Change [2 3/8”] for [METAL STUD LAYER] and click [OK] and [OK] to complete
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 13. Add/edit stairs, rails, & roof

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit Stair - three types of staircases
(CO 2) Add/Edit Railing
(CO 3) Add/Edit Roof

£ 2 Session Highlights

At the end of the session, students can create the graphics below.
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E.’ Lecture Contents

(CO 1) Add/Edit Stair — three types of staircases

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=98

+ Revit provides various types of staircases, and it is modifiable.

+ Revit stair automatically calculates the number of stair runs, automatically creating landing, supports, and even
handrails.

+ In this tutorial, the instructor will demonstrate four types of staircases — a straight stair, two runs (a switchback stair), a
spiral, and a custom with sketch in another Revit file only for reference.

+ For the Eames house, students will only need a spiral staircase.

+ For more information about Revit stairs, please visit this page

To create a straight stair

Be aware of the overall size of the staircase and create walls for the staircase before you create a staircase in Revit. If it is an
open staircase, please use the reference plane for a guideline.

« [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section

view with a perspective view to see the height and overall shape of the staircase. And view change to Window Tile view
(WT)
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« [STEP 2] Draw Detail Line (DL) for the outlines of the staircase. You may turn on the CAD drawing that you already
imported.

« [STEP 3] Click [STAIR] from [ARCHITECTURE] tab, under [BUILD] panel
« [STEP 4] Select [STRAIGHT] from [MODIFY/CREATE STAIR], under [COMPONENT] panel
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+ [STEP 5] Select a center point for the stair start point on a plan view, then Revit automatically calculates and shows

how many stairs are needed to reach the next floor. Then, click the endpoint on the current view to finish
Architecture  Structure  Precast Insert  Annotste  Analyze  Massing & Site  Collaborate  View  Manage  Add-lns  Madify | Create Stair 0~
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+ [STEP 6] Then, the preview will show on all the views. If it looks OK, click the green checkmark to finish. If it needs
changes, the types of family, click family type on [PROPERTIES] palette, and select the desired family. If you do not
have a desired family for the stair, load the family first

+ [STEP 7] If the stair run width need a modification, click the run, then change the width by adjusting the arrows
If the stair Riser Height or/and Tread Depth change, click [EDIT TYPE] and change the Type Properties. Do not forget,
if you change the type properties, all types will change. To prevent this, please [DUPLICATE] and edit.
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« [STEP 8] Click [GREEN CHECKMARK] to complete
+ [STEP 9] Remove the Detail lines or the Reference Plans that you used for the stair
[STEP 10] If you found errors on your stair, click [EDIT STAIRS] to fix the error
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To create a two-runs stair (a switchback stair)

+ [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section
view with a perspective view to see the height and overall shape of the staircase. And view change to Window Tile view
(WT)

+ [STEP 2] Draw Detail Line (DL) for the outlines of the staircase. You may turn on the CAD drawing you already
imported.
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« [STEP 3] Click [STAIR] from [ARCHITECTURE] tab, under [BUILD] panel

« [STEP 4] Select [STRAIGHT] from [MODIFY/CREATE STAIR], under [COMPONENT] panel

+ [STEP 5] Select a center point for the stair start point on a plan view, then Revit automatically calculates and shows
how many stairs are needed to reach the next floor. Then, click the second point on the current view to create the
landing start
Then, click the third point on the current view to create the second stair start point
Then, click the endpoint on the current view to finish

Properties X | [ Level 1 X = 30}
~

Stair

Constraints
Base Level

A yraro D@ GBRHD 0 (518 < >

Level2 =

@2 Revit Links

New Construction
Phase Demalished None
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+ [STEP 6] Then, the preview will show in all the views. If it looks OK, click the green checkmark to finish. If it needs
changes, the types of family, click family type on [Properties] palette, and select a desire family. If you do not have a
desire family for the stair, load the family first
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+ [STEP 7] If the stair run width needs a modification, click the run, then change the width by adjusting the arrows
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« [STEP 8] Click [GREEN CHECKMARK] to complete
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« [STEP 9] Remove the Detail lines or the Reference Plans that you used for the stair

To create a spiral stair

« [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section
views with a perspective views to see the height and overall shape of the staircase. And view change to Window Tile
view (WT)

« [STEP 2] Draw Detail Line (DL) for the outlines of the staircase. You may turn on the CAD drawing you already
imported.
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« [STEP 3] Click [STAIR] from [ARCHITECTURE] tab, under [BUILD] panel
+ [STEP 4] Select [FULL STEP SPIRAL] from [MODIFY/CREATE STAIR], under [COMPONENT] panel
+ [STEP 5] Select a center point of the staircase start point on a plan view, then Revit automatically calculates and shows

Y
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how many stairs are needed to reach the next floor. Then, click the center point of the run start on the current view to

create the staircase.
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+ [STEP 6] Then, the preview will show on all the views. If it looks OK, click the green checkmark to finish. If needs
changes, the types of family, click family type on [PROPERTIES] palette and select a desired family. If you do not have

a desired family for the stair, load the family first

« [STEP 7] If the stair run width needs a modification, click the run, then change the width by adjusting the arrows
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« [STEP 9] Remove the Detail lines or the Reference Plans that used for the stair

Complete the staircase for the Eames house project with [FULL STEP SPIRAL] tool. It may need some adjustment because
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of the structure and shape. Please experiment for the staircase.
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To create a custom stair

+ [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section
view with a perspective view to see the height and overall shape of the staircase. And view change to Window Tile view

(WT)
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Create Sketch

Creates a custom run by sketching the shape.

When sketching a run, select to sketch the boundary, fiser, or stair
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+ [STEP 2] Draw [BOUNDARY]
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[STEP 4] Draw [STAIR PATH]
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[STEP 6] If needed, click [FLIP] the direction of the staircase
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« [STEP 7] Click [GREEN CHECKMARK] to complete the tool
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Autodesk provides sample stairs and railings. Please download the samples by clicking this page and copy and paste that

which you want to use in your project. This process will load the family files to your Revit file
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(CO 2) Add/Edit Railing

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=98

Typically, railings are automatically created when a staircase is made
For more information about Railings, please read this page

However, many times, your railings need modifications.

To extend your railings

[STEP 1] click the railing
« [STEP 2] click [EDIT PATH]
[STEP 3] edit/add the path
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To edit handrail

+ [STEP 1] If a Handrail path needs changing, you can select handrail only by pressing the [TAB] key
+ [STEP 2] click [EDIT RAIL]
o [STEP 3] click [EDIT PATH] it would be better to work in Section or a 3d view
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To change the handrail type, change the family type from [PROPERTIES] palette

To create a path without a stair

[STEP 1] Click [RAILING]
+ [STEP 2] Click [SKETCH PATH]
[STEP 3] Sketch a path with a drawing tool on a plan view

e I o (e
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ol s Use the drawing tools and options to sketch the railing segments
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+ [STEP 4] Click [GREEN CHECKMARK] to finish
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(CO 3) Add/Edit Roof

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=98

In this session, I will demonstrate the two types of roof; one is the Eames house roof — Flat roof and a typical residential roof
- Hip roof

There are ten standard roof shape models in the Revit tutorial. Please watch this tutorial for your other projects
10 Common Roof Shapes Modeled in Revit Tutorial

Please find Autodesk provided roof tutorials from this link

If you want to create complex roof shapes in Revit, please watch this YouTube video
3 Complex Roof Shapes in Revit

For the Eames House project, you will create two models, which are the roof on the top of the metal deck and the Edge of
the roof.

Add a flat roof

[STEP 1] From the Project Browser, switch to the Roof plan.
+ [STEP 2] In the Properties, with nothing selected, set the Underlay to level 2.
[STEP 3] From the Architectural tab, click the small arrow on the roof] > Click [ROOF BY FOOTPRINT]

Architecture  Structure  Precast Insert  Annotate Analyze Massing &Site  Collaborate  View  Manage  Add-Ins  Modify
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Properties o, Roof by Extrusion [ Roof X i 30} i3 B0}
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Floor Plan: Roof v 8B \ép‘”" Soffit T ‘ e
Graphics
View Scale 3/8" = 10 b/ Roof: Fascia 1 |
Seaie Vaine i 3 ?
Normal %/ Roof: Gutter -
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Show Original ! f /
aphic Edit... =
Graphic Display Options Edit.. -
Grientat Project North
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+ [STEP 4] Use the Draw tool to create a boundary.

o Make sure you check Basic Roof — Generic — 9” > Duplicate — 3”
o Base level — Roof
o Base offset from level - 0’ 0.
o Uncheck - Defines slope
o Offset - 0'0”
+ [STEP 5] Once the boundary line is done, click the green checkmark
+ [STEP 6] Your roof will be over the Metal deck; you can move the roof above the metal deck
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+ [STEP 7] You may add a point / a line for slope for a roof drain, click [ADD POINT] and click a point on the roof and
change the height.

To create a gutter

[STEP 1] From the Architectural tab, click the small arrow on the roof] > Click [ROOF: GUTTER]
[STEP 2] Default will be Gutter — Bevel 5” x 5”. We will change to 6”x 6.”

+ [STEP 3] Click [EDIT TYPE] > [DUPLICATE] > name change [000_Gutter — Bevel 6” x 6”] > Click [OK]
[STEP 4] Click Gutter Profile-Bevel: 5”x5” on profile

[STEP 5] Change to 6”x 6” > Click [OK]

[STEP 6] From the ISO view, click the top edges of the roof

« [STEP 7] To finish, [ESC] key
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Add a hip roof (combined)

STEP 1] From the Project Browser, switch to the Roof plan.

STEP 2] In the Properties, with nothing selected, set the Underlay to level 2 or level 1.

STEP 3] From the Architectural tab, click the small arrow on the roof] > Click [ROOF BY FOOTPRINT]
STEP 4] Use the Draw tool to create a boundary.

.
— o o

»

> Make sure you check Basic Roof — Generic - 9” > Duplicate - 3
o Base level — Roof
o Base offset from level - 0’0
> Check - Defines slope
> Slope -97/12”
o Offset—1'6.
+ [STEP 5] Select 3 lines do not have a slope, uncheck [DEFINES SLOPE]
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« [STEP 7] From the Architectural tab, click the small arrow on the roof > Click [ROOF BY EXTENSION]
+ [STEP 8] Revit will ask you to select a work plan > Select [PICK A PLANE] > Pick a face of wall where the roof profile
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will start
[STEP 9] Revit will ask you to select Roof reference level and offset > Click [OK]
[STEP 10] Draw a continued open line for the roof on a Front view
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[STEP 11] Click Green checkmark when it is done

[STEP 12] On the plan view, you will adjust the depth of the roof

[STEP 13] To fix the separated roof, you may use [JOIN/UNJOIN ROOF] on the Modify tab
STEP 14] Click the profile first and click the face where the profile will meet
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[STEP 15] To meet all wall to the Roof, Select all walls
[STEP 16] Click [ATTACH TOP/BASE]
[STEP 17] Click the roof, you may get a warning, but it is OK.
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 14. Add/edit windows, doors, lighting
fixtures, furniture, tags, & sheets

@Session Obijectives

Upon completing this session, students will be able to:

(CO 1) Understand the concept of family file

(CO 2) Add/Edit Doors and Windows

(CO 3) Add Tags

(CO 4) Add/Edit Lighting fixtures

(CO 5) Add/Edit Titleblocks

(CO 6) Insert Plan views and symbols — North arrow and graphic scale

* Session Highlights

At the end of the session, students can create the graphics below.
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E? Lecture Contents

(CO 1) Understand the concept of family file

visualgraphiccomm/?p=100

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

About Revit Families

+ A Revit family is a group of elements with a common set of properties, called parameters, and a related graphical

representation

+ All of the elements that you add to your Revit projects are created with families.

+ For example, the structural members, walls, roofs, windows, and doors that you use to assemble a building model, as
well as the callouts, fixtures, tags, and detail components that you use to document it, are all created with families.

For more information about the Revit family, please see this page Autodesk Knowledge — Revit Family

To create a new family

+ Click [File] on the menu > Click [New] > Click [Family] > Select a template from library > create the model and

parameter
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« However, A beginner may elect to not create a new family due to the complexity of the process. Instead, you may want

to start with a family that has similar attributes and edit accordingly.

201 | Revit Session 7


https://iastate.pressbooks.pub/visualgraphiccomm/?p=100#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=100#pb-interactive-content
https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2016/ENU/Revit-Model/files/GUID-4EBB97AD-C7B6-4828-91EB-BC0E99B81E43-htm.html

To load Family files from the Revit library

Click [Load Family] from [Insert] tab, under [Load from Library] panel > Find the library folder from your computer >
Select a family / families to load > Click [OPEN]
Then, you can confirm and find the loaded families from the [Project Browser] under the [Family] category
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You can load as many families as possible but you should consider file size.

BimObject https://www.bimobject.com/en-us

o Manufacturer upload Revit Family files

o Previously named Autodesk Seek

o Most of the files are reliable, some advertisements added

Revit City https://www.revitcity.com/index.php

o The user shared Revit Family website

o Many designers, practitioners, and students use this website

o Some files may cause issues to your project

BIM Smith https://market.bimsmith.com/

> Mix of free and paid Revit Families

o Great collection of products

NBS National BIM Library https://www.nationalbimlibrary.com/en/

o UK based the best BIM object website
o Manufacturers website
o Most reliable but hard to find out

¥ Project Browser - Eames. House_Proj,
5 Sections (Building Section]
Section 1
Section 2
Legends
2 Schedules/Quantitis (al)
Sheets all)
mayTcal Links
Annotation Symbols
- Cable Trays
- Ceilings
Columns
- Conduits

Curtain Panels
Curtain Systems

- Curtain Wall Mullions
Detai Items

Flex Ducts
Flex Pipes
Floors

Fumiture

Generic Models

Parking
Pattem

Pipes

Piping Systems
Planting
Profiles
Railings

Ramps
Roofs
Site
Stairs

Structural Beam Systems
Structural Columns

Find and download Revit families from external sources (recommended websites by the instructor)
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Purge Revit families

+ Family management is one of the keys to managing your Revit file. If you want to delete unused family files, click
[Purge Unused] from the Manage tab.

+ Use caution when using this function; you will lose all family and views you are not using. I reccommend you make a
copy or save as the original file and [Purge Unused)].

+ Click [Purge Unused] Number of items checked until “0”.

R s e hddins Modty -

Meain Model

Select + Settings Project Location Design Options Generative Design  Manage Project  Phasing  Selection Inquiry

5 3D Views

150-view-01
5 o Go)
5 Elevations (Buiding Elevatic
East

‘ Check All , ?::::
I el G Check None
g 1 i - Other Styes
o | | St Stge ehanes
Graphic Display Options
| \
- ,f\; ,,,,, % I
| \
Tl I
a | 3 =
—F 4 %fﬁf , e
s Il i S G W=[T_]
Moot : ; | o Piping Systems.
Note deleted ! ! Plantin
i | | R o e @ | | poties
| | = | |
+ The file size reduced, then you have a lighter file to handle
Eames_House_Project Yengyeon_Cho_14.net @ 91120201744 AM - Autodesk Revit Pr... 13,428 KB
Q Eames_House Project_Yongyeon_Cho_14-Purged.rvt 5 9/11/2020 1213 PM  Autodesk Revit Pr... 8,932 KB

(CO 2) Add/Edit Doors and Windows

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=100

Add a door on a Wall

+ [STEP 1] Click [Door] from the [Architecture] tab, under [Built] panel
or press [DR] as a shortcut
« [STEP 2] Select door type from the [Properties] palette.

o If you need to load a new type, click the [Modify/Place Door] tab and click [Load Family], Double click [Doors]
Folder, find out the family that you want from the sub-folders

o If you cannot find the door family that you want, you may search on various websites above and load into the
project file
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o If you found the type you want, but you do not find the size of the door, you click [Edit Type] and Duplicate the
type and change the values
« [STEP 3] Place the door near the wall. Use [Space bar] to change the direction of the door. It shows the location of the
door that will be placed. Click the location that you want.
+ [STEP 4] Once you placed the door, you can change the direction by clicking arrows, and you can change the exact
location of the door. Typically, the distance between the wall to the door is 4.”
. STEP 5] If you need to change the door type, click and change the type from the Properties panel

W notate  Analyze  Massing &iSite  Collsborate  View  Manage  Add-ns | Modty | Doo

@}@E I V8 5 W 7 ol @ B

U F@@@%Eﬁ BoOAN @ @ B a7 & A

dfy \ H ‘Wind \nw (Dmpunint (\ P of Ceiling F\ C rl ( rl in Mullio Rai \ ing Ramp  Stai M HM del  Model | Roor Ror nm Arﬁa Tag By Shaft Wall Vertical Dormer Grid Set Show Ref Viewer
B G| e e Area” Face Plane

Circulation Model Room & A Opening Datum Work Plane

T

Other
Head Height 70

-31/2"

I

Rl e o o e e e T

Complete to add all doors in the floor plans for the project

Add a window on a wall

+ [STEP 1] Click [Window] from the [Architecture] tab, under [Build] panel
or, press [WN] as a shortcut

+ [STEP 2] Select a window type from the [Properties] palette.

+ [STEP 3] Adding a window is the same sequence as adding a door.

+ [STEP 4] You can modify the sill height when you add a window.

The Eames House project doesn’t have a window.

Add a skylight on a roof

« [STEP 1] Click [Window] from the [Architecture] tab
or press [WN] as a shortcut

« [STEP 2] If you do not find a skylight from the [Properties] palette, click [Load family] > find the Skylight family under
the Window folder from the Revit library > click [Open]
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S Project Browser - Eames. House Proj
0] Views (all)
Floor Plans
Level 1
Level2
Roof
Site
Ceiling Plans
Level 1
Level2
Roof
3D Views
150-view-01
D)
Elevations (Building Elevation
East
North
South
West
Sections (Building Section)
Section 1
Section 2

Legends

3 Schedules/Quantities (all)
Sheets (all)

] Families

@] Groups

@ Revitlinks

+ [STEP 3] The Skylight for Eames House is 5X5’ Flat, so the type should be made by duplicating the existing one.
« [STEP 4] Open [3D view] > click the appropriate location where the skylight is supposed to be located > open [Roof]

view > update location of the skylight with dimensions

Modify| Windows | []Moves With Nearby Elements
Properties X | g (30} 5 [ Roof X [ Level 2
Siylight-Fiat 4 ° @
sx5 T ClLbii syl 4 n
Windows (1) v | £ EditType 8 &1 L v; 3
Constraints, a [ 7 T }
| — I
Moves With Nearby Ele.. [] N “
Identity Data 2 T ] s
Image f
Comments i
Mark i 1l s |
Phasing T
Phase Created New Construction |
Phase Demlished None e e L e
£Q o
|
f
i |
[
f
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¥ Project Browser - Eames House... X

A B0 Views (al)

Floor Plans
Level 1
Level 2
Roof
site

Ceiling Plans
Level 1
Level 2
Roof

3D Views
150-view-01

Elevations (Building Elevation
East
North
South
West

Sections (Building Section)
Section 1

Section 2
Legends

5 Schedules/Quantitis (al)
Sheets (all)

9] Fomilies

[&] Groups

= RevitLinks

« [STEP 5] You may notice that the skylight only opens the roof, not the ceilings you may make. You must make a hole to

open the ceilings. Click [Shaft] from the [Architecture] tab, under [Openning] panel > Open the plan below the roof

level. For Eames house, it is Level 2 > Draw the opening. It must be a little smaller than the skylight size and click the

[green checkmark]

+ [STEP 6] Make sure the base constraint is Level 2, and the Top constraint is Up to Level: Roof, Top Offset 1’ Relocate

the Skylight.
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Note. If [Shaft] tool is not working, please try this

« Click [Edit In-Place] > Click [Void Forms] > Select [Void Extrusion] from [Create] tab > Draw lines > click the [Green
checkmark] to finish and double-check the void penetrate

Add a door / a window on a curtain wall

+ [STEP 1] Adding a curtain wall door or window is not under the Door or Window from the [Architecture] tab. To
switch a panel to a door or a window, you must select the panel first by pressing the [Tab] key.

Anchitectre Stuctre Precsst et Annotate Anshyre Massng&Ste  Colborste View  Monsge  Addns | Modiy| CutainPonels | G-
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|
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ARR
5

+ [STEP 2] You might find the door from the [Properties] palette.

o If the curtain wall door was not loaded, you need to load the door first and then change the properties palette.
o To load the door family, click [Load Family] from the [Insert] tab
o Find “Door-Curtain-Wall-Single-Glass.rfa” from the Doors folder > Open
o Find “Curtain Wall-Awning.rfa” from the Windows folder > Open
o Find “Sliding_Curtain_Wall_Door_12253.rfa” from Canvas and download to your project folder > Open
+ [STEP 3] Change the type from the properties palette.
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Complete to update all curtainwall doors and curtainwall windows for the project

(CO 3) Add Tags

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=100

Add door and window tags

« [STEP 1] Click [Tag by Category] from the [Annotate] tab, under [Tag] panel
or (TG) for the shortcut
« [STEP 2] The Door tag setting can be made a distance (1/4”) from the door
[STEP 3] Once you click a door, the tag will show
+ [STEP 4] The number may show or may not show. If not, you can make a number
[STEP 5] You can also tag both the curtain wall door and windows with a door and window tag.
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Complete to update all tags for doors and windows for the project

(CO 4) Add/Edit Lighting fixtures

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=100

Load Lighting Fixtures

Load Lighting families by clicking Load Family. You can find Revit lighting families from Lighting > Architectural > Internal
folder from the Revit library. You can load all lighting fixtures from the folder or only selected lighting fixtures to your

project.

If you want a unique lighting fixture, please download it from various websites and save it in your project folder for future

use.

Add Lighting fixtures

+ [STEP 1] Open [Level 1] Ceiling plan from the [Project Browser]

« [STEP 2] Click [Component] (CM) to place lighting fixtures from the [Architecture] tab

+ [STEP 3] Select a family and a family type that you want to add on your ceiling plan. You can search the Lighting family
as well

« [STEP 4] Select [Downlight — Recessed Can]

« [STEP 5] Place the lighting fixture on the Utility room ceiling. You may need to switch the placement option. Does not
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need to be accurate.
+ [STEP 6] Make dimensions (DM) and use Align (AL) for the accurate dimension
To see the floor plan for the positioning of the furniture, Select Level 1 for Base Level, Leve 2 for Top-level, “lookup”

for Underlay orientation, and then you can see the floor plan on your ceiling plan for lighting layout.

View  Manage  Add-ins  Modify | Lighting Fixtures | G~

Insert  Annotate  Analyze  Massing &Site  Collabors

SN RS

e Stucture  Preca

X Kc

O Soe- =8 = " /=
% T O~ = 090 Rt Pick
« B OTaaxs J\ £ Family NewHost
Modity i ===
B et x B x
1 v o =

[SEP@EE

B

Complete lighting layout with dimensions on the ceiling plans

(CO 5) Add/Edit Titleblocks

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100

Create sheets

« [STEP 1] Click [Sheet] from the [view] tab, under [Sheet Composition] panel
« [STEP 2] New Sheet window will pop up to create sheets in your project. Click [Load...].
+ [STEP 3] The load Family browser will pop up. Find [Titleblocks] folder > Open [B 11 x 17 Horizontal] file > click [OK]

> Click [OK] to load on your project file.
+ [STEP 4] You can find your A101 — Unnamed on your project browser, once you click [+] mark next to [sheet (all)]
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[STEP 5] If you need more sheets for other views, you can click sheet] from the [View] tab, or you can click the Sheets

on Project Browser, and mouse right-click and select New Sheets
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[STEP 6] If you want to change the size of the sheet you already loaded, you can click the title block and change the

type on the Properties palette. You can change the Titleblock format that you already loaded

[STEP 7] On your Titleblock, you should add the project information and the sheet information.
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> Once you click the Titleblock, you can add more information. Do not double click. If you double click and open
the family file, you are editing the family file.

o Under the Owner, we would typically designate the client’s name. In this case, you can add ARTID263

o For Project Name, you can add your project name, Eames House Project

o For Unnamed, it typically designated for the Sheet name, for example, Floor Plan — Level 1, RCP - Level 2, Site
Plan, or more

o For Project number, you will make your own. I typically make 20.263.01 (Year.Course number.Project number)

o The issue date will be the submission date

o The author is your name

o Checker is your instructor’s name

Note. This Sheet information will not change even if you change the Titleblock type. And the Project name, Project number,
Client, and Issue date will not change even if you add new sheets. But you should add Drawn by and Checked by for all
sheets

Edit Titleblocks family file

« [STEP 1] Once you double click the Titleblock, the family file will open
+ [STEP 2] I recommend saving this family before you start to edit to preserve the original file.

> Do not forget to add “000” and save the file in your project family folder
+ [STEP 3] You can delete anything in the document. However, I would delete the Autodesk Logo, a line below, and the
website information.
STEP 4] You can add lines by clicking [Line] from the [Create] tab
STEP 5] You can move lines and text box by clicking the elements that you want to move and move (MO) command
STEP 6] You can edit lines and text box size as well

[
[
[
[
[STEP 8] Once you complete your titleblock, you must save and click [Load into Project]
[

]
]
STEP 7] You can insert images or CAD files by clicking Image or Import CAD from the Insert tab
]
]

STEP 9] After you load the titleblock into your project, you must change the titleblock type to what you made.
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(CO 6) Insert Plan views and symbols — North arrow and graphic scale

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100

Insert plans

« [STEP 1] Open a sheet [A101-Floor Plan-Level 1] to insert a plan
« [STEP 2] Find the view on your project browser to insert, drag and drop the view to the sheet
+ [STEP 3] To fit into the Titleblock, you must change your drawing scale. You can double click and change the scale, or

you can change the scale from the Properties palette
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« [STEP 4] Move the view to be centered and change the length of the title bar to fit into the Titleblocks
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Repeat this for site plan, floor plans, and ceiling plans

Insert north arrow

+ [STEP 1] The north arrow is under Symbol from the [Annotate] tab
+ [STEP 2] To add the north arrow, you will open a plan view
« [STEP 3] On the Properties palette, Orientation should be changed from Project North to True North
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+ [STEP 4] Click Symbol from Annotate tab

+ [STEP 5] Select North Arrow 2 on the Properties palette. If you cannot find North Arrow 2, you need to load the
North Arrow family from the Annotation folder

+ [STEP 6] Place the North Arrow 2 on your plan view
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Repeat this for site plan, floor plans, and ceiling plans
SAVE the file before closing the application.
Save in a different location for the backup (e.g., a cloud folder)
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Chapter 15. Add/edit model-in-place
components & edit family

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit Furniture families
(CO 2) Add/Edit Model-in-place components — Custom casework
(CO 3) Add/Edit a New Family — Furniture

* Session Highlights

At the end of the session, students can create the graphics below.

4
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E.’ Lecture Contents

(CO 1) Add/Edit Furniture families

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=102

For construction documents in Revit, furniture can be mainly categorized into two main areas. One is a product, which
includes custom furniture and manufacture-made furniture, and the other is a contractor (carpenter) made built-in furniture
or millwork.

+  We typically use [PLACE COMPONENTS] a Revit family for custom furniture and manufacture-made furniture
because it will be used multiple times. It includes millwork like Revit Countertop, Shelf, Cabinets, and so on.

+  We typically use MODEL-IN-PLACE] for contractor made built-in furniture or millwork because it will be used only
once for the specific space only.

Revit Furniture  [PLACE COMPONENTS]

+ [STEP 1] Open a Floor Plan — Level 1 view from Project Browser

« [STEP 2] You may change the scale of the view because we changed the drawing scale to fit on an 11in X 17 in sheet.
changed the drawing scale from 3/32” to 3/16”

+ [STEP 3] Chck [COMPONENTS] (CM) from [ARCHITECTURE] tab

[ Architecture  Structure

4] 3

Modify| Wall - Door Windo,

set  Annotate  Analyze  Massing &Site  Collaborate  View Manage  Add-ns  Modify @+

I FPEEEE @0@.@1&@@@@! g SRS
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- A402- RCP - Level 1
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ot Groupe

&5 Revit Links
I

| v | o |

000 $EF Oz(ge

Mo clip

— @

Fioor Plan - Level 1

+ [STEP 4] You will find furniture (or any components-lighting fixture, plumbing, case work-sink, appliances, plants)
from [Properties] palette that you want to put in the floor plan. If you do not find the furniture from the panel, you

must click [LOAD FAMILY] from the [MODIFY/PLACE COMPONENT] tab and find the furniture family you want
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to add from the Library folder or the websites from Session 14

o BimObject https://www.bimobject.com/en-us

o Revit City https://www.revitcity.com/index.php

o BIM Smith https://market.bimsmith.com/

o NBS National BIM Library https://www.nationalbimlibrary.com/en/

o Manufacturers’ website

TIPS.

For your Floor plan, you do not need to find the exact furniture that you want to use. You may use the Revit furniture family
for your floor plan as a placeholder. Do not waste time to add all objects (like books, decorative pieces for perspectives) that
are not showing on your floor plan. For your perspective views and renderings, it would be better to find the most accurate
Revit family file. If you cannot find the Revit family file, find the SketchUp file and use it for your rendering.

« [STEP 5] Place the furniture families on your floor plan. Make sure the Level is what you want.
« [STEP 6] Use [Space bar] on your keyboard to rotate the family.
To move/rotate/align/copy/mirror the furniture, click the furniture that you want to move/rotate and then click
[MOVE] (MO), [ROTATE] (RO), [align] (AL), [COPY] (CO), or [MIRROR] (MM) from [MODIFY/FURNITURE] tab
« [STEP 7] Also, you can use [ALIGNED DIMENSION] (DI) from the [ANNOTATION] tab

Properties X | [B Level1 X [ Level 2 3 Levelt

e 7'-33/4" 7'-33/4" 7'-33/4"
11/16 o - avl ia/\'\,;f*z Voa - S ﬁjq R S

w

| A=

WH
/|
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N
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@ Groups
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+ Complete all furniture placement
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(CO 2) Add/Edit Model-in-place components — Custom casework
A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=102
Create Model in Place components (Alcove seating)
+ [STEP 1] Open a Floor Plan - Level 1 view from Project Browser
« [STEP 2] You may turn on the reference CAD plan/Imported image to see the size of the Alcove setting or turn on
[HIDDEN ELEMENTS] if it is hidden and unhide the category
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« [STEP 3] Click Component small black arrow and click [MODEL IN PLACE] from [ARCHITECTURE] tab
+ [STEP 4] You will need to select the most relevant Family Category. For the Alcove Seating, [CASEWORK] is the most
appropriate category. Click [OK]

+ [STEP 5] make a name for the component [Alcove seating].
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+ [STEP 6] To draw lines/models, you must set/confirm the [WORK PLANE] first

o Click [SET] from [CREATE] tab

> You can select the work plane with the name or pick a plan.
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« [STEP 6] You can make models with the Forms tool
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Cancel

> For the alcove seating, click [EXTRUSION] and draw lines with the [DRAW] tool
o The line must be closed. You may use [TRIM] (TR) to make it closed

o Double-check the Extrusion End and Extrusion Start

o Click the [GREEN CHECKMARK] to finish the drawing
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o For the upper part, you will create the upper part in the current [MODEL-IN PLACE COMPONENT]

o If you want to try other Forms, you are welcome to try and practice.
o Use the [VOID] tool and Cut tool to subtract a form from other forms (s)

o Click Extrusion > Draw lines > make sure the extrusion End and Start > Click [GREEN CHECKMARK]

o If the model is not showing, please check on your ISO view and change the WORK PLANE]
o Once all forms created, you will click the [GREEN CHECKMARK] to Finish Model
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(CO 3) Add/Edit a New Family — Furniture

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=102

In this tutorial, I will demonstrate how to create a simple furniture family in Revit. We will use Eames Walnut Stool
information from https://www.hermanmiller.com/products/seating/stools/eames-walnut-stools/

To create a new family file (Model it will be used multiple times)

« [STEP 1] Click [FILE] > [NEW] > [FAMILY]
«+ [STEP 2] Find [Furniture.rft] in the Select Template File browser and Click [OPEN]
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[STEP 3] It will automatically open these four windows. Before you start, save the family file to your project folder.
[STEP 4] I recommend you make the view tile (WT) and Zoom All (ZA) see all views. You will pick a view

[REFERENCE LEVEL], or [FRONT] view depends on what you want to make.
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Click to select, TAB for altemates, CTRL adds, SHIFT unselects.

[STEP 5] To draw the stool, you will use [REVOLVE] to draw this stool
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[STEP 6] Before you draw a revolving line, you will need [REFERENCE PLANES] to know the Height and Width.

Click [REFERENCE PLANE] from the [CREATE] tab
[STEP 7] Draw height left, and right reference plane and dimension it
Dimension information from this page
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Click to select, TAB for altemates, CTRL adds, SHIFT unselects.
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[STEP 8] On [FRONT] view, Click [REVOLVE] from the [CREATE] tab
[STEP 9] Draw lines for the Profile (Boundary). The lines are to be closed
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[STEP 10] Select [AXIS LINE] and pick the centerline
[STEP 11] Click the [ GREEN CHECKMARK] to finish the model
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STEP 12] If you want to add/subtract any model, you can create it in this model
STEP 13] Once all your model works are done, save the family file on your project folder.

« [STEP 14] Click [LOAD INTO PROJECT] to your project.
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Note. Use Sketchup Model in Revit
Importing SketchUp Files into Revit Tutorial

& = B Main Model

If you want your Sketchup file in multiple-use, you should make it as a family file.
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Sketchup material will not be followed and merged as one material, but I will demonstrate some tips in the next session.

Refer to this video

Revit Architecture | Convert SketchUp Models Into Revit(With Materials)
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SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Chapter 16. Add/edit elevation, section, detalil,
text, annotation, & rooms

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Add/Edit Elevations & Sections — Adjust crop region
(CO 2) Add/Edit Detail views

(CO 3) Add Texts & Annotations

(CO 4) Add/Edit Rooms, Room tags, Room separators

(CO 5) Add/Edit a color fill scheme

L 4 Session Highlights

At the end of the session, students can create the graphics below.
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E.’Lecture Contents

(CO 1) Add/Edit Elevations & Sections — Adjust crop region

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=104

You can create sections or elevations in any floor plans.

To add an interior elevation

[STEP 1] Open the project, and open [Level 1] floor plan
+ [STEP 2] Click [Elevation] from [View] tab, under [Create] panel

[STEP 3] Click the [Properties] palette > select Interior Elevation, the symbol will be updated.

[STEP 4] Hover over your plan. You will notice the elevation marker will “snap” parallel to walls. Please select the
location where you want to place your elevation and click to set it in place. Press [Esc] to complete the command
« [STEP 5] Select the elevation tag. You can create additional elevations from one elevation symbol. Press [Esc] to

complete the command

B of D o £ Matchine =
if ~
Revisions

=3 View Reference
B Switch

e Legends Schedules Scope Sheet
- - Box Windows

Sheet Composition

+ [STEP 6] Select the elevation arrow (black filled) to adjust the crop region and view depth by moving the blue line; you

can adjust where the elevation view begins. By adjusting the blue nodes on the line, you can define the crop region.
Moreover, by moving the arrows, you can adjust the view depth of the elevation.
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+ [STEP 7] Once your elevation is defined, double click on the arrow of the elevation symbol > the newly created

elevation view will be open. You may realize the current view is not what you want to present. If the view shows right,

please skip [STEP 8] and [STEP 9]
« [STEP 8]Click the edge of the elevation > click [Edit Crop]
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« [STEP 9] Redraw the boundary of the elevation. The boundary must be a closed-loop > Click [Green check-mark] to

finish the crop boundary.
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[STEP 10] Make sure you check all three [Crop view], [Crop Region Visible], and [Annotation Crop] on [Properties]

palette.

Note. The solid blue defines the visible region, and the dashed line defines where your annotations can be viewed and

placed. Additionally, you can continue to adjust their view ranges by clicking on the nodes.

Elevations (Interior Elevation)
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[STEP 11] Add a sheet for the elevation by mouse right-clicking and clicking [New Sheet] on Sheets(all) from [Project
Browser] > Select 11x17 titleblock page that you created > Rename the sheet — Sheet number [A601], Sheet name —

Interior Elevation > Once the empty sheet is open > Drag the elevation view from [Project Browser] to the sheet >

Rename the view title [E-LIVING-N] > Then you can see the elevation symbol name and view name updated on the

floor plan
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+ [STEP 12] Usually, we want to show the boundary of elevation in a bold line. On your sheet, add [Detail Line] from
[Annotation] tab, under [Detail] panel, or type [DL] > Select [Wide Lines] from [Modify] tab, under [Line Styles] > Trace
the boundary lines
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Click to select, TAB for altemates, CTRL adds, SHIFT unselects. & 0

To add a section view

« [STEP 1] You will use similar steps to create section views
« [STEP 2] Click [Section] from [View] tab, under [Create] panel
+ [STEP 3] Draw a section line by clicking two points, then you can change the view direction and boundary of the view

231 | Revit Session 9



—
I3

Modiy|

Select ~ Properties

Properties

Structure

Clipboard

Precast Insert Annofate  Analyze

2 Ko B8 Py g ) b
3O

O Son- 8
Y Sen- 2

Geometry.

X [} A6O1 - Interior Elevation

Section .|
Building Section

Views (1) | 63 editType
Graphics 2
View Scale i

Scale Value T &

Display Model Normal

Detail Level Coarse

Parts Visibilty Show Original
Visibilty/Graphics Overr. Edit

Graphic Display Gptions Edit

Hide at scales coarser th.. 3/16" = 1-0"

Massing & Site

Coiabar v renage N Adne

n om Q- @ —

D A SRl

Blu = a-a

2 x - Lo
=

) tevel1 Bz x|0 Sectiont

Modify| Views (D«

[
Sze  Spit
Crop Segment

Reference Crop  Section

5. Floor Plans.

5 Ceiling Plans
Level 1
Level 2
Roof

b

5 3DViews
150-view-01
&0}

- Elevations (Building Elevation

Immn P
Show HiddenLines By Discipline : o | North
Color Scheme Location  Background ‘ B @ ‘iju(h

= est
e JEITTT Jﬁ -} <[ S

ault Analysis Display . None =

Sun Path 0 @ ELVINGN
Extents. 4 ABOY) I T2 | & Sections (Building Section)
Crop View e = N _ secton 1
Crop Region Visible E Legends
‘Annotation Crop U onl J i el Schedules/Quantites (al)
Fo i S S S 3 W e —— - e e
Far Clip Offset 10 8111/128" gy ] I ' BN St
Scope Bax None 1A w — @ - Floor Plan - Level
View Template <Nonex i - A401 - RCP - Level 2
View Name Section 1 | I | | | - A402 - RCP - Level 1
Dependency independent - AGOT - neirElevaton
Tile on Sheet ( T T ( -] Farilies

Referencing Sheet

Referencing Detail

Bhasing 3
Phase Filter Show All
Phase New Construction

D

[@] Groups
& Revit Links

« [STEP 4] Set a sheet for the section
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(CO 2) Add/Edit Detail views

visualgraphiccomm/?p=104

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

Add detailed views

« [STEP 1] Click [Callout] from [View] tab, under [Create] panel

Revit Session 9 | 232


https://iastate.pressbooks.pub/visualgraphiccomm/?p=104#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=104#pb-interactive-content

+ [STEP 2] Draw the boundary of a view on your floor plan > then [Level 2-Callout] will be automatically created under
[Floor plans] > Rename the view to [Level 2 — Restrooms] > If needed, update the scale
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+ [STEP 3] Create an elevation view and a section view on the detail view > add details > Update scales > Hide [elevation
symbol] on [Level 2] floor plan > Hide [Section symbol] on [Level 2 — Restrooms] detail view and [Level 2] floor plan
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« [STEP 4] Add the detail views to the sheet [A701-Restroom 1]
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(CO 3) Add Texts & Annotations

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=104

Annotation (Texts, Notes, and Dimensions) can be added to any views and sheets

In this tutorial, you will practice the [TEXT] tool to add texts and notes

« [STEP 1] Open a [view] from [sheet] by double-clicking the view > On the view, click [Text] from [Annotate] tab, under
[Text] panel > Select a text type from [Properties] panel > Drag and drop to make a text box > Add text
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+ [STEP 2] Add a leader line(s) by clicking the [Leader] icon from the [Modify] tab > adjust arrow direction and the leader

line
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(CO 4) Add/Edit Rooms, Room tags, Room separators

visualgraphiccomm/?p=104

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

Another useful annotation tool is creating, defining, and tagging rooms in Revit. Once you have walls, Revit recognizes the
walls as the boundary of the rooms. However, if you have unclear boundaries, you have to define room boundary by using

[Room Separator] first

Confirm room boundaries

+ [STEP 1] Click [Room] from [Architecture] tab, under [Room & Area] panel

« [STEP 2] Hover the mouse over the floor plan to find a closed room. You can confirm the boundaries by clicking

[Highlight Boundaries]
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« [STEP 3] Click [Close] to hide the highlighted boundaries

Define boundaries

« [STEP 1] To define boundaries, click [Room Separator] from [Architecture] tab, under [Room & Area] panel
+ [STEP 2] Using [Draw] tool to draw separated boundaries, then you can manually define boundaries.
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Create rooms

[STEP 1] Click [Room] from [Architecture] tab, under [Room & Area] panel
[STEP 2] Hover over each room and click once with the mouse to define the room boundary. You will see a tag that
reads [ROOM] and a [X] showing the extent of the room. Continue for each room.
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Edit tags

[STEP 1] Click a room tag (NAME) two times, then you can edit the room name. Click a room tag (NUMBER) two
times. Then you can edit the room number.

Note. If the rooms are located on the 1st floor, the number starts from 101. If the rooms are located on the 2nd floor,
the number starts from 201.

[STEP 2] Move the room tags outside of the room to avoid overlapping with model lines and the room names > Select
all room tags > Check [Leader Line] box > Move the room tags to the outside of the room
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(CO 5) Add/Edit a color fill scheme

visualgraphiccomm/?p=104

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

You can use the [color fill legend] to place rooms and spaces after adding rooms. Color coding plans can help the client

understand the relationship between public and private, work, and rest spaces.

Add a color fill legend

+ [STEP 1] Click a [room] on a floor plan > Add [PUBLIC], [SEMI-PRIVATE], or [PRIVATE] on [Department] from
[Properties] palette > If you already added one of the three options, you can select from the drop-down menu.
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[STEP 2] Repeat step 1 for all rooms

[STEP 3] Duplicate floor plans for only the color-filled plans by right-clicking a view > select [Duplicate view] > select
[Duplicate with Detailing] > Rename the copied views
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[STEP 4] Open the duplicated views > Click [Color Fill Legend] from [Annotate] tab, under [Color Fill] panel > Click on
a floor plan, then [Choose Space Type and Color Scheme] window will open > Confirm Space type: Room, Color
Scheme: Department > Click [OK] then the color-filled legend and color will show.
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Chapter 7. Add/edit views, lighting, &

materials

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Set perspective views

(CO 2) Set Isometric views

(CO 3) Edit Views — Graphic Display styles
(CO 4) Test Render

(CO 5) Set sun

(CO 6) Edit Artificial lighting

(CO 7) Add/Edit materials

(CO 8) Render material managements

£ & Session Highlights

At the end of the session, students can create the graphics below.
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E.’Lecture Contents

(CO 1) Set perspective views

visualgraphiccomm/?p=106

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

Revit supports perspective views and isometric views.

For more information about 3D views, please read this page

To create a camera view for a perspective view

« [STEP 1] Open a floor plan [Level 1] to create a camera view

+ [STEP 2] Click a drop down menu of [3D view] > [Camera view] from the [View] tab, under [Create] panel

+ [STEP 3] On the floor plan, click the location of the camera position, click the target position > The perspective view
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To reposition the camera view

- Ad02 - RCP -

« [STEP 1] In order to adjust the view, you will open the camera view that you would like to adjust and the floor plan

together. Type (WT) to see the tile view and type (ZA) to see zoom in all

+ [STEP 2] Click the frame of the perspective view > you can reposition by controlling the 3D wheel on the top-right

corner of the view and resize the camera view by adjusting the nodes

« [STEP 3] You can also change the camera position and the target position on your floor plan. On the Properties panel,

change eye elevation & Target elevation, turn off Far Clip Active, and view the name.
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Image-print size update for the perspective view

« [STEP 1] Click the view frame

+ [STEP 2] Click the [Size Crop] icon from the [Modify] tab

+ [STEP 3] On Crop Region Size window, check [Scale (locked proportions)]

« [STEP 4] Change the width of what you want to make, and then the height will automatically change with the view

ratio you made.

+ [STEP 5] If you want to change the proportion, you check the [Field of view] and change the proportion. Click Apply.
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« [STEP 6] Then again, check [Scale] to change the size of the view
« [STEP 7] Click [ok] to finish
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(CO 2) Set Isometric views

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=106

Set Isometric view

+ [STEP 1] To add an Isometric view, Click the drop-down menu of [3D view] from the [view] tab, under [Create] panel,
click [Default 3D view] > The Isometric view will pop up
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« [STEP 2] To edit the boundary of the view, Click the [section box] option on the [properties] palette
+ [STEP 3] Click the [section box] on the view > Drag the arrows toward the model to create a dynamic slice of the
model
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(CO 3) Edit Views — Graphic Display styles

visualgraphiccomm/?p=106

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

To set the graphic display styles

+ Once you click [Graphic Display] on the [view navigation] panel, click one of the six options, then you can change the

styles of graphic

Identity Data

View Template <None>
View Name {30}
Phasing
Phase Filter Show All
@ Graphic Display Options,
) Wireframe
EF Shaded
) Consistent Colors
&P Realistic
Properties help Apply 3= 10" P i <
Readv £ P}

+ Examples of the six graphic style preset
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- AT00 - Ste Plan
A101 - Floor Plan - Level T
A101-C- Color filled - Level 1
A102 - Floor Plan - Level 2
A102-C- Color filled - Level 2
A401 - RCP - Level 2
7402 - RCP - Level 1

5. ASO1 - Interior Section

- ABOT - Interior Elevation

- AT01 - Restroom 1
-] Families
e-[e] Groups

o RevitLinks

> i< >
LR 8= AN 7.0
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Wireframe & Hidden Line

Shaded & Consistent Colors

Realistic & Custom

ay Options

To modify Graphic Displ

]

iew navigation] panel > click [Graphic Display Options

on the [v

ay]

Graphic Displ

[

Modify the properties that are appropriate for your project

+ [STEP 1] Click

]

For a quick presentation, I like to use these settings

« [STEP2
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Select + Graphics

Properties

 wove g

30 View: (30} | G editype
Graphics 5
ViewScale £l

Scale Value T £

Detail Level Fine

Parts Visibilty Show Original

Visibility/Graphics Over. Edit,

Graphic Display Options Edit,

Discipiine Coordination

Show Hidden Lines By Discipiine

Default Analysis Display . None

Sun Path
Exents
Crop View

Crop Region Visible.

Annotation Crop

Far Ciip Active

Far Cip Offset

Scope Box None
Section Box
Camera
Rendering Settings Edit,
Locked Orientation
Projection Mode Orthographic
Eye Elevation 363 67/256
rEE
Camera Position Adjusting
Identity Data
View Template <None>
View Name o}
Dependency independent
Title on Sheet
Phasing
Phase Filter Show All
Phase New Construction
Bropetties help Apply
Ready.

Presentation

Create Sheet Composition Windows

=& = Project Browser - Eames_House.Pro
A | BG Views al)
Graphic Display Options x balliatn
Level1
. Level 1 - Color il
Level2
st v Level 2 - Color Fill
Show Edges Level2 - Restrooms
Roof
smooth lines with anti-sliasing Ste
Trarsparency: [ & Ceiling Plans
Level1
Shoueties: | <none> i
~ Shadows Roof
[cast shadons & 3DViews
Show Anbient Shadons 150-view-01
NSETTTe Perspective-Living-01
» Depth Cueing 5 Elevations (Builing Elevation
~ ligntng £ast
Exterior: Sun ol Sy
Scheme;  Exterior: Sun oy .
= West
un Settng: n-sesson, ghtng>
5 Elevations (Interor Elevation)
Artfical Lights: Artiicalight. ELVING-N
E-Restroom 1 - W
s 1 & Secons (aiding Section)
S-Restroom 1 -W
Ambient Light:
Shadons: 1 Legends
{3 Schedules/Quantites (al)
O B Sheets (al)
~ Background A100- Site Plan
A101 - Floor Plan - Level 1
Badoround: (sl 2 A101-C - Color filled - Level 1
svcie: R A102 - Floor Plan - Level 2
A102-C - Color flled - Level 2
Horizon Color: [ RGe 242:242:242 A401 - RCP - Level 2.
A402 - RCP - Level 1
Ground Cobr: [RGB 165-165-165 s R
A0 - Interior Elevation
Save 25 View Tenpiate. ATO1 - Restroom 1
g
How do these settings affectview araphics? & Families
] Groups
oK Cancel Aoply o RevitLinks
v
3= 107 BBk G Go FRF 63D 0 (& IE < 5 43 >

0 fain Model

bl

« [STEP 3] Click [Apply] to confirm what you changed, click [Ok] to set the style

(CO 4) Test Render

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=106

To do a test render, you need to adjust the render settings

« [STEP 1] Click [Render] from the [View] tab, under [Presentation]
or Click [Rendering Dialog] on the [view navigation] panel
+ [STEP 2] Adjust settings

o Confirm Setting — Draft for a test render

o Change Lighting scheme - interior for an interior scene

o Change Sun Setting — Sun and Artificial

o Change Background style

o Click [adjust Exposure] if needed
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e - T e

Select ~ Graphics

Properties

® o

ETE [CJRregion
Quality

Output Settings

Oprinter 96 0PL |

Wiidth: 1023 pixels

Presentation

Height: 666 pixels
Uncompressed image size: 2.6 M8
Lighting

scheme: ([it=ror: Sun nd Artiaal -
Sun Setting: [ <in-session, Lighting>|

Artifcal Lights.
Background
Style: [Sky: No Clouds 5
Image
| Adiust Exposure,
Save to Project Export.
Display

Show the model

Properties help Apply

Exposure Control

Spoare ke
e
- 1
-
Wtz
Reset =

Learn about exposure control options

il

perspecive B 9% T KR o B <

Click to select, TAB for altemates, CTRL adds, SHIFT unselects.

(=N

Create

Sheet Composition

Windows

= Project Browser - Eames_ House_Proj.
~ | B0 Views ()
Floor Plans
Level 1
Level 1- Color il
Level2
Level 2 - Color il
Level 2 - Restrooms
Roof
Site:
Celling Plans
Level 1
Level2
Roof
3D Views
1S0-view-01
1S0-view-02
Perspective-Living-01
Elevations (Building Elevation
East
North
South
West
Elevations (Inerior Elevation)
ELVINGN
E-Restroom 1-W
Sections (Building Section)
S-Restroom 1 - W
SECTION A-A"
Legends
Schedules/Quantities (o)
Sheets (all)
A100 - Site Plan
A101 - Floor Plan - Level T
A101-C- Colorfilld - Level 1
A102 - Floor lan - Level 2
A102-C - Colorfilld - Level 2
A40T-RCP - Level 2
A402 - RCP - Level 1
AS01 - Interor Section
A601 - Interor Elevation
AT01 - Restroom 1
9] Families
@] Groups
o Revit Links

el

> >

TR L S0

« [STEP 3] Click Render to see the result. You can stop if it shows all right, you do not need to wait until the completion.

(CO5) Set sun

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106

Setting Sun

STEP 1
STEP 2
STEP 3
STEP 4

[ W/ B s B Y

Click [Sun Path] On > Click [Shadow] On
Click Sun Settings to adjust sun direction
Select Still for a specific time

Change Display setting to Realistic or Render to see the sun direction and material
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Uncompressed image size: 2.6M8
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Scheme: | Interior: Sun and Artfical v

Sun Setting: [ ED Save Settngs
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Lz E-Restroom 1 -W
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S-Restroom 1 -W

SECTION A4
Legends
{5 Schedules/Quantites (al)
D Sheets (al)

Badkground
Style: | Sky: No Clouds v

Image
AT01 - Floor Plan - Level 1
A101-C - Color filed - Level 1
A102 - Floor Plan - Level 2
A102-C - Color filed - Level 2
A4O1 - RCP - Level 2

A402 - RCP - Level 1

AS01 - Iterior Section

ABO1 - Interior Elevation
AT01 - Restroom 1

2] Families

@ Groups

@ RevitLinks

| Adust Exposure,
Save toProject. ot

Display

Show the rendering

Propetties help Aoy | perspectve E TR G 0 I E < ) 2

<
Ready & “Fo B3 Visin Model % 4% 5 OF & Yo

(CO 6) Edit Artificial lighting

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=106

Review the default lighting setting

+ [STEP 1] To see an accurate lighting setting, change the render setting to [Interior: Artificial only] and [High] quality
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Properties &l @ x |[@ = @ = Project Browser - Eames_House Proj
A B0 Views (al)
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Level 1 - Color il
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Graphics %

Detail Level fFine

s Vit Sters e Render | Clregon | w0

Visilty,Graphics Overr i Qualty AvtfcalLghts “
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Do O T e Level30.00%)of 10

Su Bath Resoluton: @ sceen [ Warrings:

Exents 3 Oprnter | sa001 [ Close dilog when rendering s complete

Crop View

Crop Region Viible Vidth: 1029 pixels

e ] Helght: 666 pixels Perspective-Living-01
Far Cip Offset Uncompressed mage size: 2,648 Elevations (Building Elevation

Scope Box

Lightn o
Section Box i North
West
Rendering Settings Edit Sun Setiing
[ocked Orientation = = Elevations (Interior Elevation)
ELVINGN

Projection Mode Perspective Artfidal Lights
50

Eye Elevation E-Restroom 1- W

o saciground Sections (Building Section)
Cemeab it Eoict Ste: [y No Clouds S S-Restroom 1 - W
Identity Data A " jf‘c"‘ A
View Template <None> Pal—
View Nome Perspective-Living-01 chedules/Quantites (o
Bependency \nd:pzndzn( . 2B sheets (al)
Tile on Sheet Image A100- Site Plan
A101 - Foor Plan - Level 1
Phasing 5 AdustExposure.
A101-C- Colorfilled - Level
Phse Fiter Show Al
= e Save toProfct Bt 102 Floor Plan - Level 2
A102:C- Colorilled - Level 2
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+ [STEP 2] Open Visibility/Graphics Overrides, or type [VV] for 3D view
« [STEP 3] Turn on Lighting Source to see the light source

[T Achitecture  Structure  Precast Insert  Annotate  Analyze  Messing &Site  Collaborate  View  Manage  Add-lns  Modify (3~
f

. Iy
Select ~ Properties  Clipboard Geometry Mty View  Messure  Create
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Detail tems O [y View Roof
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o Duct Placeholders OBy View o 3D Views
Ducts OBy View 150-view-01
Electrical Equipment O [y View 150-view-02
Electrical Fixtures O ey View Perspective-Living-01
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ahing Devices al & Sections (Building Section)
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“<Hidden Lines> SECTION A-A
E)u T Source Legends
PIL_Graphics 3 Schedules/Quanites al)
PIL Lighting Fistu D) Sheets al)
Lines ] A100- Site Plan
o O Mass 5] A101 - Fioor Plan - Leve 1
Mechanical Equipment 5] A101-C- Color flled - Level
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Override st Layers 601 - InteriorElevation
&y e =g [CutLine Styles = ATO1 - Restroom 1
. 2] Famil
Categores that re not overidden are raun = g
according to Gbject Sty setings. Objectstys. @] Groups
o Revitlinks
o | = ke o

Ready 0 fain M

Lighting setting

« [STEP 1] Click the lighting fixture that you want to modify

+ [STEP 2] Click Edit Type > Click Duplicate and name the new type

« [STEP 3] Modify Photometrics [initial intensity] > I recommend to adjust the value of [[lluminance] and [at a distance
of]
Please refer to this page for the recommended lighting level (Lux) for activities Repeat this step for all other lighting
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« [STEP 4] Test render to see if the light fixtures are at the right setting.
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. Recessed indirect lighting

o Recessed Ceiling with Light in Revit * Light Tutorial *
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(CO 7) Add/Edit materials

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=106

Apply materials in Family type

STEP 1] Click an object that you want to add or change materials
STEP 2] Click [Edit Type] to change Materials and Finishes
STEP 3] Duplicate if needed

STEP 4] Click Material Value (Not all objects have this option, but many family files do this option) to add or modify
the material. Then Material Browser will pop up

Architecture  Structure  Precast  Insert  Annotate  Analyze  Massing &Site  Collaborate  View Manage  Add-Ins  Modify | Fumiture 3+

.
— o

o~
Select + Properties  Clipboard Geometry Modify View Messure  Creste  Mode Host
[IMoves With Nearby Elements
Properes 5 ® x|@ [ 2 rojec Browser - Eames_House P
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Phase Created New Construction Wood Backing 3233 Smoked Ok { Leather - Black | | Perspe ing-0°
Phase Demolished None Identity Data % 5 Elevations (Builing Elevation
Type Image East
Keynote North
Model South

West
- Hlevations (Interior Elevation)
ELVING-N

Show the rendering

« [STEP 5] If you already made a material you want to use, please select the material and click ok to finish
+ [STEP 6] If you want to make a new material, click Create New Material
« [STEP 7] Mouse right-click and click to [Rename] the new material [Ex. 000-FB-01-White]
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+ [STEP 8] You can change Identity, Graphics, and Appearance. To add material from Revit Library, click Appearance,

Click [Replace] this Asset. Asset Browser will pop up
+ [STEP 9] Search a material from Appearance Library
« [STEP 10] Click a replace icon
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<<Prevew oK Cancel Apply

[ savemmoRct [ Eport

Display

« [STEP 11] Click Information, name change if this is a unique material

+ [STEP 10] Click ok to apply

&

Painting materials (For Walls, Floors, and Ceilings)

+ [STEP 1] To use [Paint] tool, click [Paint] from the [Modify] tab

+ [STEP 2] Click a material that you want to use from Material Browser. If you do not find the material that you want to

Cance

use in the Material Browser, you must add a new material first and then apply the paint tool
+ [STEP 3] Click a face that you want to change, use the Tab key to select right face
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[STEP 4] You also can remove the paint material by using the Remove Paint tool
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[STEP 5] Use [Split Face] (If the surface needs to be separated), Click [Split Face] from [Modify] tab

[STEP 6] Click the elements (Wall, Floor, Ceiling) you want to split face. You may need to use the TAB key to select the
elements

[STEP 7] Draw a closed line to divide the surface. You may need to open an elevation view, a floor plan, or a ceiling
plan to draw the lines.
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« [STEP 8] Click Green checkmark to finish
« [STEP 9] Then use the Paint tool to apply the material
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Decal (Flat Surface — Carpet or pictures)

+ [STEP 1] To create Decal, click Decal Types from the Insert tab
« [STEP 2] Please create a new Decal, Name it, insert the image, and click ok
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+ [STEP 3] To place a Decal, Click Place Decal from the insert tab

[STEP 4] Place on a surface
[STEP 5] Change size and location from views
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(CO 8) Render material managements

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=106
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Manage material

+ [STEP 1] Click [Materials] from [Manage] tab
« [STEP 2] In this [Material Browser], you can add and modify materials

Architecture  Structure  Precast Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =

i 14y E 0 F %
4 % o) =
5 n o 2 s
Medify Frnaps  Project Project Shared Global Transfer Purge Project Structural | Additional _ Location Design
Information Parameters Parameters Parameters Project Standards Unused  Units Settings Settings T N Options Main Model
Select = Settings Project Location Design Options
Properties X [ Level1 ¥ Perspective-Living-01 X [ Level 1 i 150-view-02

@ 3D View -
« [STEP 3] If you need to apply an imported object (CAD or Sketchup), use [Object Styles]

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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Autodesk.Help. (2019, November 17). 3D Views. Retrieved October 22, 2020, from https://knowledge.autodesk.com/
support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/Revit-DocumentPresent/files/ GUID-
B3354433-8ED8-4DA7-8078-C2514195BEB5-htm.html

Airfal. (2014, January 15). Recommended light levels for common types of working activities. Retrieved October 23,
2020, from https://www.airfal.com/en/industrial-lighting/recommended-light-levels-common-types-of-working-
activities-2875/

Balkan Architect. (2018, January 3). Recessed Ceiling with Light in Revit * Light Tutorial*. Retrieved October 23, 2020, from
https://www.youtube.com/watch?v=4VFK-KEOMZc
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Chapter 18. Create Revit rendering, Revit

clouding rendering

@ Session Objectives

Upon completing this session, students will be able to:

(CO 1) Insert other types of files — Sketchup, AutoCAD
(CO 2) Advanced render settings

(CO 3) Edit render qualities

(CO 4) Understand and make cloud renderings

(CO 5) Save Rendering outputs

£ & Session Highlights

At the end of the session, students can create the graphics below.
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E? Lecture Contents

(CO 1) Insert other types of files — Sketchup, AutoCAD

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=108

Although many manufactures provide Revit Family and Revit also provide numerous libraries, designers always seek new
models and objects for their design and renderings. Sketchup 3D Warehouse provides a great library from designers and
manufacturers. [ added three Video tutorials to import the Sketchup model to Revit Family for your reference. You may try.

+ Sketchup Model to Revit
Importing SketchUp Files into Revit Tutorial

+ Sketchup Model to Revit — Material changes
Revit Architecture | Convert SketchUp Models Into Revit(With Materials)

« Complex 3D max Model to Revit — Hide the complex model lines in Revit (Super advanced level)
AMAZING REVIT 1 - FROM 3DS MAX TO REVIT WITHOUT VIEWING TRIANGLES EDGES

Sketchup model to Revit with updating material changes

+ [STEP 1] Sketchup Model to DXF file

o Open the Sketchup model in Sketchup, or your download the furniture model from a 3D warehouse. In this
process, you may need Sketchup Pro.

o Create layers by material. If you have 3 materials, create 3 layers with unique names (e.g. 000_Chair_sk_seat_01,
000_Chair_sk_leg_01, 000_Chair_sk_base_01)

o The entire model until there is nothing left to explode.

File Edit View Camera Draw Tools Window Bxtensions Help
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U ® @ | Explode the group or component into its constituent objects.
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Modeling credit: Vojislav N. downloaded from 3D warehouse

Select one material > Mouse right click and Select > All with the same material
File Edit View Camera Draw Tools Window Extensions Help
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7 ® @ | select everything with the same material as the selected entities.

Modeling credit: Vojislav N. downloaded from 3D warehouse

Change layer in [Entity Info] Tray by selecting the desired layer that you previously made
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Measurement ts

7 ® @ | select objects. Shift to extend select. Drag mouse to select multiple.

Modeling credit: Vojislav N. downloaded from 3D warehouse

Do the same procedure (material selection and layer change) for the other materials
Export > 3D model > Select DXF file > Click option > Select only Faces > Version 2007> OK > Export
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Modeling credit: Vojislav N. downloaded from 3D warehouse
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« [STEP 2] DXF file Properties change
o Open AutoCAD
> Open the DXEF file in AutoCAD. It will show in a 3D view
o Select all lines by pressing [Ctrl+A]
o Change Object color from [Home] tab > Color [By Layer]
o Save the DXF file with Version 2007
-] Hore R T e e
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[STEP 3] Import DWF file (Furniture) to Revit

o File > New > Family > Select Family Template file (Furniture)
o Insert tab > Import CAD > Change files of type to DXF > Select the file > Click [Open] > Save the family file > Load
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+ [STEP 4] Change materials for an imported file in the Revit project file
o Manage tab > Object Style
o Click Imported objects
o Change material by clicking the material slot
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(CO 2) Advanced render settings

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=108

Region renders

The Region render function saves time while rendering

+ [STEP 1] Check Region on Render Setting
+ [STEP 2] You will see RED square on the perspective view. You can adjust the box that you wish to render
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Saye to Project Export
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 0 Aain Model

il

Output Settings

The default setting is Screen, which shows the entire screen size. If you need a perspective view for presentations or print,

your rendering size should be a different setting

« [STEP 1] Click Print on Render Settings
+ [STEP 2] Change the resolution

o 75 DPI - Screen presentation
o 150 DPI — Regular print size
o 300 DPI - Fine print size
o 600 DPI — Not used
+ [STEP 3] If you need to change image size, you can adjust the width and height on Crop Region Size
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Render image

+ [STEP 1] After your rendering process is done, you can save the image in the Revit project file for your future use. You
can find the saved rendering under the project browser by clicking [Save to Project] on the [Rendering settings]
window. You can include the rendered images on the sheets with a titleblock.
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« [STEP 2] You can save the rendering with different formats by clicking [Export] under the image on [Render settings].
Typically, save JPG for photoshopping.

Render Background

+ [STEP 1] You can add a background for your render [background]

o The default setting can be Revit Sky, which can correspond with a specific date and time.

o You are also able to add an image as a background.

> You can set as a Transparent image. The file type must be PNG or TIFF file to save a transparent image for the
background.

(CO 3) Edit render qualities

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=108
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Change the render quality

+ Draft - for a test render, but not recommended, because of lighting quality, reflection, bump, and refraction on
finishesDraft-Render time 1min
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+ Best — Although it produces the best quality, it is not recommended due to rendering time. Best-Render time 2hrs
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(CO 4) Understand and make Cloud Renderings

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=108

Cloud rendering

Autodesk provides users with Cloud rendering. Design firms have great hardware to quickly render but Autodesk also

provides its servers for rendering. The render quality is a bit better and faster than Revit rendering. Cloud rendering is a

paid service, however, for educational purposes, it is offered for free.

« [STEP 1] Once your render settings are what you want to produce, click [Render in Cloud] from [View] tab, under

[Presentation] panel
[STEP 2] If you are a first time user of Cloud Render, you must Sign-in to an Autodesk account (email, PW, text code
required)

+ [STEP 3] Double-check your view name, output type (Still image), Render Quality, Image Size, Exposure
+ [STEP 4] Click email when complete
« [STEP 5] Click Render

e e - e

Select ~ Graphics s presentaton Create Windows
Properties A =] x = Project Browser - Eames House Project Yongyeon....
S Level 1 -Color Fill
3oV Level 2
= Level 2 - Color Fill
Level 2 - Restrooms.
3D View: Perspective-Living-01 | B EditType =k
E 3 EE Render in Cloud HO | LEFT Site
Graphics A
Detail Level Fin {\ AUTODESK. RENDERING & Ceiling Plans.
Parts Visibility S Renderin Cloud ¢ i Level 1
Visibility/Graphics Over. Select 3D views to render in the Cloud Level 2
Graphic Display Options Welcome to Rendering in the Cloud for Revit 2021 Roof
i i Ar 3D View | Perspective-Living-01 & 3D Views.
iscipline ] A
Default Analysis Display .. No{ - To begin renderingin the cloud: Output Type | Stil Image -0 B0 vinw: 01
Sun Path - 1S0-view-02
Extents % Step1 Render Quality | Standard R Perspective-Living-01
rop View - Elevations (Building Elevation)
Coel On select 3D views and Image Size | Medium (1 Mega Pixel) o
Crop Region Visible 2
Far Clip Active Exposure | Advanced A North
5 South
Far Ciip Offset 53
Step2
Scope Box ot 4 West
Section Bax m) The service will notify you when your images are ready. - Elevations (Interior Elevation)
Camera E-LIVING-N
Rendering Settings E-Restroom 1 - W
Locked Orientation 090 step3 - Sections (Building Section)
Projection Mode bl IRH o iew > Rence Gty toview, downond, o o more withyour S-Restroom 1 - W
Eye Elevation 5 completed renderings online. SECTION A-A'
Target Elevation 5 & Renderings
Camera Position Bl Perspective-Living-01_1
Identity Data PerspectiveLiving-01_2
Vew Termlste [bestooutsemmeattng Pespecive Liing 013
View Name Legends
Dependency 3 Schedules/Quantities (all)
Title on Sheet & B Sheets (al)
Phasing A100 - Site Plan
Phase Filter Show All /A101 - Floor Plan - Level 1
Phase New Construction A101-C - Color filled - Level 1

Broperties help

Apply perspective B G O O FF @2 0 ta &

Walls : Curtain Wall : Curtain Wall 1

<

A102 - Floor Plan - Level 2
A102-C - Color filled - Level 2
401 -RCP - Level 2

A402 - RCP - Level 1

A501 - Interior Section

A607 - Interior Elevation
AT01 - Restroom 1

A901 - Perspective - Living 1

) Families
o | @@l Groups

B @ Revit Links

fain Model

(CO 5) Save Cloud Rendering outputs

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=108
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Get rendering outputs

+ [STEP 1] Check the render results
« [STEP 2] Once you received the notification email, you can check the results in Render Gallery

Tl e v [ e

s x [ Level1
@ = .

3D View: Perspective-Living-01 | 63 EditType

Graphics A

DetailLevel Fine

Parts Visibilty Show Original

Visibilty/Graphics Overr. Edit.

+ [STEP 3] The Render Gallery website will open, click View Project
« [STEP 4] Click the rendered thumbnail image > Click [Post-Processing] to change expose level and color balance

Whit

om Amount

1
o«
-«
500
0
o

Bloom Width
ultiplier

image credit: Autodesk cloud rendering

+ [STEP 5] Click Download Icon > Click JPEG
+ [STEP 6] If you need Transparent Background (for photoshop), click PNG
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image credit: Autodesk cloud rendering

Revit rendering vs. Cloud rendering

cnghsh ~  {\ AUTODESK

Revit Rendering

Render time Longer
Hardware use Your hardware
Control — Image size Fully controllable

Control - Lighting Manual

Revit Cloud Rendering

Vary (shorter)

No hardware required
Few options

Automatic

SAVE the file before closing the application.

Save in a different location for the backup (e.g., a cloud folder)
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PART THREE. ENSCAPE

Chapter 19. Introduction of Enscape

+ Understand what is Enscape
« Control/navigate Enscape

+ Create views

+ Add model backgrounds

+ Add Entourages

+ Render images

Chapter 20. Edit Model and Materials

« Understand workflow, name of the material
« Use 3D Grass, Water, Reflective, textures
« Change to Architecture Maquette (White model, Outline) & Light mode

« Create Orthometric views

Chapter 21. Edit Lighting and Create Video

» Save, and load presets
+ Set and adjust artificial lightings
+ Create a walk-through video

Chapter 22. Edit Render outputs

« Export enlarged jpg files (Original, ID) for print
+ Create Executable file

+ Create Render Panorama image
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Chapter 19. Introduction to Enscape

@Session Obijectives

Upon completing this session, students will be able to:

(CO 1) Understand what is Enscape
(CO 2) Control/navigate Enscape
(CO 3) Create views

(CO 4) Add model backgrounds
(CO 5) Add Entourages

(CO 6) Render images

‘®: Session Highlights

At the end of the session, students can create the graphics below.
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(CO 1) Understand what Enscape is

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=110

Enscape is a commercial real-time rendering and virtual reality “plug-in” for Revit, Sketchup, Rhino, ArchiCAD, &

Vectorworks.

It is mainly used in the AEC industry and is developed and maintained by Enscape GmbH, founded in 2013 and based in
Karlsruhe, Germany.
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Enscape features. Information from: Enscape website

« [FEATURE 1] Real-time walk-through
CAYAS Architects was able to save 75% of their time to produce 3D visualizations by using Enscape
+ [FEATURE 2] Virtual Reality
“A key add-in for Revit and Rhino workflow through to VR” Forster+Partners
“Now, with Enscape, our clients are amazed with what we show them. They are able to actually experience their
project before it is even built. Enscape helps us to do a better job.” HMFH Architects
« [FEATURE 3] Export functions
“Design is always an iterative process, but Enscape has made it a dynamic one” Turner Fleischer

o Batch export
o 360-degree panorama
o Video exports
o Standalones — an EXE file
+ [FEATURE 4] Various visual settings

o Clouds and backgrounds
o Time of day change
o White model mode
o Light analysis mode
o Volume fog effects
> Depth of Field option
o Ortho views
o BIM information
« [FEATURE 5] Asset library — more than 1000 options

Other architectural rendering applications

« Vray

« Lumion 3D
» Twinmotion
« Corona

Read this article to learn more about other rendering applications in this link.

Download and install Enscape

+ [STEP 1] Request Enscape educational license form the link
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AN AL . .
E NSCAPE GALLERY  COMMUNITY  BUY  FREETRIL  VIDEOTUTORIALS  SUPPORT Your Educational License

IS
" Enscape <support@enscape3d.com> =
Student Lecturer University FAQ To Cho, Yongyeon [ARTIO]

PERSONAL DATA

Hi Yongyeon
. we're happy that you want to use Enscape. This is your educational license key:

1gEGAV3eHVy4790BAEDD1EL21AEBAFAATGj; 17,

It is valid for one semester - in other words 6 months.
Please download the installer via this link:

Download Enscape now

Don't hesitate to contact our support team if you have any questions.

Tl e Alternatively, you can also check our Forum , Blog or our Knowledgebase .
CAD PROGRAM Best,
D Revic Your Enscape Team
O seetenom
[ #nine <‘»
\:\ ArchicaD

. |
FUTURE CREATC

Enscape GmbH | Erbprinzenstrafe 27 | 76133 Karlsruhe | Germany
E student@enscapedd.com | P +49 721 132 060 60
D00 i

+ [STEP 2] Double click the downloaded Setup file.
« [STEP 3] Enscape requires four pre-installed programs, and you must install the necessary application (all free) to run

Enscape.

+ [STEP 4] In an advanced setup, you can install Enscape only for Revit.
If you would like to use Enscape Sketchup and Revit, you can select all (Default setting).

+ [STEP 5] Once the installation process is completed, open Revit. Note. Enscape is not stand-alone software. Enscape is
a plug-in application in Revit, Sketchup, and Rhino. Therefore, you must have your application open in order to use

Enscape.

Atchitecture  Structure  Steel  Precast  Systems Insert  Amnotate  Anabyze Massing &Site  Collsborate  View  Manage mem @-
3 Por— =3
@ L é . @ = = @

Asset Library Manage Uploads  Place Sound Source _Enable Sound ~ General Settings Visual Settings ~Feedback About

Start  150-view-01 ~  Enable
(on selected face)
Control Active Document VR Headset Tools Video Panorarma Manage Uploads sound Settings Misc
Properties X & Perspective-Living-01 X 21 Project Browser - Eames_House_Project Yongy... X

A | 2-C Views al)
5 Floor Plans
Level 1

Level 1 - Color il

30 View: Perspective-Living: | 3 Edit Type - (el
& Level 2 - Color il
Graphics 2
Detail Level Fine Level 2 - Restrooms
Parts Visibility Show Original Roof
Visibilty/Graphics Edt. o
Graphic Display Op. Edit - Celling Plans
Discipiine Architectural = Level 1
Default Analysi Dis... None (@) Level2
Sun Path - Roof
Extents L3 &3 Views
Crop View B 150-view-01
Crop Region Visible 1S0-view-02
o) Perspective-Living-01

1 Elevations (Buildin Elevation)

« [STEP 6] Once you click Enscape Start, Enscape will ask for the license code to activate.
Please copy and paste the codes from your email and activate it.

Required Software information can be found in this link.
System requirements information can be found in this link

+ To check your graphic drivers (Windows)

o Open your “This PC” on your Desktop
o Mouse “right-click” > Click “Properties” > Click “Device Manager” on the left side of the panel > Find “Display

adapters” and see the graphic drivers
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Computer description:

Workgroup: MEW

Windows activation
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(CO 2) Control/navigate Enscape

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=110

Open your project file and open a perspective that you want to make a rendered image in Enscape. Start Enscape

« [STEP 1] Click [Enscape] tab

+ [STEP 2] Select the view that you would like to start on [Active Document] panel

« [STEP 3] Click [Start] on [Control] panel. Then it would be best if you waited a few seconds or minutes to launch the

plug-in

=
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Manage Uploads  Place Sound Source _ Enable Sound  General Settings Visual Settings Feedback About

Manage Uploads.

Once Enscape is open, familiarize yourself with the navigation control

(on selected face)

Sound

Settings. Misc

5 Project Browser - Eames_House Project Yangy...
A | 510 Views (al)
& Floor Plans
Level 1
Level 1 - ColorFill
Level 2
Level 2 - Color il
Level 2 - Restrooms
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Ceiling Plans
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@ Level2
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« [OPT 1] For the best practice, use dual monitors to see the Enscape real-time render on one monitor, your Revit

project on the other monitor.
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+ [OPT 2] If you do not have two monitors, you can split your screen with two windows
Architecture  Structure  Steel  Precast Systems Inset Annotate Analyze Massing &Site  Collaborate  View  Manage  Add-ns  Enscape™  Modify &~

G © 3 = = = @
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Rendering Settings Edit West
Locked Orienttion 5 Elevations (Interor Eleve
Projection Mode  Perspective E-LIVING-N
Eye Elevation [ E-Restroom 1 -W
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fly
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Properties help

.

[m] BIM
Video Editar III Collaboration EI
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Adjust settings There are two types of settings.

« [OPT 1] General Settings
This setting is for the file and saves locations, mouse and keyboard control, licensing, etc.
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A102 - Floor Plan - Level 2
A102-C - Color filed - Level 2

+ [OPT 2] Visual Settings
This setting is to render styles, image quality, camera settings, atmosphere, background, render settings, etc.
+ Below are the settings that [ used in the rendering below

© & M= é g = @ LA P = = @
Pause live updates Perspective-Living-01 - Enable Take Suveen;mt ExEm Create 3D View Asset Library Camela path Video Editor (on/off) = Manage Uploads p‘(izne;s:\::l::fﬂa‘ﬁf' Enable Sound General Settings Visual Settings Feedback About
Properties X {3 Perspective-Living-01 X = Project Browser - Eames_House_Project_Yongy... X
w | 210} Views (all)
@ Visual Settings - @ Visual Settings @ Visual Settings - x
Style Contrast [ White Background ol
(Gotires 20% ) Auto Contrast fog
E \uto Exposure Saturation Illumination
Projection Ambiient Brightness Night Sky Brightness 100%
Depth of Field 5% Effects Shadow Sharpness 0%
Maotion Blur Moon Size 100%
Focal Point 0.00m Lens Flare Artificial Light Brightness. 150%
Field of View 103° Bloom
Horizontal Horizon
Pt Gty e Source Mountains
Draft Medium High Ultra Chromatic Aberration Rotation 171
Intensity 25%
o Direction Angle 0
Variety 0%

+ the rendering preview
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(CO 3) Create views

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=110

If you find a view while you navigate the real-time view from Enscape, you can create/ save a view
+ [STEP 1] Once you find the view, stop to navigate
[STEP 2] Click “Create 3D view” from the tools panel
« [STEP 3] Name the view
[STEP 4] You can find the view that you just created on the Revit Project browser

e oo Vo S i i
5 g
i
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+ [STEP 5] To go back your views that you created, click the view name on the [Active Document] panel

(CO 4) Add model backgrounds

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=110

There are two options to change the model background

« [OPT 1] Change your Atmosphere on the visual settings to change the model backgrounds
e Crr e e L e e L e A e A e e s el ) o

; P — —
G © B H @ & B = : @ @ » = [= |@ [
Pause live updates  Perspective-Living-01 ~  Enable Take Screenshot  Export Create 3D View Assetlibrary ~Camerapath Video Editor (on/off) Manage Uploads  Place Sound Source  Enable Sound - General Settingg Visual Settings JFeedback About
- T o - (on selected face)

Control Active Document VR Headset Tools Video Panorama Manage Uploads Sound Settings Misc

Properties X | (@ Perspective-Living-01 X [ Level 1 = Project Browser - Eames_House_Project Yongy... X

~ | ©C Views al)

Level 1

@ Visual Settings o X Level 1 - Color Fill
30 View: Perspective-Living: + | £ Edt ype Lewel2
Graphics 2 aee - £ Level2 - ColorFill
Detail Level Fine Rendeing  Image  Atmosphere  Capture B o x
Parts Visibilty Show Original S
Visibilty/Graphics Edt. Height 200m
Graphic Display Op. Edt.
Discipiine Architectural Hlumination
Default Analysi Dis... None Sun Brightness 20%
Sun Path
Eims A Night Sky Brightness 200%
Crop View . 0%
Crop Region Visible
Far Clip Active Moon Size 300%
Far Ciip Offset 5310 187/236" el Lght Brigh s
P e rtficial Light Brightness.
Section Boc =]
oty 5 Horizon
Rendering Settings Edt. Source Clear
Locked Orientation fear |
Rotation o
Projection Mode  Perspective Sigbar
Eye Elevation 576"
B Wind Dt
Camera position_ bxplicit Intensity Forest 25%
Identity Data Mountains g
View Ternplate <None> Direction Angle p———— o
View Nome Perspective-Living 01 S
Dependency independent Clougs o
Tite on Sheet s
il Density White Cubes 0%
asing #
Phase Filter Show All Variety White Ground! 0%
Phase New Construction s 2 e
Contrails o
A101 - Floor Plan - Level 1
Longitude b A101-C- Color filled - Level 1
— 000 A102 - Floor Plan - Level 2
F A102-C - Color filed - Level 2
A401 -RCP - Level 2
The preset to be used for the horizon plate (f any) or a custom skybor. R

AS01 - Interior Section

« [OPT 2] Try to use Skybox. Find free skyboxes from this link

(CO 5) Add Entourages

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=110

Add Enscape models from Asset Library

[STEP 1] Click Asset Library from the Tools panel
« [STEP 2] Search items by category or tags
[ ]
[

STEP 3] Open a floor plan that you want to add the selected Enscape model to the Revit model
STEP 4] Select the model and place it on your floor plan. Use Move, Rotate commands to place the Enscape model.
Also, confirm the positions on your perspective view.
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9 4

+ [STEP 5] Once the placement is done, press [ESC] to go back to the library

B Q>

=

(CO 6) Render images

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=110

To make the final render

« [STEP 1] Click [Visual Settings] to set render size, file location, and file type.

+ [STEP 2] Click [Capture] in your visual settings

+ [STEP 3] Select the [Resolution] of the final rendering — Typically Full HD for PPT presentation, Ultra HD for Print
version presentation. If your render size is unique, please select Custom and set the pixel size.

STEP 4] Check [Show Safe Frame] to see the preview on your real-time view

STEP 5] Check [Export Object-ID, Material-ID, and Depth Chanel], Adjust the depth for the Depth Chanel

STEP 6] Set a render location to save your final render image file by clicking the Folder

STEP 7] Select a file format, typically [JPG]

STEP 8] Select the view name that you want to generate a final render

—_— — — — — —

STEP 9] Click [Render image] from [Enscape] tab, under [Tools] panel, to get the final render image outside of the file.
You may click “Render image (into the document)” to use the rendered image on your Revit document. This way, you

can add your final render image to your sheet
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I e e

y F F ) £ =
G e | B & & A P = = @
Pause live updates | Perspective-Living-01 v Encble [ TakeSaicemshot | Export Create 3D View Asset Library  Camera path Video Editor (on/off) Manage Uploads  Place Sound Source _ Enable Sound  General Setfings Visual Settings  Feedback About
N - - y (on selected face)
Control Active Document VR Headset ¥ Video Panorama  Manage Uploads Sound Settings Misc
Take Screenshot

gz X[ Level1 @ Render Image (Into Document) = @ Perspective-Living-01 X e - e el S

T N - ~ | 2 Views al)

Level 1
@ Visual Settings Level 1 - Color Fill
3D View: Perspective-Living: | £ Edit Type — .
P 9 2 Presets @ Enscape - View: *Perspective-Living- - o x

Graphics 2 1
Detail Level Fine U Rendering Image  Atmosphere
Parts Visibity Show Original
Visbilty/Graphics . Edt. Resoluton ({Full HD s | x 1050 ) AspectRatior 178
Graphic Display Op. Edit
Discipiine Architectural
Default Analysis Dis.. None p— ==
Sun Path =
Extents ' Export Object-ID, Material-ID and Depth Channel ' I
CropView o 2000m
Crop Region Visibie A
Far Cip Active 0 [J Automatic Naming . » g-01
Far Clip Offset Default Folder 15 19_Enscape 01 = i
Scope Box None
o B File Format [ PEG Image (*.jpg) -
Camera
Rendering Settings Edit {| Video —
Locked Orientation Compr. Qualty | Maximum — .
Brojection Mode  Perspactive ation)
Eye Elevation 5o i 20 —
Target Hlevation 15 0° :
Camers Bosition  TEipiicit Panorama A — o [mage % 2=l
Identity Data Resolution Normal
View Template <None>
View Name Perspective-Living 01
Bependency independent 1
Tile on Sheet 2
Phasing -2
Phase Filter Ishow All —
Phase New Construction

[ Sheets (all)
A100 - Site Plan
A101 - Floor Plan - Level 1

Free resources

o Link1
o« Link2
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Chapter 20. Edit model & materials

© Session Objectives

Upon completing this session, students will be able to:

(CO 1) Understand workflow, name of the material

(CO 2) Use 3D Grass, Water, Reflective, textures

(CO 3) Change to Architecture Maquette (White model, Outline) & Light mode
(CO 4) Create Orthometric views

‘® Session Highlights

At the end of the session, students can create the graphics below.
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E? Lecture Contents

(CO 1) Understand workflow, name of the material

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=112

To manage your file size for faster real-time rendering in Enscape, you would be better to reduce your file size

To apply a new material

[STEP 1] Click [Material Browser] icon on [Material and Finish] category in the [Properties] palette
« [STEP 2] Click [Create New Material] on [Material Browser]
[STEP 3] Rename the material that you created (Example. 001_XX_01_Description)

+ [STEP 4] Check [Use Render Appearance] on [Graphic] tab

Create Inset  Annotate View Manage  Add-ns  Enscape™

Select v Propetties  Clipboard Geometry Modify

Modify | Extrusion Depth 0 059/256"

Modiy | Bxtrusion | (5«

Y

Measure Create Mode Work Plane Placement  In-Place Editor

Bt ) x P e e e e —
| E-10] Views (all)
% & Floor Plans
'— v Material Browser - 000_CPT_02 ? i
Level 1 - Color Fill
Famiture (1) o Search Q| identity | Graphics | Appearance Level2
Constraints Project Materials All ¥~ j= - 7 Shading b
Extrusion End 0 059/256' Ty p— el 2% Restraoms
Extrusion Start oo Name il Roof
iz - q _Charles_construction & Celling Plans
Transparency Level 1
Visible i —
Visbilty/Graphics . | Edi. . [ crovestes e Level 2
Wiaterials and Finishes # 30500’
Material [000_CPT_02 - ' Foreground & b
Identity Data S B
Subcategory <None> Pattem <none: 150-view-02
- (LUIRGE 120 120 120 Perspective-Living-02
000_Chair_sk_seat 01 Alignment Texture Alignment, -~ Elevations (Building Elevation)
East
= ¥ Background North
| | 000.CPTOT South
Pattem <none> West
] mmcree | 5 Gevtons (s o)
[ ¥ 8 ra 120 120 120 S
E-Restroom 1-W
000_FB_01 v =
- Cut Patts 5 Sections (Building Section)
¥ Foreground S-Restroom 1 -W
000FE01-White SECTION A
Pattern <none> & Renderings
[0 000_Gypsum Wall Board Perspective-Living-01_1
- Color Perspective-Lving 01 2
. 000_Steel ASTM A992_Black ¥ Background _ - Perspective-Living-01.3
Legends
= g Pattem <none> [ Schedules/Quantities (all)
i v =) 1 Shests (al)
=Y {70 R 120 120 120 AT00 - Site Plan
»Home Name A101 - Floor Plan - Level 1
A101-C - Color filed - Level 1
A102 - Floor Plan - Level 2
Ei-@ B <« A102-C - Color filled - Level 2
A401 -RCP - Level 2
(53] Cancel || orly 402 -RCP - Level 1
AS1 - Interior Section

el

[STEP 5] Click the [Appearance] tab on the [material browser]

[STEP 6] Click [Replace] Icon

[STEP 7] Click [ Appearance Library]

[STEP 8] Select a category

[STEP 9] Click a specific material that you would like to apply, or change > click the [replace] icon
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Modify | Extrusion

Measure Create Mode

’ o

Work Plane Placement

Q] Identity Grapm(SIAppearin(e.

In-Place Editor

= Project Browser - Eames_House_Project Yongyeo...
~ | 21707 Views (all)

)

Create Insert  Annotate  View Manage  Add-ns  Enscape™
Select -~ Properties  Clipboard Geometry Modify
Modify | Extrusion | Depth

g () ©

D T
Search
Fumiture (1) v

Constraints # || Project Materils: Al Y -
Extrusion End 0 059/256"
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Work biane .
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Visible 2 U P
Visbilty/Graphics . | Edit F
[ ot
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W oo
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000_Gypsum Well Board
W o

. 000_Steel ASTM A992 Black

T oo
o

Glossiness
Highlights  Non-Metallic
» [ Reflectivity
» | Transparency

> [ Cutouts

» [ Self lumination
» v Bump

Tint

»Home

Name

«

X Asset Browser 7 X
[ search Y|
@ Appearance Library: Flooring: Carpet
= Asset Name a Aspect Type *
_ Pad - Waffled Appe.. Gene
ng
> Ceramic
> Concrete Purple-Gray Appe.. Gene
T Default
»Fi Fabric
Tia Finish
] Red Appe.. Gene
Rug - Braided Appe... Gene
100 |
0 C
M Rug - Hooked Appe... Gene
T Metallic Paint ? "
T Mirror
»Fi Miscellaneous
»Fi Paint
> Plastic J| Rug - Knotted Appe.
T Roofing RErEeEeeTEE
i Sicing assetintheeditor |
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> Stone Saxony - Flower Patter Blue-White Appe. Gene
T Stucco
»Fin Wall Covering
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»D.w.ysn e Saxony - Flower Pattern Colored Appe.. Gene
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Concel || Aoy

+ [STEP 10] On the [Material Browser], click the Duplication icon. This process is recommended to make a unique

material

+ [STEP 11] If the material image needs to be changed, click the image name. If the material size, location, or rotate, click

image

« [STEP 12] Change the scale, offset, or rotate > Click done

Modify | Extrusion

Measure Create Mode

@~

TlLe Y [Blei]

Ty

Work Plane Placement

Come nsct Anmotate View Mamage  Adeins  Enscape™
Select v Properties  Clipboard  Geometry Modify
Modify | Extrusion | Depth|0' 059/25
e ) )

B
' < -
Search

Fumiture (1) B
Constraints Project Material: All Y -
Edrusionfnd 0 0 50/256"

Extrusion Start ] i
Work Biane -

Graphics |

e . [ m _Charles legs

(4]
Visibilty/Graphice .. | Edt.

Materials and Finishes A
[000_CPT_02 1

Meaterial
Identity Dta * | Il ocrisicon
Subcategory <None>

Salid/Void “Sofid

000_Chair_sk seat_01

E 000_CPT.01

In-Place Editor

Q| dentity Graphics | Appearance
1= .| g0 Rug-Knotted(1) C

= Project Browser - Eames_House_Project Yongyeo...

~ | £1.0] Views (al)

» Information

=]
000.CPT.02

W oo
L) onreovee

000_Gypsum WallBoard
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. 000_Steel ASTM A992 Black
8 ooom o1
=

¥ Generic
Image
Image Fade
Glossiness
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» [ Reflectivity

» | Transparency

» | Self llumination

»Home

Name.

«

« [STEP 13] Update Information on the [Identity] tab

o Description = Material tag information

o Other information = Material schedule information

Finishes Flooring.Rug Knotted jpg

100 Souv:ef shes:Flooring.Rug Knotted.jpg. l

B | [ mage

. pr— TCProgrom i 691 Comman e Atodesk Sara
o e g Kot
- —
[ memr—
68 ot i
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= H“ﬁ;
e
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cancel || pply

- ABOT - Interior Elevation
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el oy e T
e =g > Sy
Moty | Exrsion | Depth [0 0397255
e w © x P e e e o
a | 510 Views (al}
.Q | Material Browser - 000_CPT.02 X se ? X
- Se h
bl = | IO B 2]
Constraints # || Pproject Materals: A1 T ~ Neme | 000_cpT 02 Appearance Library: Flooring: Carpet
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+ [STEP 14] Update Information on the [Graphics] tab
o Shading, Check [Use Render Appearance]
o Update [Surface Pattern] if needed
o Update [Cut Pattern] if needed
: 8- 93 7
Mty |Exrsion | Depth [0 0397255
Propertes &) © < Project Browser - Eames.House Project Yongyeo..
n | 510 Views (ai}

.Q | Material Browser - 000_CPT.02 7 x ? X
— e || I q] \denmgl Graphics | ppesrance | seacn q
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g oo . -
i — T
=
e Ry
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»EI PhysicalMaterial Structural,
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e 8 l
] &= || o =k

- ABO - Interior Elevation

+ [STEP 15] Update Information on the [Appearance] tab

o Information name = Should be unique

o Generic = Image or color

o Reflectivity

o Transparency

o Self-illumination - Create self-illuminated material like a light source
o Bump - Create a bumpy texture on a surface
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« [STEP 16] Click [Apply] > click [0k]

AB01 - Interior Elevation
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For material, Enscape uses most of Revit material properties

Materials in Revit can be found at this link

Use sample materials from this link

(CO 2) Use 3D Grass and Water

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=112
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Enscape requires a special name for Water and Grass.

The material name must include [water] for water materials.
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The material name must include [grass] for grass materials.
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(CO 3) Change to Architecture Maquette (White model, Outline) & Light mode

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=112

Designers use white models to discuss the shape or form of space.

+ [STEP 1] Open [visual settings]
+ [STEP 2] Change mode to [White]
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The designer also uses light mode to show lighting intensity. You can see where hot spots are and where the areas that need

more lighting.

+ [STEP 1] Open [visual settings.]

+ [STEP 2] Change the mode to [Light view.]

« [STEP 3] You may uncheck [Automatic Scale] for manual
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(CO 4) Create Orthometric views

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=112

To create an isometric view via Enscape, you need an isometric view on your Revit file.

+ [STEP 1] Create a Default 3D view by clicking the [3D view] from the View] tab, under [Create] panel
Architecture  Structure  Steel  Precast  Systems  Insert Annotate  Analyze  Massing &Site  Collaborate  View  Manage  Add-Ins  Enscape™  Modify

G © 8§ H e & =
(ETr—

. d = B @6

Pause live updates{(1S0-view-02 <) Ensble  TokeScreenshot Export Create3D View Assetlibrary Camers path Video Editor (on/off) Manage Uploads  Place Sound Source _ Enable Sound  General Settings Visual Settings Feedback About
- " T i (on selected face)
Control Active Document VR Headset Tools Video Panorama Manage Uploads Sound Settings Misc

Properties X i Perspective-lving02 3 ISO-view-02 X = Project Browser - Eames_House_Project Yongy... X

A | 510, Views (all)
S e - ot

3D View: ISO-view-02 ~ | B3 EditType Level2

Graphics 2 Level 2 - Color Fill
View Scale 8 =10 Level 2 - Restrooms
Scaic Value T 3 Roof

Detail Level Fine Site

Parts Visibilty Show Original & Celing Plans
Visibilty /Graphics .. Edi Level 1

Graphic Display Op. Edi Level2

Discipiine Coordnation Roof

Show Hidden Lines By Discipline 53D Views

Default Anaiysis Dis... None 30 View 1
Sun Path n}
Extents
Crop View ] =t
Crop Region Visile |[] Perspective-
Amnotation Crop1[] 5+ Elevations (Builing Hlevation)
Far Ciip Active [ East
Far Cip Offset o0 gm:
Scope Box out
Section Box < West
s <S5 R ——
Rendierng Setings it .’I’yg sumen
< - Restroom 1 -
Brojection Mode - Onthographic ’4“. 1 B i ‘q =
e Hlevation EpeT s ey Restroom 1 -
wid B e
mers Bosiion  TAdjusting S enderings
i g g g
Identity Data I < pasSiuzicatl
View Template <None> g erspective-Living-01_2
e Perspective-Living-01.3
View Name S0 view-02
B Legends
Dependency independent eg
Tile on Sheet [ Schedules/Quantites (al)
Phasing 2 o - E) Sheets (all)
et Show o A100-Ste
Phaze New Construction A101 - Floor Plan - Level T
) 1 AT01-C- Color filled - Level 1
A102 - Floor Plan - Level 2
A102-C - Color filed - Level 2
A401-RCP - Level 2
A402 - RCP - Level 1
. AS01 - Interor Section
Propertes help - 1o B GG R @ 0 (8 S < > 2601 - Interor Eivation

= = P o - =

¥

Mmoo o Sa

« [STEP 2] Use [section box] and hide in view by element or category to hide unnecessary items
« [STEP 3] Synchronize the view by selecting [view name]
+ [STEP 4] Change the Projection to [Orthographic] from [Visual Settings] under [Rendering]
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Selects the projection made (disabled in VR, perspective projection only).

+ [STEP 5] You may change the [render style mode] on your [visual settings]
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« [STEP 6] You also may change views using numbers on the keyboard

For a floor plan, press [ 5]
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Chapter 21. Edit lighting and create a video

© Session Objectives

Upon completing this session, students will be able to:

(CO 1) Save and load presets
(CO 2) Set and adjust artificial lightings
(CO 3) Create a walk-through video

‘® Session Highlights

At the end of the session, students can create the graphics below.
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@ Lecture Contents

(CO 1) Save and load presets

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=114

The saving and loading presets are very helpful if you need to render multiple images. You will save a lot of time and produce
consistent image qualities.

You can save the visual setting that you modified

« [STEP 1] Click Presets
« [STEP 2] Click Save Preset > Save to Project or Save to File
« [STEP 3] Name the preset

T

© & F e & BE &

¢ o = @ d = [ = |w@ 6«
Resume live Perspective- Living-01 - Enable Take Screenshot  Export Create 3D View AssetLibrary Camera path  Video Editor (on/off) Manage Uploads  Place Sound Snuv:ev Enable Sound  General Settingd Visual Settings || Feedback About

(on selected face)

Control Active Document VR Headset Tools Video Panorama  Manage Uploads Sound Settings Mise
Properties X 3 Perspective-Living-01 X = Project Browser - Eames_House_Project_Yongy... X
@ oy Level 2 - ColorFill
' Visual Settings - X Level 2 - Restrooms
4 7 > Roof
3D View: Perspective-Living: | () Edit Type M—L | . % Site
s 2 Load Preset » bhere _Capture i . Ceiling Plans
Detail Level Fine [ savebreser » || Save To Project (default | 7 Level1
Parts Visibilty Show Original P s Torie Level 2
Visibility/Graphics Edit G o Roof
Graphic Display Op. Edt. Manage Presets S \ L 3D Views
Discipiine Architectural 30 View 1
Default Analysi Dis... None 1S0-view-01
Sun Path 0 Camers 150-view-02
Extents 8 Auto Exposure
Crop View
Crop Region Visibi Exposure 0% . etivng
levations (Building Elevation
Far Clip Active Projection Two-Point v - 3 fis (Building )
Far Clip Offset -
Seope o Depth of Field 5% North
3 South
Section Boc B
Comera A lputofocus B L DR e
Rendering Settings = Facal Paint 000m = - —_— el Elevations (Interior Elevation)
Locked Orfentation T ——— - ] > S = { el
Projection Mode  Perspective e E-Restroom 1-W
Eye Eievation H Sections (Building Section)
Target Flevation 5 0" Rendering Quality Restroom 1 - W
Camera position_Explicit Draft Medium High utra SECTION A-&
Identity Data Renderings
View Template <None> Perspective-Living-01.1
View Nome “Perspective-Living 01 Perspective-Living-01.2
Dependency Zindependent I Perspective-Living-01_3
Tite on Sheet

+ Itis recommended to save three types of preset [Perspective-Day, Perspective-Night, and Isometric]

To load a preset that you already saved

« [STEP 1] Click Presets
« [STEP 2] Click load Preset > Load from Project, or you may load from the file
+ [STEP 3] Select a preset that you would like to load > Click OK
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G Visual Settings = x @ Enscape - View: “IS0-view-02 - o x ™
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A Rendering
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Visiblty/Graphics .. Edt. Height om
Graphic Display Op. Edt. S
Disci Architecturel indinaian
Default Analysis Di... None [socdoroy ] 5
Sun Path [m] SEnBighnes Perspective-Day 150-Color-Day) e
Extents o Night Sky Brightnessf] Perspective-Night 29% .
Crop View ing:
Crop Region Visible Shadow Sharpness. 55% g-02
SeiChpadive Moon Size a36% i
Far Ciip Offset
Arifical Light Bright 200%
— levation)
-
ection)
Wind
Camera Position Explicit - s
Identity Data
View Termplate <None> Direction Angle - o
mmmmm erspective-Living- 0t
Vewl PerzpectiverLiving 1 1fthe renderer window is open, the selected preset will =] 0013
Dependency independient Clouds Er
Tite on Sheet =
= Density T AN @l
Phase Filter Show All Variety s
Phase New Construction
| Girrus Amount 207 Level 1

W ~Level 1
Contrails 1 AT02 - Floor Plan - Level
Longitude 5000m -C- =
[ <nnn. 4 g s

- Interior Elevation

(CO 2) Set and adjust artificial lightings

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=114

For better artificial lighting simulation

+ [STEP 1] Use a night-time scene time (sunset or sunrise would work as well)

[STEP 2] Turn off “Auto Exposure” in Enscape visual settings

o Exposure Brightness = 60% ~ 80% (Nighttime scene)
o Exposure Brightness = 51%~53% (Day time scene)

+ [STEP 3] The render quality should be High or Ultra

« [STEP 4] Vignette effect = 0%

+ [STEP 5] Artificial Light Brightness = 100% ~ 150%

Once you change the time of day, you must click “create 3D view” to save that time of day.

« [STEP 1] Click [Create 3D view] from the [Enscape] tab
« [STEP 2] Name the view
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Find/use IES lighting from this link
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Use/adjust self-illumination materials for lighting sources

Architecture  Structure  Steel  Precast Systems  Inset  Annotate  Analyze Massing & Site  Collaborate  View  Manage  Add-Ins  Enscape™  Modify (2~

Main Model -

Select v

Properties

@ 30 View

3D View: Perspectiy

Settings

X

Graphics.
Detail Level

‘ [search

Project Location

Ql Identity Graphics | Appearance

Inquiry Macros  Visual Programming

S Project Browser - Eames House Project Yongyeo..

~ Level2
Level 2 - ColorFill
Level 2 - Restrooms
Reof

Parts Visibility

Project Materials: All Y +

=R

Graphic Display O]

Discipiine
Difault Analysis | G Cabinets - Handles

Sun Path

Extents | ‘ Camira Black
Crop View

Crop Region Visibl Comir petol
Far Ciip Active SEE S

Name

Far Ciip Offset
Scope Box
Section Box

Camira White

Camera | \- Cherry
Rendering Settings

Locked Orientatio| o
Projection Modle s

Eye Elevation
Target Elevation

Camera Position

SR

O Camira White

Updating.

Amount

Image

Image Fade
Translucency
Refraction

> Cutouts

%D

(no image selected)

Identity Data
View Template
View Name
Dependency
Title on Sheet

Phasing
Phase Filter
Phase

»Home

Name

¥ I Self lllumination
Filter Color
Luminance

Color Temperature

RGB 255 255 255 -
Lamp Shade Interior ~ 2,50000

Incandescent Bulb 7| 2,800.00

-@-

«

v

Bump.
> Tint

oK cancel || Apply 'A102 - Floor Plan - Level 2
A102-C - Color filled - Level 2.
A401 - RCP - Level 2
n 1 A402 -RCP - Level 1

(CO 3) Create a walk-through video

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=114

To create a video path with scenes

+ [STEP 1] Click “Video Editor” from the Enscape tab

+ [STEP 2] Click “Add keyframe” — Once you click “Add keyframe,” the setting will be saved
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+ [STEP 3] Change the scene by moving the scene

+ [STEP 4] Once you think the next scene is the right position (recommend foot walk to see the scene from the same
height), click “Add keyframe,” then you can see the second frame is added.

« [STEP 5] You may check the preview to see how this works.
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« [STEP 6] Repeat step 3 to 5 to create a complete path for a video

299 | Enscape Session 3



[T Achitecture  Structure  Steel  Precast Systems Insert Annotate Anahyze Massing &Site  Collaborate  View ~ Manage  Add-Ins  Enscape™  Modfy @+
& @ & =l

Pause live updates  Perspective-Living-01 ~ Enable  TakeScreenshot Export Create 3D View Assetlibrary ~Camerapath Video Editor (on/off) Rendler Video Manage Uploads.

Properties X | {3 Perspective-Living-01 X

|30 View: Perspective-Living: | 3 EditType
Graphics 5
Detail Level
Parts Visibility
Vibilty/Graphics
Graphic Display O
Discipline
Defaut Analysis Di.
Sun Path
Euterts 5
CropView
Crop Region Visible
Far Clip Active
Far Cip Offeet
Scopesin
Section Box

Fine
Show Original

Architectural
None

Camera 3
Rendering Settings Edit.
Locked Orientation

Projection Mode
Eye Elevation
Target Elevation 5

Perspective

Camera Bosition  Explicit
Identity Data #

View Ternplate

View Name Perspective-Living-01

Dependency independnt

it on Sheet

Phasing #

Phase Filter Show All 5]
Phase New Constructon Timeline

=+ Add keyframe (K)
X Remove all Movement

» Preview (P)

Total Duration

Shaky 08 0610 001

mera @D Easingin/out

Properties help ly perspectve B () ¥k G 0o <
Cick to select, TAB for alterates, CTRL adds, SHIFT unselects & 0 1

RS

Sound

¢ = = @

Place Sound Source _ Enable Sound  General Setings Visual Setings  Feedback About
(on selected face) ™

Settings Misc

= Project Browser - Eames House Project Yongy... X
~ Level2

Level 2 - Color il

Level 2 - Restrooms

Roof

Site
Ceiling Plans

o

o
5
g
i

1S0-view-03
Perspective-Living-01
Perspective-Living-01-Night
Perspective-Living-02

Elevations (Building Elevation)

o

o

Elevations (nterior Elevation)
E-LIVING-N
E-Restroom 1-W.
Sections (Building Section)
S-Restroom 1-W.
SECTION A-A'
Renderings
Perspective-Living-01.1
Perspective-Living-01.2
Perspective-Living-01.3
Legends
Schedules/Quantities (al)
Sheets (al)

o

&

AB01 - Interior Elevation
A701 - Restroom 1
A901 - Perspective - Living 1

AR N ST

[STEP 7] Click a [frame] and change the settings (time of the day, duration of the movement, camera field of view, and

camera position) and click “Apply” to apply the changes
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[STEP 8] You can repeat other frames to change the settings
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+ [STEP 9] You can get out of the keyframe editor by clicking Back, Click Preview to see the results
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To save a video path

+ [STEP 1] Click “Save Path” from the Enscape tab
« [STEP 2] Make a unique name for the path
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To render the video

+ [STEP 1] Load camera path by clicking “Camera Path” > “Load path” from the Enscape tab

« [STEP 2] Change video size from Visual Setting — Resolution (HD is recommended), the quality can be [Web], FPS
must be [30]

« [STEP 3] Click “Render Video” to render the path
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Note. To render the video, it will take a while because of the pictures that the video renders. Typically, if you render a
1-second video, Enscape renders 30 frames. If one frame takes 10 seconds to render, a total 1-second Video takes 300
seconds to render. Enscape does a great job because Revit rendering takes 5 minutes to render one frame.
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Chapter 22. Edit render outputs

© Session Objectives

Upon completing this session, students will be able to:

(CO 1) Export enlarged jpg files (Original, ID) for print
(CO 2) Create Executable file
(CO 3) Create Render Panorama image

‘® Session Highlights

At the end of the session, students can create the graphics below.

© Eames Houne rject Yongyeen o2

m__ M
]

i 1]
[
R ] ]

R i Iy

B4 Lecture Contents

(CO 1) Export enlarged jpg files (Original, ID) for print

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=116

Refer to [lecture 14.1, CO 2], for the final render image process
If you need a special size of render image, change the resolution to Custom and change the values from Capture in Visual
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You can use the ID images and Depth map to adjust the rendering in photoshop.

(CO 2) Create Executable file

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=116

To export the EXE file

EXE file type is for a presentation, it does not require any programs like Revit, nor Enscape, material links, and lighting/
render settings.

« [STEP 1] Click [Start] to launch Enscape and confirm your model is ready for export.
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[STEP 2] Select view to start
[STEP 3] Add information (Icon, Title, Load first screen) from [Customization] on [General Settings]
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« [STEP 5] Save > Name the file name and wait until the file is created
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(CO 3) Create Render Panorama image

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/
visualgraphiccomm/?p=116

To create Render Panorama

(This option creates only one 360-degree rendering image with QR code at the same time)

+ [STEP 1] Select a view to create a 360-degree rendering image (The center of a room/space)
+ [STEP 2] Click Enscape Start. Confirm your Projection mode is [Perspective]

« [STEP 3] Click Render Panorama. The render takes time because this panorama needs to render 16 images (for the
normal setting)
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[STEP 5] Click the rendered image > Upload the rendered image in ENSCAPE CLOUD
« [STEP 6] Click the file to open the web browser or use a QR code
+ [STEP 7] And the rendered image file and the QR code can be saved in JPG
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Tips from Enscape using Panorama view

Please read this link for using the panorama view

Please read this link for an advanced level using panorama images
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Appendix: Ancillaries

o File package for a student - Download

= Base drawings
= Source models
= Material images

o File package for an instructor — Request to the author via email
(yongyeon@iastate.edu or choyongyeon1983@gmail.com) with documentation, they are a faculty member.

= Base drawings

= Source models

= Material images

* AutoCAD, Revit, and Enscape models

Recommended lecture schedule and to-do list for each session:
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Week Session

01 01
02
02 01
02
03 01
02
04 01

Contents

Introduction of AutoCAD

What is the application & 4 different AutoCAD

How to install the application

Understand AutoCAD interface — Ribbon, Panels, Model space, Layout tabs, Status bar, €/ Properties
AutoCAD setup tips — Options, Unites, Workspace

Types and structure of drawings in Auto CAD- Floor plan, RCP, Elevation, Section, s Details
Input commands and understand different selections

Understand basic drawing tools— Origin, Line, Move, Rotate, Copy

Attach image/PDF/CAD and Adjust the scale

Set the project folder, Save the file, and backups

Draw Floor Plans

« Understand Layers — Name, Line type, Thickness, €/ Color

« Draw centerlines - Line, Ortho, €/ Offest

+ Draw exterior/interior walls, floor, millwork & openings — Polyline, Spline, Circle, Rectecgul, Object
Snap, Mirror, Fillet, Trim, Extend, Array, €/ Match Properties

Finalize (2) Floor plans layout (1st floor & 2nd floor for the House) — Walls, Floor, Millwork, & Openings

Create Dimensions and Components

+ Add/Edit dimensions (in model space)- Dim, €/ Dimension style

+ Add/Edit blocks from AutoCAD Tool Palette & Other sources — Door, Window, Column, Plumbing,
Furniture € Equipment

+ Create custom blocks — Custom furniture

Draw Elevations and Sections

« Draw a section
+ Draw an elevation from the Floor plan
+ Add/Edit Text & Annotation (in model space) — MText, Text style, M leader, €/ Multileader Style

Add components (Window, Column, Plumbing, Furniture, & Equipment) in (2) Floor plans (Follow the wall
layout and millwork, design your own furniture layout)

Finalize (1) Section (House-Section A-A’) and (1) Elevation (refer House-Section C-C’) — with furniture,
dimensions, and annotations

Draw Ceiling Plans

+ Draw Ceiling Plans from Floor plan
+ Add/Edit Hatch
» Create Legends
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Set Sheets

02

Understand the Model space and Paper spaces
Set a new layout — Page layout, £/ Plot styles

Set views in Paper spaces — Defpoints, Scaling
Add/Edit/Draw a titleblock

Symbols and prints
05 01

+ Add/Edit symbols in Paper spaces — drawing title, elevation symbol and section letters, north arrow
« Printing

Add Hatches in the floor plans, sections, and ceiling plans

02 Finalize (2) Ceiling plans (1st floor & 2nd floor for the House) — design your own lighting layout for the
House

Create a PDF drawing set

Introduction to Revit

Purpose of using Revit — How &/ Why Interior Design uses Revit

Install Revit

Understand Project Templates — Default and Own

Save Revit file — Set the project folder and backup file

Open an existing project file

Keyboard shortcuts

Understand the User Interface — Toolbar, Properties, Drawing area, Option bar, and Project Browser

06 01

Create a Site

02 Understand the site plan and information

Set the project location and understand building base point

Find GIS information

Add & Edit Site — Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees
Define true north and project north

Set Grids, Levels, Dimensions, & Building columns

07 01 Import CAD drawings— Floor plans, building elevations, and sections

Adjust and verify the scale

Create and modify grids and levels
Create plan views— Floors and ceilings
Create columns with dimensions

Finalize the (1) site (including terrain, roads, side works, property line, surrounding buildings, and trees)
02
Work on building columns
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08

09

10

01

02

01

02

01

02

Add/Edit Beam, Walls, & Curtain Walls

Add/Edit Beam

Create walls

Edit walls wall properties — Wall thickness, Wall details, €4 Finishes
Edit/add wall properties — Wall opening, wall sweep

Add/Edit Curtainwalls, Mullions, & Panels

Understand Visibility settings, Add/Edit Floor & Ceiling,

Understand View template, visibility graphics
Understand View range

Add/Edit Floors & Floor Properties

Add/Edit Ceilings & Ceiling Properties

Add/Edit Stairs, Rails, & Roof

Add/Edit Stair - three types of staircases
Add/Edit Railing
Add/Edit Roof

Work on building beams, walls, floors, ceilings, stairs, railings, and roofs

Finalize (2) Floor plans (Ist floor & 2nd floor for the House) with dimensions

Add/Edit Windows, Doors, Lighting, Furniture, Tags, & Sheets

Understand the concept of family file

Add/Edit Doors and Windows

Add Tags

Add/Edit Lighting fixtures

Add/Edit Titleblocks

Insert Plan views and symbols — North arrow and graphic scale

Add/Edit Model-in-Place Components & Edit Family

Add/Edit Furniture families
Add/Edit Model-in-place components — Custom casework
Add/Edit a New Family - Furniture
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Add/Edit Elevation, Section, Detail, Text, Annotation, & Rooms

1 01 + Add/Edit Elevations & Sections — Adjust crop region
+ Add/Edit Detail views
+ Add Texts & Annotations
+ Add/Edit Rooms, Room tags, Room separators
« Add/Edit a color fill scheme
Work on furniture, casework, lighting, doors, and windows
Finalize (2) Ceiling Plans (1st floor & 2nd floor for the House) - design your own lighting layout for the
House
02 Finalize (2) Furniture Plans and Floor Floor Finish Plans(1st floor & 2nd floor for the House) — design your
own furniture layout and finish choice for the House
Finalize (2) Elevations (Decide your own views for the House)
Finalize (2) Sections (House-Section A-A’, House-Section C-C’) — No furniture, Follow the given drawing
Add/Edit Views, Lighting, & Materials
» Set perspective views
12 01 + Set Isometric views
« Edit Views — Graphic Display styles
+ Test Render
* Setsun
« Edit Artificial lighting
« Add/Edit materials
« Render material managements
Create Revit Rendering, Revit Clouding Rendering
02 + Insert other types of files — Sketchup, AutoCAD
» Advanced render settings
« Edit render qualities
+ Understand and make cloud renderings
+ Save Rendering outputs
Finalize (2) Perspective views (Revit rendering and Revit Cloud rendering) — (Decide your own views for the
House)
13 01 - .. . .
Finalize (1) Isometric view (Decide your own views for the House)
Create a PDF drawing set
Introduction of Enscape
02 Understand what is Enscape

Control/navigate Enscape
Create views

Add model backgrounds
Add Entourages

Render images
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14 01
02
15 01
02

Edit Model and Materials

Understand workflow, name of the material

Use 3D Grass, Water, Reflective, textures

Change to Architecture Maquette (White model, Outline) & Light mode
Create Orthometric views

Edit Lighting and Create Video

+ Save, and load presets
+ Set and adjust artificial lightings
« Create a walk-through video

Edit Render outputs

+ Export enlarged jpg files (Original, ID) for print
+ Create Executable file
+ Create Render Panorama image

Finalize (3) Perspective views ((2) Enscape rendering + Photoshoped, (1) Lighting analysis) (Decide your own

views for the House)
Finalize (1) QR code for Panorama rendering
Finalize (1) Video (30 seconds)

Create a PDF drawing set
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